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Section 1. Installation 

The components of the Clearing Member module are installed as part of the Calypso Installer when you select the 
“Clearing Member” solution: 

 

• Exchange Feed – Direct connection with the CCP through IBM MQ Series to transmit / receive trades and 
messages. 

• Data Uploader – Upload of trades and messages received by the Exchange Feed into Calypso. 

• ERS Limits (optional) – Limits are checked once the trades are in Calypso. 

• CMF OTC Clearing – Back office processing – Once the trades are validated/rejected in Calypso, a 
consent/reject message is sent to the CCP so that the trades can be cleared – Import of initial margins, 
variation margins, market data, fees, etc. – Generation of client statements. 

• Collateral – Allocation of margin calls (initial margins and variation margins). 

 

Margin Calculators in version 14.1+ 

In the "Common Third Party Libraries & Extension" window, add the Margin Calculator JARs. There is a JAR for each 
type of report: DEFAULT, TYPEB, TYPEC, TYPED, TYPEE, TYPEH, and TYPEJ: 

• calypso-margin-calculation-default-service-x.x.x-SNAPSHOT.jar - EUREX CreditClear 

• calypso-margin-calculation-typeb-service-x.x.x-SNAPSHOT.jar - SGX 

• calypso-margin-calculation-typec-service-x.x.x-SNAPSHOT.jar - TSE 

• calypso-margin-calculation-typed-service-x.x.x-SNAPSHOT.jar – CME Swap (HistSim and 

OTCMargin reports) 

• calypso-margin-calculation-typee-service-x.x.x-SNAPSHOT.jar - COMDER 

• calypso-margin-calculation-typeh-service-x.x.x-SNAPSHOT.jar - LCH 

• calypso-margin-calculation-typej-service-x.x.x-SNAPSHOT.jar – EUREX IM 

Please contact Calypso Product Support for obtaining these JARS. 
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 Please refer to the Calypso Installation Guide for details on the Calypso Installer. 

 

If you are installing a CUP (Calypso Upgrade Package) instead, the instructions are also in the Calypso Installation 
Guide. 

 

Database Upgrade 

When you run Execute SQL as part of your installation, the data files will be already loaded. You just need to check 
the following checkboxes: 

• exchange_feed_cme 

• exchange_feed 

• exchange_feed_lch 

• collateral 

• collateral-workflow 

• gateway 

• ERS checkboxes (optional) – MarginCalculatorDomainValues, limitinstall, limitsinstall, marketriskinstall 

 Please refer to Calypso Collateral Management release notes for upgrade information, if any. 
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Section 2. Overview 

Calypso’s OTC derivatives clearing member solution combines Calypso’s Back Office, Connectivity, Collateral and 
ERS Limits functionality to offer a complete solution for entities offering OTC clearing services to their internal 
trading desks as well as to external clients. The primary activities that the clearing member will be relying on 
Calypso for are: 

• The use of connectivity and STP workflow to automatically accept or reject trades submitted for clearing 
by their customers, 

• Management of cash and collateral related to the clearing activities, and 

• Generating client statements for their customers to summarize the day's activity. 

In order to support these activities, Calypso provides interfaces to Central Counterparties (CCPs) to allow the 
creation of trades to start them on their process to becoming a cleared trade in the client’s account. These trades 
will flow into the system in real-time throughout the day. At the end of the day the CCPs will summarize all of the 
information about the trades, risk and positions related to each account managed by that clearing member, and 

Calypso provides the facility to run schedule tasks which import and process that information. The processing 
results in the generation of Calypso trade objects which will facilitate the settlement of cashflows and the 
management of Initial Margin Requirements. 

The Collateral Management module will then take over to manage any Margin Calls resulting from the day’s activity 
for each account. This includes not only cashflows related to the cleared trades, but payments made to or from 
each clearing account as part of routine business. 

The end of day (EOD) processing will also save pricing marks for each trade based on the CCP’s valuation, and will 
generate market data, such as curves and quotes, which can be used to value the positions using Calypso’s native 
pricers. Again, all of this information is sourced from the EOD reports provided to the clearing member by the CCP. 

As a last step, Calypso will aggregate all of the information stored in the system from the activity of each account, 
and generate a client statement which will be sent to the account holders as a record of their activity. 

2.1 CCP and Service Coverage 

Calypso’s OTC derivatives clearing member solution includes “out-of-the-box” support for connectivity and 
integration with the following central counterparties: 

• LCH SwapClear and SwapClear US integration: 

- Trade connectivity via SwapClear interface 

- Creation of mirrored trades enriched with keywords and fees 

- Import of EOD Reports for Market Data and Processing 

- Initial Margin calculation 

• CME Clearing House and CME Clearing Europe integration: 

- Trade connectivity via MQ 

- Creation of mirrored trades enriched with keywords and fees 

- Import of EOD Reports for Market Data and Processing 

- Initial Margin calculation 

• Processing of EOD Report in CDML format (Clearing Data Markup Language) for any CCP. 

[NOTE: Calypso does not provide exchange translators to the CDML format out-of-the-box] 

The concept provides a specification for the content and format of two file types, Trade Valuation and 
Initial Margin, into which the EOD Reports published by each CCP can be converted based on the business 
logic of their reports. This translation can be executed by a customer built translator, or any alternate 
method that our users want to employ. 

 

Calypso’s coverage for the services offered by the CCPs above is: 

• LCH SwapClear and SwapClear US: 

All eligible products. 
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- Interest Rate Swaps: Vanilla, Basis, OIS, Zero Coupon, Variable Notional 

- FRAs 

• CME Clearing House: 

All eligible IRS products. 

- Interest Rate Swaps: Vanilla, OIS, Zero Coupon, Single currency basis swaps 

- FRAs 

FX NDFs 

• CME Clearing Europe: 

All eligible IRS products. 

- Interest Rate Swaps: Vanilla 

- FRAs 

Similar levels of support for other CCPs and services will be added as they become operational. 

2.2 Intraday Processing 

The trades are imported in real-time from the CCP. For each trade captured on the affirmation platform, two 
mirrored trades are created in Calypso: 

• One to reflect the clearing member position at the CCP 

• One to reflect the client / house position at the clearing member 

The trades navigate the Calypso workflow based on their clearing status (cleared, rejected, request), using 
straight-through processing and exceptions monitoring. Once the trades are cleared, they update the accounts 
positions. Intraday commissions and periodic fees are computed on the trades. 

The system allows generating intraday margin call trades as margin calls are made by LCH. 

The system also supports CCP limit checks for pre-clearing. 

2.3 EOD Processing 

The key aspects of the EOD processing are as follows: 

• Monitoring of house and client accounts 

• Import and processing of CCP EOD files 

• Management of settlement activity flowing from this processing 

• Generation of Market Data based on EOD files 

• Storage of trade level valuations based on Marks in EOD files 

• Collateral Management process 

• Regulatory reporting: Client Statements, CFTC Minimum Net Capital Requirement report, Sequestration 
Fund Requirement report, Collateral Value report (LSOC regulation) 

At EOD, a number of files are imported from the CCP to update the client / house positions with the cashflows that 
are to be passed from the CCP to the clearing member, and ultimately to the Client or House entity. These 
cashflows include the PAI, Coupons, Fees, and Variation Margin. 

Initial margin (IM) requirements are imported from EOD files into the system and stored as pricer measures on 
Collateral Exposure trades, based on Margin Call Contracts configurations. There is one Collateral Exposure trade 
per Margin Call Contract and currency. Through the Collateral Management process, Calypso generates Margin Call 
trades to transfer cash or collateral securities into and out of the client’s accounts in order to maintain sufficient 
collateralization of their cleared positions. They are reported on the client statement, and based on the client’s 
request, the margin calls can then be settled, paid in a different currency, or substituted to collateral securities. 

Variation margins (VM) are represented by the cash positions of the cash client / house accounts. Margin calls to 
the variation margin requirements are computed through the Collateral Management process in cash, and occur 
when there is a negative balance in the client’s cash account. 
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Clearing Member Positions at the CCP 

For house activity, there is one Margin Call Contract per CCP and product type that handles IM between the 
clearing member and the CCP. 

For client activity, there is one Margin Call Contract per CCP and product type that handles IM between the clearing 
member and the CCP. 

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin 
calls are computed in the corresponding currency, and can be substituted to collateral securities. 

There is no variation margin requirement between the clearing member and the CCP. 

Client Positions at the Clearing Member 

Initial Margin 

There is one IM Margin Call Contract per Client, CCP and product type. 

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin 
calls are computed in the corresponding currency, and can be substituted to collateral securities. 

 

Variation Margin 

The system supports storing variation margins in multiple currencies, or in a single currency, based on the client’s 
choice. 

• Multi-currency scenario – There is one VM Margin Call Contract per Client and per currency (regardless of 
CCP and product type). 

In this case, there is one variation margin per currency, and the margin calls are computed per currency. 

• Single-currency scenario – There is one VM Margin Call Contract per Client. 

In this case, all variation margins are converted to the base currency of the Margin Call Contract. There is 
one variation margin in base currency, and the margin calls are computed in base currency. 

The various scenarios, and their impact of the Collateral Management process and the client statement, are 
described in the Calypso Clearing Member User Guide. 

2.4 Account Definition 

The clearing member module supports the following types of accounts: 

• House accounts for clearing member house activity 

• Individual segregated client accounts (ISA) for individual client activity 

• Omnibus segregated client accounts (OSA) for clients that provide clearing activity for their own individual 
clients 

House Accounts 

House accounts are created to monitor the clearing member’s trading activity, and differ from client accounts 
primarily in the way that they are treated by the CCP and Regulators. 
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Each house account is represented by an internal counterparty, which is a legal entity of the trading group within 
the same corporate structure, and a set of Calypso accounts. 

Trades are entered at the Internal Counterparty level, in the House book. 

VM, PAI, Coupons, Upfront Payments, etc. are calculated by the CCP at trade level - They are reported and 
accounted in Calypso at the House Account level. 

IM is calculated at the Internal Counterparty level. 

• IM is settled between the CCP and the Clearing Member at the Clearing Member level across all house 
accounts 

• IM is settled between the Clearing Member and the Internal Counterparty at the Internal Counterparty 
level 

Individual Client Accounts 

 

Each client account is represented by an external counterparty, and a set of Calypso accounts. An individual client 
may have multiple unique accounts. Each account is managed independently at the CCP. 

Trades are entered at the Client level, in the Client book. 

VM, PAI, Coupons, Upfront Payments, etc. are calculated by the CCP at trade level - They are reported and 
accounted in Calypso at the Client Account level. 

IM is calculated at the Client level. 

Clearing House (CCP) 

Clearing Member 

House Activity 

Internal 
Counterparty #1 

Internal 
Counterparty #2 

House Account #1 House Account #2 

Calypso Legal Entity Calypso Account 

Clearing House (CCP) 

Clearing Member 

Individual Client Activity 

Calypso Legal Entity Calypso Account 

Client #1 Client #2 

Client Account #1 Client Account #2 

Client #3 

Client Account #31 Client Account #32 
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• IM is settled between the CCP and the Clearing Member at the Clearing Member level across all client 
accounts 

• IM is settled between the Clearing Member and the Client at the Client level 

Omnibus Client Accounts 

 

The omnibus client provides clearing activity for its own individual clients. 

Each omnibus client is represented by an external counterparty. Each individual client is represented by an external 
counterparty, which parent is the omnibus client, and a set of Calypso accounts. 

Trades are entered at the Client level, in the Client book. 

VM, PAI, Coupons, Upfront Payments, etc. are calculated by the CCP at trade level - They are reported and 
accounted in Calypso at the Client Account level. 

IM is calculated at the Omnibus Client level. 

• IM is settled between the CCP and the Clearing Member at the Clearing Member level 

• IM is settled between the Clearing Member and the Omnibus Client at the Omnibus Client level 

  

Clearing House (CCP) 

Clearing Member 

Omnibus Client Activity 

Omnibus Client #4 Omnibus Client #5 

Client Account 
#41 

Client Account 
#42 

Client Account 
#51 

Client Account #52 

Client #41 Client #42 Client #51 Client #52 

Calypso Legal Entity Calypso Account 



15 Clearing Member Setup Guide 

2.5 Clearing Solution Flow 

 

 

Steps Details 

 

Client trades are captured in the Affirmation Platform and routed to Calypso through the CCP and Calypso 
Exchange Feed using Trade Event messages. 

The Calypso Exchange Feed transforms the messages into Upload Documents, and triggers the Calypso 
Data Uploader. 

 

The Calypso Data Uploader creates mirrored trades in Calypso to reflect the clearing member position at 
the CCP, and the client position at the clearing member. 

1 

2 

Trade Event 
messages 

Consent/Reject messages 

Clearing House (CCP) 

Calypso – Clearing Member 

Exchange Feed 

Upload Documents 

Client trades 

Messages 

ERS Limits 

Limits Check 

Consent/Reject 
messages 

EOD CCP Files 

Data Uploader 

Client/CMF trades 

CMF/CCP trades  

Client/CMF Clearing Transfer trades 

CMF/CCP Clearing Transfer trades 

Collateral Exposure trades 

Margin Call trades 

Scheduled Tasks 

CDML files processing 

(Note: Configured per CCP) 

Collateral 

Margin Call Contracts 

(IM - VM) 

PAI - Fees - Coupons 

Initial Margins 

Variation Margins 

Accounts Positions 

Settlement accounts 

Clearing accounts Margin Call 
Allocations 

Client Statement 
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Reference Data 

Legal Entities and Accounts 

SDIs - Drive transfers to accounts 

Commissions and Fees 

Scheduled Tasks 

CLEARING_STATEMENT 

Trade Event messages 

Consent/Reject 
messages 

Scheduled Tasks 

CLEARING_IMPORT_MARKET_DATA 

 

Market Data 
Collateral 
Exposure 

Cash 
balances 

Affirmation Platform 
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Limits are checked on the trades using ERS Limits. 

 

Once the trades are validated/rejected in Calypso, a consent/reject message is sent to the CCP so that the 
trades can be cleared, or rejected back to the executing broker. 

Once the trades are cleared, they update the accounts positions. 

Intraday commissions are computed on the trades. Periodic fees, rebates, and maintenance fees are 
invoiced to the clients. 

 

EOD – The CCP files are imported into Calypso using scheduled tasks. 

 

The scheduled tasks perform the following: 

• CDML files processing - You first need to store the files into the system using the scheduled task 
CLEARING_TRANSLATE_TO_CDML. Then you can process the files using the scheduled task 
CLEARING_PROCESS_FROM_CDML. 

The scheduled task CLEARING_PROCESS_FROM_CDML consumes the imported 
tradeValuationReport and initialMarginRreport CDML reports. 

• A set of scheduled tasks allow importing market data: 

- CLEARING_IMPORT_MARKET_DATA 

- CLEARING_IMPORT_SCENARIO_SHIFTS 

• COLLATERAL_MANAGEMENT computes cash margin calls on initial margins and variation margins. 

• ERS_ANALYSIS kicks off the calculation and storage of the limits usage and availability. 

 

Generation of the client statements using the scheduled task CLEARING_STATEMENT. 

 

Once the client receives the client statement, the client decides how to meet the margin calls computed by 
the COLLATERAL_MANAGEMENT scheduled task: in cash, securities, or both. 

The margin calls are modified accordingly using the Collateral Manager, and are settled as applicable. 

 

3 

4 

5 

6 

7 

8 
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Section 3. Before you Begin 

Before you begin, you need to define the following reference data. 

3.1 Eligible Currencies 

If you want to generate the Sequestered Report by currency, you need to define the eligible currencies for clearing. 

The eligible currencies are defined using Configuration > Definitions > Currency Defaults from the Calypso 
Navigator. 

Click Attributes, and set the attribute ClearingEligible = True. 

 

3.2 Pricing Environments 

You need to create the following pricing environments, pricer configurations, quotes sets, and pricing parameter 
sets. 

Pricing Env FROMDB CME_IM CME_VM LCH_IM LCH_VM 

Pricer Config FROMDB CME_IM CME_VM LCH_IM LCH_VM 

Quote Set FROMDB CME_IMReplication default LCH_IMReplication default 

Pricing Parameter Set FROMDB CME CME LCH LCH 

 

The pricing environment FROMDB is used for back office activities, and CME_IM, CME_VM, LCH_IM, LCH_VM are 
used for ERS activities. 

All pricing parameter sets listed above should have: 

• USE_MARKS = true 

• ADJUST_FX_RATE = false 

• Pricing Parameter Set FROMDB: ZD_PRICING = false 

 

Pricer configurations CME_IM, CME_VM, LCH_IM, LCH_VM: 

• Swap product = PricerSwap 

• FRA product = PricerFRA 

 

[NOTE: The quote sets CME_IMReplication and LCH_IMReplication must be defined in the Data Mapping window for 
InterfaceName = CME/QuoteSet or LCH/QuoteSet, and Interface Value = IMReplication – See Market Data for 
details] 

 

Pricer configuration FROMDB: 

• Swap product = PricerFromDB 

• FRA product = PricerFromDB 
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• FXNDF product = PricerClearingFromMarks (same as PricerFromDB, but it always uses the settlement ccy 
of a trade for loading marks). 

• ClearingTransfer product = PricerFromDB 

• CollateralExposure product = PricerCollateralExposure 

• MarginCall = PricerFromDB 

 

The pricing environment names in this documentation are only suggestions. Please feel free to assign names 
according to your business needs. 

 

3.3 Data Uploader Setup 

3.3.1 MQ Series Setup 

The Data Uploader reads and processes messages from IBM MQ Series via the Import Message engine, and 
transmits messages sent by the Sender engine. 

Message information going through the MQ Series queues are plain-text, XML-formatted strings. 

Step 1 - Install IBM MQ Series 

In addition to installing MQ series, you need to obtain the following JARs from IBM. 

• com.ibm.mq.commonservices_7.0.1.3.jar 

• com.ibm.mq.jar 

• com.ibm.mqjms.jar 

• com.ibm.mq.pcf.jar 

• dhbcore.jar 

• com.ibm.mq.headers.jar 

• com.ibm.mq.jmqi.jar 

• com.ibm.mq.jms.Nojndi.jar 

• connector.jar 

• fscontext.jar 

Add those JARs to your CLASSPATH. 

Step 2 – Create the MQ Series Queues 

Launch MQ Explorer and create the following objects - Note that you will need each of these object names in later 
steps: 

• Queue Manager 

• Input Queue 

• Output Queue 

Step 3 – Generate the Bindings File 

The bindings file is used as the PROVIDER_URL to connect to the middleware. 

Modify “<calypso home>/client/bin/uploaderMQSeries.bat”. Change the highlighted text to match the 

object names you have created in Step 2. Change the CLASSPATH to the appropriate path as needed. 

QM_Name == Your Queue Manager 
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InputQueueName == Your Input Queue 

OutputQueueName == Your Output Queue 

 

echo del qcf(QueueConnectionFactory) > uploadermqsetup.scp 

echo del q(OutputQueueName) >> uploadermqsetup.scp 

echo del q(InputQueueName) >> uploadermqsetup.scp 

echo def qcf(QueueConnectionFactory) qmgr(QM_Name) >> uploadermqsetup.scp 

echo def q(OutputQueueName) qu(OutputQueueName) qmgr(QM_Name) tc(JMS)>> 

uploadermqsetup.scp 

echo def q(InputQueueName) qu(InputQueueName) qmgr(QM_Name) tc(JMS)>> 

uploadermqsetup.scp 

echo end >> uploadermqsetup.scp 

 

set 

CLASSPATH="C:\tools\IBM\MQS\java\lib\com.ibm.mq.jar;C:\tools\IBM\MQS\java\lib\com.ibm.

mqjms.jar" 

 

Run “<calypso home>/client/bin/uploaderMQSeries.bat” to generate the bindings file. 

 

Step 4 – Set the PROVIDER_URL 

Rename “<calypso home>/client/resources/UploaderJMSAdmin.config.sample” to “<calypso 

home>/client/resources/UploaderJMSAdmin.config”, and update the PROVIDER_URL property as 

necessary for your implementation. 

• PROVIDER_URL=file://C:/tools/IBM/MQS/binding - The path to the bindings file you have 

generated in Step 3. 

 

[NOTE: Resource files need to be copied to <calypso home>/custom-extensions/custom-

projects/custom-shared-lib/src/calypso/resources. You may need to create this folder if it does not 

already exist. You will then need to deploy the files to your applications servers] 

 Please refer to the Calypso Installation Guide for details on deploying resource files. 

3.3.2 Incoming Messages Setup 

The Data Uploader creates GATEWAYMSG incoming messages into Calypso, and creates the trades. 

By default, the system sets the message sender to CLIENT and the message RECEIVER to CALYPSO. If these 
entities do not exist as Legal Entities, the system will create them. 

You can change those values as needed in the file “<calypso 

home>/client/resources/gatewayservice.properties”. 

Rename “<calypso home>/client/resources/gatewayservice.properties.sample” to “<calypso 

home>/client/resources/gatewayservice.properties” and modify as needed. 

GatewayServiceClientName=CLIENT 

GatwayServiceHostName=CALYPSO 

 

[NOTE: Resource files need to be copied to <calypso home>/custom-extensions/custom-

projects/custom-shared-lib/src/calypso/resources. You may need to create this folder if it does not 

already exist. You will then need to deploy the files to your applications servers] 

 Please refer to the Calypso Installation Guide for details on deploying resource files. 

 



Clearing Member Setup Guide 20 

©  2 0 1 1 – 2 0 1 8  |  Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved 

Message Workflow 

You need to define a message workflow to handle these messages. 

• EventClass: PSEventMessage 

• Subtype: GATEWAYMSG 

• Product: ALL 

 

 

[NOTE: Any status code change to this workflow needs to be recorded in the file “[calypso 

home>/client/resources/gatewayservice.properties”] 

# Gives list of BO Messages states that are used to link pending messages 

# These messages are blocked messages due to some validation error. 

BOMessageIncompleteStates=PENDING_VALID,PENDING_TRADE,BACKLOAD 

 

[NOTE: Resource files need to be copied to <calypso home>/custom-extensions/custom-

projects/custom-shared-lib/src/calypso/resources. You may need to create this folder if it does not 

already exist. You will then need to deploy the files to your applications servers] 

 Please refer to the Calypso Installation Guide for details on deploying resource files. 

3.3.3 Trade Workflows 

Note that the trade workflows are set per processing organization. 

The PO is the clearing member. For example, PO = CGM LLC. 

ALL Product Types 

Product Type = ALL 

Orig Status Action Resulting Status  Use 
STP 

Rules / Filter Create 
Task 

CLEARED AMEND VERIFIED true Rule AutomaticFees 

Filter CCPStatus-NOT-ALLEGED 

true 

CLEARED UPDATE CLEARED false Rule AutomaticFees true 

CLEARED TERMINATE TERMINATED false Rule 

AutomaticFees,UpdateTermination 

false 

CLEARED ENRICH VERIFIED false Rule AutomaticFees,CheckSDI 

Filter Cleared_On_OR_Before_Today 

true 

CONSENT GRANTED UPDATE CONSENT GRANTED false   true 

CONSENT GRANTED ACCEPT CREDIT_CONSENTED false  true 

CONSENT GRANTED REFUSE REJECTED false   true 

CONSENT GRANTED STP-ACCEPT CREDIT_CONSENTED true  true 
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Orig Status Action Resulting Status  Use 
STP 

Rules / Filter Create 
Task 

CONSENT REJECTED REFUSE REJECTED false   true 

CONSENT REJECTED REJECT REJECTED false   true 

CONSENT REJECTED UPDATE CONSENT REJECTED false   false 

CREDIT_CONSENTED TERMINATE TERMINATED false Rule UpdateTermination false 

CREDIT_CONSENTED UPDATE CREDIT_CONSENTED false   false 

CREDIT_CONSENTED AMEND CREDIT_CONSENTED false   false 

CREDIT_CONSENTED REFUSE REJECTED false Filter CCPStatus-NOT-CLEARED false 

CREDIT_CONSENTED ACK CLEARED true Filter CCPStatus-CLEARED true 

CREDIT_CONSENTED CLEAR CLEARED false Rule AutomaticFees true 

LIMIT_CHECK ACCEPT REQUIRES_CONSENT false   false 

LIMIT_CHECK UNDO PENDING false   false 

LIMIT_CHECK CHECK_LIMIT REQUIRES_CONSENT true Filter Limit-WhatIfCheckErrorN true 

LIMIT_CHECK CANCEL CANCELED false   false 

LIMIT_FAILED REJECT CONSENT REJECTED false   true 

LIMIT_FAILED UPDATE LIMIT_FAILED false   false 

LIMIT_FAILED AMEND LIMIT_FAILED false   true 

LIMIT_FAILED RECHECK_LIMIT PENDING false   true 

LIMIT_FAILED ACCEPT CONSENT GRANTED false   true 

LIMIT_FAILED REFUSE REJECTED false   false 

NONE NEW CLEARED false Rule 

AutomaticFees,ClearingLimitPortfolio 

Filter CCPStatus-NOT-ALLEGED 

false 

NONE NEW PENDING false Rule 

AutomaticFees,ClearingLimitPortfolio 

Filter CCPStatus-ALLEGED 

false 

PENDING AMEND VERIFIED false Rule CheckWhatIfLimits true 

PENDING ACCEPT CONSENT GRANTED true   false 

PENDING WHATIF LIMIT_CHECK false Rule CheckWhatIfLimits true 

REJECTED UPDATE REJECTED false   false 

REQUIRES_CONSENT REJECT CONSENT REJECTED false   true 

REQUIRES_CONSENT STP-REJECT LIMIT_FAILED true Filter Limit-WhatIFCheckPassN true 

REQUIRES_CONSENT REJECT LIMIT_FAILED false Filter Limit-IsViolated true 

REQUIRES_CONSENT UPDATE REQUIRES_CONSENT false   true 

REQUIRES_CONSENT STP-ACCEPT CONSENT GRANTED true Filter Limit-WhatIfCheckPass true 

REQUIRES_CONSENT ACCEPT CONSENT GRANTED false   false 

REQUIRES_CONSENT REFUSE REJECTED false   true 
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Orig Status Action Resulting Status  Use 
STP 

Rules / Filter Create 
Task 

TERMINATED AMEND TERMINATED false Rule AutomaticFees false 

TERMINATED UPDATE TERMINATED false   false 

VERIFIED CANCEL CANCELED false   false 

VERIFIED TERMINATE TERMINATED false Rule 

AutomaticFees,UpdateTermination 

true 

VERIFIED MATURE MATURED false   false 

VERIFIED UPDATE VERIFIED false   true 

VERIFIED AMEND VERIFIED false Rule AutomaticFees false 

VERIFIED ACCEPT CONSENT GRANTED false   true 

VERIFIED REJECT REJECTED false   true 

 

[NOTE: The transitions CREDIT_CONSENTED – ACK – CLEARED and LIMIT_CHECK – CHECK_LIMIT - 
REQUIRES_CONSENT must have “Generate Intermediate Event” checked to force the generation of a trade event 
so that the messages can be generated] 

 

Filter CCPStatus-ALLEGED 

 

Filter CCPStatus-NOT-ALLEGED 
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Filter Cleared_On_OR_Before_Today 

 

Filter CCPStatus-CLEARED 

 

Filter CCPStatus-NOT-CLEARED 

 

Filter Limit-WhatIfCheckErrorY 
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Filter Limit-WhatIfCheckErrorN 

 

Filter Limit-WhatIFCheckPass 

 

Filter Limit-WhatIFCheckPassN 

 

Filter Limit-IsViolated 
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Clearing Transfer 

Orig Status Action Resulting Status  STP Product Type Rules 

CANCELED AMEND CANCELED false ClearingTransfer  

NONE NEW PENDING false ClearingTransfer  

PENDING AUTHORIZE VERIFIED true ClearingTransfer CheckSDI 

PENDING CANCEL CANCELED false ClearingTransfer  

VERIFIED AMEND VERIFIED false ClearingTransfer  

VERIFIED CANCEL CANCELED false ClearingTransfer  

Collateral Exposure 

Orig Status Action Resulting Status  Use 
STP 

Product Type Rules  Create 
Task 

NONE NEW VERIFIED false CollateralExposure   false 

VERIFIED CANCEL CANCELED false CollateralExposure   false 

VERIFIED AMEND VERIFIED false CollateralExposure   false 

Interest Bearing 

Orig Status Action Resulting 
Status  

Use 
STP 

Product Type Rules  Create 
Task 

Gen Int. 
Event 

CLEARED AMEND VERIFIED false InterestBearing   false true 

NONE NEW VERIFIED true InterestBearing   false true 

VERIFIED AMEND VERIFIED false InterestBearing   false true 

VERIFIED CANCEL CANCELED false InterestBearing   false true 

Margin Call 

Orig 
Status 

Action Resulting 
Status  

Use 
STP 

Product 
Type 

Rules  Create 
Task 

NONE NEW PENDING false MarginCall UpdateClearingMarginCallKeywords true 

PENDING AUTHORIZE VERIFIED true MarginCall CheckSDI true 

VERIFIED AMEND VERIFIED false MarginCall   true 

VERIFIED CANCEL CANCELED false MarginCall   true 

The rule UpdateClearingMarginCallKeywords allows propagating the fields defined in the domain 
“Clearing.MCC.propagateFields”, from the margin call contract additional info to the margin call trades. 

If the domain “Clearing.MCC.propagateFields” is empty, the fields CCP, CCP_ORIGIN_CODE, MARGIN_TYPE and 
PRODUCT_TYPE are propagated by default. 

3.3.4 Calypso Engines 

The Import Message engine and Sender engine use “<calypso 

home>/client/resources/calypso_uploader_config.properties” to connect to the input and output 

queues of MQ Series. 

You should run these engines after the full clearing member setup is completed (legal entities, message 
configuration, etc.). 

 

Version 14.0+ 
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Make sure that the following engines are configured in “<calypso 

home>/deploy/EngineStartupConfig.properties”: 

engines.startup=TransferEngine,MessageEngine,InventoryEngine,AccountingEngine,Liquidat

ionEngine,PositionEngine,TaskEngine,LifeCycleEngine,UploaderImportMessageEngine,Upload

erSenderEngine 

 

#UploaderImportMessage Engine 

UploaderImportMessageEngine.class=com.calypso.tk.engine.UploadImportMessageEngine 

UploaderImportMessageEngine.name=UploaderImportMessageEngine 

UploaderImportMessageEngine.param.count=1 

UploaderImportMessageEngine.param.1=config 

UploaderImportMessageEngine.param.value.1=Uploader 

 

# Uploader Sender Engine 

UploaderSenderEngine.class=com.calypso.engine.advice.SenderEngine 

UploaderSenderEngine.name=UploaderSenderEngine 

UploaderSenderEngine.param.count=1 

UploaderSenderEngine.param.1=config 

UploaderSenderEngine.param.value.1=Uploader 

 

You can then start the Import Message engine and Sender engine as part of the Engine server using "<calypso 

home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on 

*nix platforms. 

 

Version 14.1+ 

The Import Message engine and the Sender engine are configured in the Engine Manager of Web Admin: event 
subscription and engine parameters. 
You may need to add these engine if they are not available for configuration: 

• For the Import Message engine, create a new engine called UploaderImportMessageEngine, with class 
name com.calypso.tk.engine.UploadImportMessageEngine 

Engine parameter config=Uploader 

• For the Sender engine, create a new engine called UploaderSenderEngine, with class name 
com.calypso.engine.advice.SenderEngine 

 

The Import Message engine and the Sender engine can be started from the Engine Manager in Web Admin. 

 Please refer to Calypso Web Admin documentation for complete details. 

 

The Import Message engine is now listening to messages from the MQ input queue. 

The Sender engine is now sending messages to the MQ output queue. 

 

If you want to run another Import Message engine with “-config LCH_1” for example, you would need to: 

• Create the following classes: 

LCH_1Message.java 

LCH_1MessageHandler.java 

LCH_1IEAdapter.java 

LCH_1IEAdapterConfig.java 

Contact Calypso Support for sample classes. 

• Create a file LCH_1bridge_config.properties with the appropriate MQ connection information. 

*If* the details in LCHbridgeservice.properties cannot be used for this second queue, you need to 

create LCH_1bridgeservice.properties. 
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Then you need to add an entry for the LCH_1 Import Message engine to “<calypso 

home>/deploy/EngineStartupConfig.properties” as described above. 

Please note that the queue *must* have the LCH (or CME) prefix for this process to work. 

3.3.5 Task Station Configuration 

You can view EX_GATEWAY exceptions in the Task Station for exceptions related to the integration of 
GATEWAYMSG messages. 

You can also view GATEWAYMSG messages using <status code>_GATEWAYMSG. 

3.4 Exchange Feed Setup 

3.4.1 Property Files 

The Exchange Feed module requires the configuration of the following property files: 

• <calypso home>/client/resources/CMEbridgeservice.properties and <calypso 

home>/client/resources/LCHbridgeservice.properties 

• <calypso home>/client/resources/ErrorCodeBundleExchangeFeed.properties 

• <calypso home>/client/resources/Core.DataServer.serviceconfig.xml 

• <calypso home>/client/resources/CMEbridge_config.properties and <calypso 

home>/client/resources/LCHbridge_config.properties 

 

[NOTE: Resource files need to be copied to <calypso home>/custom-extensions/custom-

projects/custom-shared-lib/src/calypso/resources. You may need to create this folder if it does not 

already exist. You will then need to deploy the files to your applications servers] 

 Please refer to the Calypso Installation Guide for details on deploying resource files. 

 

“CMEbridgeservice.properties” and “LCHbridgeservice.properties” 

You need to set the following properties: 

• bridge.counterparty.attribute.identifier - Counterparty attribute that stores the counterparty. 

• bridge.book.attribute.identifier – Book attribute that stores the book. 

• BridgeMessageDefaultSender – Default message sender = CME or LCH 

• BridgeMessageDefaultReceiver – Default message receiver (clearing member PO) 

• <MESSAGE_TYPE>_<PRODUCT>_BRIDGE_XSLT - To override default product specific XSLT invoked 
within TransformBridgeMessageRule (optional) 

• <MESSAGE_TYPE>_<PRODUCT>_BRIDGE_XSLT_CLASS – To override default product XSLT java class 
used for transformation invoked within TransformBridgeMessageRule (optional) 

• file.bridge.log.directory -Directory for all original messages for logging purpose. 

• ThreadPoolSize - Number of threads 

• ValidatorFiles – Set of XSLT files which are used to validate if the incoming message can be handled by 
the engine. 

 

Sample “CMEbridgeservice.properties” 

REQUESTCONSENT_SWAP_BRIDGE_XSLT= 
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CLEARINGCONFIRMED_SWAP_BRIDGE_XSLT= 

REQUESTCONSENT_SWAP_BRIDGE_XSLT_CLASS= 

CLEARINGCONFIRMED_SWAP_BRIDGE_XSLT_CLASS= 

bridge.counterparty.attribute.identifier=CME_CPTY 

bridge.book.attribute.identifier=CME_ACCOUNT 

file.bridge.log.directory=/mnt/presales/logs/clearing/cme 

BridgeMessageDefaultSender=CME 

BridgeMessageDefaultReceiver=CGM LLC 

ThreadPoolSize=5 

ValidatorFiles=exchange_feed_cme_clearing_confirmed_check_fpml5.0.xslt,exchange_feed_c

me_request_consent_check_fpml5.0.xslt,exchange_feed_cme_clearing_refused_check_fpml5.0

.xslt 

 

“ErrorCodeBundleExchangeFeed.properties” 

This file is used to define Exchange Feed module specific exception IDs and message content mapping. 

Please note that this is an extension of “ErrorCodeBundle.properties”. The system requires both property 

files. 

This file contains the following information: 

#Exchange Feed Msg override datauploader 

EF_10014=Channel is not running 

EF_10015=Cannot parse file 

EF_10016=Cannot read file 

EF_10017=Cannot find gateway message with linked ID 

EF_10018=Invalid trade id in gateway message 

EF_10019=Cannot find trade 

EF_10020=Missing values from clearing status 

EF_10021=More than 1 trade found for external reference 

EF_10022=No Previous BridgeMessage Found 

EF_10023=Trade Not Found 

EF_10024=Invalid Interest Compounding Method 

EF_10025=Invalid Interest Compounding Frequency 

EF_10026=No prefered FX Rate definition found 

EF_10027=Trade Source not found in Trade Keyword 

EF_10028=Domain value not found 

EF_10029=No Trade found with Correlation ID provided 

#Error Types 

EF_23000=MQ Exception 

EF_21002=Miss Data for Transform 

 

#Exchange Feed Error Msg 

EF_50001=Invalid FPML Message 

EF_50002=Folder Not Exist 

EF_50003=ExchangeFeedBridgeEngine is not registered 

EF_50004=Missing FeedConfigType in message 

EF_50005=Message Handling failure 

 

#Exchange Feed Field 

EF_00001=External Reference 

 

“Core.DataServer.serviceconfig.xml” 

Add the following lines to register the RMI Server in the Data Server: 

<bean id=”baseDataUploadServer” class=”com.calypso.tk.service.DataUploadServerImpl”> 

</bean> 

<bean id=”rmiBaseDataUploadServer” parent=”rmiServiceExporter”> 

   <property name=”service” ref=”baseDataUploadServer” /> 

   <meta key=”serviceInterface” value=”com.calypso.tk.service.RemoteDataUpload” /> 
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</bean> 

 

“CMEbridge_config.properties” and “LCHbridge_config.properties” 

These files are required by MQ Series as a channel for incoming and outgoing messages. 

The Import Message engine reads the data from the file to establish connection to the MQ to retrieve/send data 
from/to the queue. 

• jms.modetypeclass - Factory class in the JNDI service provider 

• jms.url – JNDI directory where the MQ binding files reside 

• jms.queue.connectionFactory – JMS Connection factory name is set under the MQ server setup 

• jms.channels - MQ channel to be monitored 

• monitor.frequency -  Monitoring intervals 

• input.queue.name – JMS Queue name is bound to the MQ queue for incoming messages from 

• output.queue.name – JMS Queue name is bound to the MQ queue for outgoing messages 

 

Sample “CMEbridge_config.properties” 

# JMS properties file 

# 

jms.modetypeclass=com.sun.jndi.fscontext.RefFSContextFactory 

jms.url=file:/c:/calypso/software/JNDI-Directory 

jms.queue.connectionFactory=CME_MATCHING.CF 

#indicate that messages will be sent to a JMS WebSphere MQ client 

jms.sender.queue.targetClient=MQJMS_CLIENT_NONJMS_MQ 

jms.receiver.queue.targetClient=MQJMS_CLIENT_NONJMS_MQ 

jms.channels=TO.CALYPSO, CME.TO.CALYPSO2 

# monitor for the queue channel listed above, in terms of second 

monitor.frequency = 60 

 

input.queue.name=JQUEUE.CME.CALYPSO 

JQUEUE.CME.CALYPSO.queue.ackType=auto 

JQUEUE.CME.CALYPSO.queue.persist=false 

JQUEUE.CME.CALYPSO.queue.transacted=false 

 

output.queue.name=JQUEUE.CALYPSO.CME 

JQUEUE.CALYPSO.CME.queue.ackType=auto 

JQUEUE.CALYPSO.CME.queue.persist=false 

JQUEUE.CALYPSO.CME.queue.transacted=false 

 

Sample “LCHbridge_config.properties” 

# JMS properties file 

# 

jms.modetypeclass=com.sun.jndi.fscontext.RefFSContextFactory 

jms.url=file:/c:/calypso/software/JNDI-Directory 

jms.queue.connectionFactory=LCH_MATCHING.CF 

monitor.frequency = 60 

 

input.queue.name=JQUEUE.LCH.CALYPSO 

JQUEUE.LCH.CALYPSO.queue.ackType=auto 

JQUEUE.LCH.CALYPSO.queue.persist=false 

JQUEUE.LCH.CALYPSO.queue.transacted=false 

 

output.queue.name=JQUEUE.CALYPSO.LCH 

JQUEUE.CALYPSO.LCH.queue.ackType=auto 
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JQUEUE.CALYPSO.LCH.queue.persist=false 

JQUEUE.CALYPSO.LCH.queue.transacted=false 

3.4.2 Exchange Feed Bridge Engine Registration 

Version 14.0+ 

Add ExchangeFeedBridgeEngine to the Engine configuration using Configuration > System > Engine Config 
from the Calypso Navigator. 

Configure ExchangeFeedBridgeEngine to subscribe to PSEventMessage using Configuration > System > Event 
from the Calypso Navigator. 

Add the event filter BridgeMessageEventFilter to ExchangeFeedBridgeEngine. 

This event filter takes the selection criteria from the static data filter “BridgeMessageEventFilter”. It should be 
defined as: 

 

 

Version 14.1+ 

The ExchangeFeedBridge engine is configured in the Engine Manager of Web Admin: event subscription and engine 
parameters. 

You may need to add this engine if it is not available for configuration: Create a new engine called 
ExchangeFeedBridgeEngine, with class name com.calypso.tk.engine.ExchangeFeedBridgeEngine. 

3.4.3 Incoming Messages Setup 

The Exchange Feed processes CONSENT messages and BRIDGEMSG messages. It transforms BRIDGEMSG 
messages into Calypso Upload Document objects through the TransformBridge rule. The Exchange Feed Bridge 
engine generates the GATEWAYMSG messages that trigger the Data Uploader to create trades in Calypso based on 
the Calypso Upload Document objects. 

BRIDGEMSG Message Workflow 

This workflow can be imported using the file “<calypso 

home>/client/resources/workflow/BRIDGEMSG.wf”. 

If you are clearing with LCH, this workflow should be imported using the file “<calypso 

home>/client/resources/BRIDGEMSG_FOR_CVR.wf” instead. It adds the transition highlighted below for 

managing incoming collateralAllocation messages. 

Orig Status Action Resulting 
Status 

STP Rules Comments 

COMPLETED REDO PENDING false RedoBridge  

COMPLETED AMEND COMPLETED false   
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Orig Status Action Resulting 
Status 

STP Rules Comments 

NONE NEW PENDING false   

PENDING TRANSFORM TRANSFORMED true TransformBridge Swap_BRIDGE_XSLT= 

SWAP_DEFAULT.xslt 

PENDING LOAD COMPLETED false TransformBridge Swap_BRIDGE_XSLT= 

SWAP_DEFAULT.xslt 

PENDING CANCEL CANCELED false   

PENDING MATCH COMPLETED true MatchCollateralAllocationResponse 

Filter: isLCHCVRMessage 

 

TRANSFORMED REDO PENDING false RedoBridge  

TRANSFORMED LOAD COMPLETED false MergeTradeId  

TRANSFORMED CANCEL CANCELED false   

Static data filter “isLCHCVRMessage”: 

 

CONSENT Message Workflow 

This workflow can be imported using the file “<calypso home>/client/resources/workflow/CONSENT.wf”. 

Orig Status Action Resulting Status STP Message Type Rules 

NONE NEW PENDING false CONSENT  

PENDING AUTHORIZE TO_BE_SENT true CONSENT CheckContact 

TO_BE_SENT SEND SENT true CONSENT  

3.4.4 Task Station Configuration 

You can view EX_BRIDGE exceptions in the Task Station for exceptions related to the integration of BRIDGE 
messages. 

You can also view BRIDGEMSG messages using <status code>_BRIDGEMSG. 

3.4.5 Data Mapping 
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Add the Calypso Mapping Window to the Calypso menu (menu action mapping.CalypsoMappingWindow), so 

that you can define mapping values between the CCPs and Calypso. 

Mapping values are provided out-of-the-box, and need to be reviewed / validated for the interface names “CME”, 
“ExchangeFeed.CME”, “ExchangeFeed.LCH”, and “LCH”. 

 

To audit changes to the Data Mapping, add CalypsoMapping to the domain “classAuditMode”. 

Important Note: 

Make sure that the overnight reference indices defined in Calypso (EONIA, FEDFUNDS, etc.) have the reference 
index attribute IndexCalculator = OISNew. 

Trade Keywords 

A set of trade keywords allow standardizing the Clearing solution. 

It is possible to map a keyword name/value to another one by setting the mapping through the Calypso Mapping 
Window. 

 

 

Clearing Keywords 

Trade Keywords Description 

CCP Clearing house: CME, LCH, etc. 

Short name of the clearing house legal entity. 

CCPAccountReference Clearing house account name - SDI selection is based on this trade 
keyword, which value must match the “ExternalName” of the Calypso 
client/house account. 
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Trade Keywords Description 

CCPBlockTradeID Block trade ID. 

CCPClearedDate Date that the trade is processed by the clearing house. 

CCPFirmReference Clearing Member Firm identifier. 

CCPMessageTimestamp Message timestamp. 

CCPOriginCode Set to either HOUSE or CLIENT to reflect house activity or client activity. 

CCPTradeID Trade ID assigned by the clearing house. It is also set on the trade’s 
External Reference. 

ClearingConfirmedCorrelationID LCH trade confirmation number. 

ClearingConfirmedIncomingMessageID LCH message confirmation number. 

ClearingConfirmedSentBy LCH confirmation sender reference. 

ClearingConfirmedSentTo LCH confirmation receiver reference. 

client_trade_id Trade ID provided by the client. 

CMFAccountReference Set by the system when a trade is created: ID of the Calypso clearing 
account. 

IS_CLIENT Set to “false” for HOUSE trades and clearing member mirror trades. 

Set to true for client mirror trades. 

LIMIT_WHATIF_CHECK_PASS Y if the limits check passed, or N otherwise. 

LIMIT_WHATIF_LIMIT_MAX Limit amount. 

LIMIT_WHATIF_PORTFOLIO ERS Limits portfolio. 

LIMIT_WHATIF_RISK_USAGE Trade amount contributing to the limit check. 

PlatformTradeID Trade ID assigned by the platform where the trade is captured (Markitwire 
for example). 

Status Trade status at the clearing house. 

TradeSource Platform where the trade is captured (Markitwire for example). 

USUPrefix Unique swap identifier - CFTC namespace. 

USIValue Unique swap identifier – trade ID. 

Mirror Keywords 

The following trade keywords need to be propagated on the mirror trades. 

They need to be added to the domain “MirrorKeywords”: CCP, CCPAccountReference, CCPClearedDate, 

CCPOriginCode, CCPSettlementType, CCPTradeID, LIMIT_WHATIF_CHECK_ERROR, 
LIMIT_WHATIF_CHECK_ERROR_MSG, LIMIT_WHATIF_CHECK_PASS, LIMIT_WHATIF_LIMIT_MAX, 
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LIMIT_WHATIF_PORTFOLIO, LIMIT_WHATIF_RISK_USAGE, PlatformTradeID, RelatedProductType, Status, 
USIPrefix, USIValue. 

Examples: 

 

Trade Templates 

Trade templates are required to populate missing information from the incoming messages. 

You can create trade templates from the Trade windows using “Save As Template” from the product specific menu. 

In the Calypso Mapping Window, you can set the trade template for a given product type. 

Select the InterfaceName “ExchangeFeed.CME” and add a TradeTemplate: 

• Interface Value = product type (Example “InterestRateSwap”) 

• Calypso Value = trade template (Example “USD3L1”) 

 

Repeat for more product types as needed, and for the InterfaceName “ExchangeFeed.LCH” as needed. 

 

3.5 Clearing Member Setup 

The following files are available under ““<calypso home>/client/resources/config/”: 

• clearingconnection.properties.sample 

• clearing.properties.sample 

• clearing.reportPaths.properties.sample 

• CustomClearingReports.xml.sample 

• clearingServiceCodes.properties.sample 

 

These files are optional – They are used to override out-of-the-box properties, see below for usage. 
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[NOTE: Resource files need to be copied to <calypso home>/custom-extensions/custom-

projects/custom-shared-lib/src/calypso/resources. You may need to create this folder if it does not 

already exist. You will then need to deploy the files to your applications servers] 

 Please refer to the Calypso Installation Guide for details on deploying resource files. 

 

“clearingconnection.properties” 

Rename “clearingconnection.properties.sample” to “clearingconnection.properties”, and modify 

as needed. 

This file contains connection information to the CCP. 

# Key format is 

# 

# <CCP short name>.<Firm ID (PO LE attribute)>.<key> 

# 

# URI format must include protocol, host and port (where applicable) 

# 

# For public key SFTP authentication, keyPassphrase is optional. Key 

# path can be an absolute filesystem path, or a resource path within 

# the classpath. Filesystem paths take precedence 

 

CME.4Q0.URI=sftp://sftpng.cmegroup.com:22 

CME.4Q0.user=<user> 

CME.4Q0.password=<password> 

 

LCH.CC1.URI=sftp://195.246.228.9:6020 

LCH.CC1.user=<user> 

LCH.CC1.key=<path to CC1 key> 

 

LCH.CC2.URI=sftp://195.246.228.9:6020 

LCH.CC2.user=<user> 

LCH.CC2.key=<path to CC2 key> 

LCH.CC2.keyPassphrase=<CC2 key passphrase> 

 

Firm Id 

They are stored in the attributes of the clearing member processing org: “<CCP><Clearing Service>FirmId”, for 
example “CMEIRDFirmId”. 

If no such legal entity attribute is found, the system will look for the legal entity attribute “<CCP>FirmId”, for 
example “CMEFirmId”. 

In this example, the CMEFirmId is “4Q0” – This is a test environment for Calypso – You need to replace it with your 
own firm ID. 

In this example, the LCHFirmId for LCH US is CC1, and the LCHFirmId for LCH UK is CC2 – There are test 
environments for Calypso – You need to replace them with your own environments. 

 

URI 

Then set the values for the parameters URI. 

In this example, “sftp://sftpng.cmegroup.com:22” is a test environment for Calypso – You need to replace it with 
your own environment. 

The following types of URI are currently supported: HTTP/S, SFTP, FTPS, FTP and local file system. 

Examples of local file system: 

CME.4Q0.URI=file://C:/CLEARING/Data/CME 

LCH.CC1.URI=file://C://CLEARING//Data//LCH 
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User / Password or User / Key 

Then set the values for the parameters user/password, or user/key/keyPassphrase. 

If you set both user/password, and user/key/keyPassphrase for a given URI, user/key/keyPassphrase will be used 
for authentication. 

keyPassphrase is optional – It is only needed if the key is protected. 

 

“clearing.properties” 

This file is used to override default properties as needed. 

If you want to override the default properties, rename “clearing. properties.sample” to “clearing. 

properties”. 

 

clearing.import.folder 

The default import folder is “<user home>\Calypso\clearing\” on the server where the Scheduler engine is 

running, and for the user running the Scheduler engine. 

If you want to override the default import folder, rename “clearing.properties.sample” to 

“clearing.properties” and set the import folder “clearing.import.folder”. 

# 

# Clearing configuration properties 

# 

 

# Import data base folder. If not defined, it will 

# default to $calypso_user_home/clearing, were $calypso_user_home 

# is the running user's Calypso home (-userhome arg) 

# 

#clearing.import.folder=/home/clearing/Calypso/clearing 

clearing.import.folder=X:\\shared\\Calypso\\clearing 

 

clearing.custom.packages 

You can set custom packages as needed using the property clearing.custom.packages. 

Example: 

clearing.custom.packages=pkg1,pkg2,...,pkgN 

where pkgN is the custom packages to add, for example: 

clearing.custom.packages=com.customer.package1,com.customer.package2 

If the property clearing.custom.packages does not contain the package “com.calypso.clearing”, it will be 

added at the end of the list. 

If the property clearing.custom.packages contains the package “com.calypso.clearing”, its order in the list 

will be respected. 

 

clearing.import.lchFirmIdPathSuffix 

By default, when clearing members access their LCH environment, the “LCH<Clearing Service>FirmId” is used to 
identify the path to the CCP files. If such attribute is not present, it is the attribute “LCHFirmId”. 

If the clearing members want to access their test environment at LCH instead, the path to the CCP files is identified 
by the “LCH<Clearing Service>FirmId” / “LCHFirmID” with the suffix “(mbr)”. 

This property allows setting the suffix to access the test environment. 

Example: 

clearing.import.lchFirmIdPathSuffix=(mbr) 
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clearing.import.lch.swapClearFolderSuffix 

By default, the CCP files are stored in the SwapClear folder but LCH could setup another folder for testing 
purposes. 

The other folder can be accessed using the folder suffix defined in this property. 

The folder will become “Swap Clear <folder suffix>”. 

Example: 

clearing.import.lch.swapClearFolderSuffix=\ Member Test Refresh 

 

The folder /<mnemonic>/SwapClear/ will be transformed to /<mnemonic>/SwapClear Member Test 

Refresh/. 

 

clearing.import.cme.UATNRSuffix 

If defined, the value of this property will be added in front of all CSV and XML file extensions. 

Example: 

clearing.import.cme.UATNRSuffix=.nr 

 

The suffix will be added as follows: "/cme/ftp/PUB/IRS/IRSDFR_LIBOR1M_${date}.nr.csv”. 

 

“clearing.reportPaths.properties” 

This file is used to override report paths. It contains the default report paths for reference. You can override as 
needed. 

If you want to override the default report paths, rename “clearing.reportPaths.properties.sample” to 

“clearing.reportPaths.properties”. 

# 

# Report paths overrides 

# 

# Paths defined in this properties file will override those loaded from the 

# OOTB configuration and CustomClearingReports.xml. Only paths can be 

# overridden here, no other report attribute will be modified. Refer to 

# Clearing documentation for more information. 

# 

# The following syntaxes are accepted 

# 

#  <reportBeanName>=<new report path> 

#  <CCP>.<reportName>=<new report path> 

# 

# where 

# 

#  reportBeanName : report bean name, with bean as in Spring bean. See 

#                   CustomClearingReports.xml for more info 

# 

 

Example: 

CME.CMEPAAQuote = /cme/ftp/PUB/IRS/cme.paa.rate.{date}.csv 
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The following placeholders are supported: 

• ${date}: Valuation date. Formatting depends on CCP. 

• ${firmId}: Firm ID, as defined in the legal entity attributes “<CCP><Clearing Service>FirmId” or 
“<CCP>FirmId” if not present. 

• ${lchDynamicDateFolder}: Only for LCH. It is based on the value of the legal entity attribute 
“LCHRemoteFolderStructure”: 

• If it is set to “Dynamic”, then ${lchDynamicDateFolder} is the formatted valuation date, plus a final 
forward slash (/). Only for LCH and for Dynamic folders, as defined in the legal entity attribute 
“LCHRemoteFolderStructure”. 

• If it is set to “Static” then ${lchDynamicDateFolder} is an empty string. 

 

You can also use this file to handle individual Zip files: You need to override the report path by adding one of the 
following suffixes: 

• zip 

• gz 

 

Example: 

LCH.HistoricIndexRates = /Public(mbr)/SwapClear/Trade/${date}_REP00003 - Historic 

Index Rates_ 1.TXT.zip 

 

Additional capability – The following syntax is also supported: 

${key=value?expandedValue} 

For example: 

${firmId=CC2?.zip} 

meaning: 

• If firmId is CC2, then the “.zip” suffix is added. 

• If not, nothing is added. 

Example: 

LCH.CashSettlementReport = 

/${firmId}/SwapClear/${lchDynamicDateFolder}${date}_REP00016c - OTC Portfolio Cash 

Settlement (Client)_ 1.TXT${firmId=CC2?.zip} 

 

“CustomClearingReports.xml” 

This file is used to override default reports and market data. 

If you want to override the default reports and market data, rename “CustomClearingReports.xml.sample” 

to “CustomClearingReports.xml”. 

[NOTE: The report configuration is done using Spring] 

 

Adding a new report: For example, we need to add a new CME DFR curve, IRSDFRCurve_AONIA. The way to do 
it is to add the following XML to the file “CustomClearingReports.xml”: 

<bean id="IRSDFRCurve_AONIA" 

class="com.calypso.tk.clearing.external.report.CMEReport"> 

   <property name="name" value="IRSDFRCurve_AONIA" /> 

   <property name="CCP" value="CME" /> 

   <property name="displayName" value="IRS DFR Curve - AONIA" /> 
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   <property name="type" value="MARKET_DATA" /> 

   <property name="path" value="/cme/ftp/PUB/IRS/IRSDFR_AONIA_${date}.nr.csv" /> 

   <property name="XSLResourcePath" value="stylesheet/cme/CME_DFR.xslt" /> 

   <property name="defaultFormat" value="CSV" /> 

   <property name="attributes"> 

      <map> 

         <entry key="marketDataType"> 

            <util:constant static-

field="com.calypso.tk.clearing.external.report.MarketDataType.CURVES" /> 

         </entry> 

      </map> 

   </property> 

   <property name="plugins"> 

      <list> 

         <ref bean="cmeCurveProcessorPlugin" /> 

      </list> 

   </property> 

</bean> 

 

Description of each property: 

• name (mandatory) : Name of the report. Along with the CCP, it fully identifies a report. 

• CCP (mandatory). 

• displayName (optional) : Will default to the name. 

• type (mandatory) : We currently support 2 types of reports: 

• EOD_REPORT : reports used in BO processing (e.g.: margin) 

• MARKET_DATA 

• path (mandatory) : Remote path of the report. Note the ${date} placeholder: some variables can be 
used, always enclosed in ${} 

• date : valuation date 

• firmId : e.g. 4Q0 or CC1 in our case. Taken from the PO LE attributes “<CCP><Clearing Service>FirmId” 
or “<CCP>FirmId” if not present 

• XSLResourcePath (mandatory): CLASSPATH path of the XSLT style sheet to process the report 

• defaultFormat (optional) : Raw report format. 3 types currently supported 

• XML 

• CSV (Comma Separated Values) (e.g.: used in CME) 

• TSV (Tab Separated Values) (e.g.: used in LCH) 

• attributes (optional) 

• marketDataType: within market data type we support several subtypes. The marketDataType is 
important, because, OOB, the report groups that used to be defined in the clearingmarketdata.properties 
files are now dynamically built by grouping reports that have the same marketDataType. E.g.: all reports 
with marketDataType=com.calypso.tk.clearing.external.report.MarketDataType.CURVES will form the 
OOB group "Curves". The supported types are 

com.calypso.tk.clearing.external.report.MarketDataType.CURVES ("Curves" group) 

com.calypso.tk.clearing.external.report.MarketDataType.QUOTES ("Quotes" group) 

com.calypso.tk.clearing.external.report.MarketDataType.RATE_RESET ("Rate Resets" group) 

com.calypso.tk.clearing.external.report.MarketDataType.HOLIDAYS ("Holidays" group) 

• plugins (optional) 

 

For the specific case of CME DFR curves, there is an easier way to add a new one: this would be an equivalent 
definition: 

<bean name="IRSDFRCurve_AONIA" parent="parentDFRCMEReport"> 
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   <property name="path" value="/cme/ftp/PUB/IRS/IRSDFR_AONIA_${date}.nr.csv" /> 

</bean> 

Note the parent=parentDFRCMEReport : that will complete the rest of the configuration. 

Modifying the OOB market data groups: For example, you do not want to download all the OOB curves, but 
only 2 of them: IRSDFRCurve_AONIA and IRSDFRCurve_TONAR. You can add the following XML to 
“CustomClearingReports.xml”: 

<bean name="curvesGroupBean" 

class="com.calypso.tk.clearing.external.report.ReportInfoGroup"> 

   <property name="name" value="Curves" /> 

   <property name="reportNames"> 

      <set> 

         <value>IRSDFRCurve_AONIA</value> 

         <value>IRSDFRCurve_TONAR</value> 

      </set> 

   </property> 

</bean> 

 

The property name=Curves will make the OOB Curves group to be ignored, and the new one will contain only those 
2 reports. Needless to say, the report names must point to existing report: if you add names of unknown reports, 
they will be ignored. 

“clearingServiceCodes.properties” 

This file is used to override default service codes. Service codes are used in the scheduled task 
CLEARING_EXPORT_CVR_WORKSHEET to determine the file name. 

#  

# Clearing Service Codes 

# 

# Arbitrary codes that identify Clearing Services. Initially, a clearing service 

# would identify a product, or family of products (product type) that are usually 

# margined together, although in the future this definition could change 

# 

# Current supported syntax is 

# 

#   < CCP short name>.<Product type>=<Service Code> 

# 

# Uncomment and redefine, if needed 

#   

#CME.IRD=01 

#CME.NDF=02 

#LCH.IRD=03 

3.6 Collateral Setup 

3.6.1 Collateral Workflow 

The Collateral workflow provided out-of-the box by the Collateral module must be modified as follows. 

All the transitions from NONE to EXECUTED should be STP. 

Orig Status Action Resulting Status  Use STP Rules 

ALLOCATED VALIDATE VALIDATED true  

EXECUTED AMEND EXECUTED false  

EXECUTED SUBSTITUTE EXECUTED false Execute 



41 Clearing Member Setup Guide 

EXPOSURE_AGREED ALLOCATE ALLOCATED true  

NONE NEW PRICING true  

PRICED_NO_CALL AGREE_EXPOSURE EXPOSURE_AGREED false  

PRICED_PAY AGREE_EXPOSURE EXPOSURE_AGREED true AutoAdjust 

PRICED_RECEIVE AGREE_EXPOSURE EXPOSURE_AGREED true AutoAdjust 

PRICING PRICE PRICED_NO_CALL true CheckNoCall 

PRICING PRICE PRICED_PAY true CheckPay 

PRICING PRICE PRICED_RECEIVE true CheckReceive 

VALIDATED EXECUTE EXECUTED true Execute 

3.6.2 Buffer Functionality 

The multi-buffer functionality is only enabled if the domain “Collateral.Multiplier” contains the value “Buffer”. 

3.7 ERS Limits Setup 

You need to set the following environment properties in the Calypso User Env. 

Environment Property Description Sample Value 

ERS_RISK_SERVICE_ROOT URL of the ERS Risk services – It 
contains the host name and port 

number of the ERS Web Services. 

http://localhost:8084/risk-services 

ERS_RISK_APP_URL URL of the ERS Risk application – It 
contains the host name and port 
number of the ERS Web Services. 

http://localhost:8084/risk-services 

ERS_LIMIT_POSTDEAL_STATUS List of Trade status codes for post-
deal limit checking. 

VERIFIED,PRICING 

ERS_LIMIT_PREDEAL_STATUS List of Trade status codes for pre-
deal limit checking. 

NONE,PENDING 

ERS_PRICING_ENV ERS pricing environment. 

[NOTE: Make sure that the user who 
runs the risk engines has the same 
timezone as the selected pricing 
environment] 

INTRADAY 

ERS_LIMIT_APP_URL URL of the ERS Limits application – 
It contains the host name and port 
number of the ERS Web Services. 

http://localhost:8084/limits-services 

ERS_LIMIT_SERVICE Types of limits to be computed: 
CreditRisk, MarketRisk, or ALL. 

ALL 
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Section 4. Legal Entities and Accounts Setup 

Notes 

Legal entities must be defined to identify the clearing house, the clearing member (processing org), 
and the clients. They should all have at least one contact. 

When defining legal entities, accounts, and books, a number of attributes will be set as well. Please 
remember that attributes and their values are case sensitive. 

4.1 Defining Books 

The book in Calypso is used to store trades. 

When trades are imported into the system, and trades are created as a result of the EOD processes, the books are 
set according to the following logic. This applies to cleared trades, clearing transfer trades, margin call trades and 
collateral exposure trades. 

You have two options to define books: 

• Option 1 - Define books at the clearing account level (CCP facing trades and client / house facing trades 
are in the same book for a given clearing account) 

• Option 2 - Define books at the legal entity level (CCP facing trades and client / house facing trades are in 
different books for a given clearing account) 

Option 1 has priority over Option 2 if both options are configured. In other words, books defined at the legal entity 
level will be ignored if a book is defined at the clearing account level. 

[NOTE: If you choose Option 1, it has to apply to ALL clearing accounts. If you choose Option 2, it has to apply to 
ALL legal entities – It is not recommended to have a mix of both options] 

4.1.1 Option 1 – A Book per Clearing Account 

You define a book at the clearing account level. 

This book contains for a given clearing account, the CCP facing trades and the client / house facing trades. So 
basically, this book always has a flat position. 

Sample Clearing Account Book 

The clearing account book is set on the account attributes of BOTH the CCP Facing Clearing Account and the 
Client Facing Clearing Account. 

[NOTE: This is the same setup, whether the clearing account is a client clearing account or a house clearing account] 

 

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books. 
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It is not requires to set any book attribute. 

4.1.2 Option 2 – A Book per Legal Entity 

For the clearing member, you need to have a book to store the trades related to the house activity, and a book to 
store the trades related to the client activity. When trades are imported, the book will be assigned in the following 
order of priority: 

• The book set at the Clearing House level, if any. 

NOTE: You can only set the book at the CCP level if you have defined only one clearing member in your 
system. 

• The book set at the clearing member level, if any. 

• The book set in the User Defaults. 

For the clients, you can have a book per client, or a book across multiple clients. This choice should mostly be 
driven by P&L reporting requirements, since the P&L is computed at the book level. When trades are imported, the 

book will be assigned in the following order of priority: 

• The book set at the client level, if any. 

• The book set in the User Defaults. 

Sample Clearing Member Books 

The clearing member books are set on the clearing house OR the clearing member attributes. 

 

Clearing Member House Clearing Book 

The clearing member House Clearing book holds trades for the clearing member’s house trades. 

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books. 
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Set the following book attributes: 

• OPTIONAL - BookType = House (optional attribute to identify House activity in filters) 

 

Clearing Member Client Clearing Book 

The clearing member Client Clearing book holds the mirror trades of the clearing member’s clients at the clearing 
house. 

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books. 

 

Set the following book attributes: 
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• OPTIONAL - BookType = Client (optional attribute to identify House activity in filters) 

Sample Client Book 

A book should be defined for client trades at the clearing member. It can be a dedicated book, or a book shared 
across multiple clients. 

 

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books. 

 

It is not required to set any book attribute. 

Sample Internal Counterparty Book 

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books. 
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It is not required to set any book attribute. 

• OPTIONAL - BookType = House (optional attribute to identify House activity in filters) 

• Pricing Env = <Pricing environment name> 

4.2 Defining the Clearing Houses (CCPs) 

A clearing house only requires the definition of a legal entity and its contact information. 

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities. 

Each clearing house must be defined with at least the following roles: “CCP, “Agent” and “CounterParty”. 

CCP short names must be added to the domain “mccAdditionalField.CCP”. 

[NOTE: The Client role is also required if you plan to define Variation Margin contracts for CCP facing contracts – 
Optional – See Clearing Member Contracts – CCP Facing Contracts for details] 

Trade Classification 

You can set the legal entity attribute VMClassification to CTM (Collateralized-To-Market) or STM (Settled-To-
Market). The trade keyword VMClassification will default to that value when importing EOD files to generate 
Clearing Transfer trades. If it is not set, the value will be retrieved from the import files, and if there is no value in 
the import files, it will default to STM. 

Recommended setup per CCP: 

• CME: VMClassification legal entity attribute = STM 

• LCH: VMClassification legal entity attribute = Not set (it will be retrieved from report 91). 

• For the other CCPs, do not set the VMClassification legal entity attribute - It will default to STM. 

You can setup an MCC contract for each trade classification using the attribute VM_CLASSIFICATION, set to CTM or 
STM. 

This applies to both Client and CCP facing Clearing Transfer trades. 

CME 

 

Click Contact to define at least one contact. 

Click Attributes to set the following legal entity attributes: 
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• OPTIONAL - “Client Clearing Book” = <Book name for the Clearing Member’s client trades> 

 See Defining Books for details – The book can be defined at the Clearing Member or Clearing Account 
level instead. 

• OPTIONAL - “House Clearing Book” = <Book name for the Clearing Member’s house trades> 

 See Defining Books for details – The book can be defined at the Clearing Member or Clearing Account 
level instead. 

• “CME_CPTY” = CME 

LCH 

 

Click Contact to define at least one contact. 

Click Attributes to set the following legal entity attributes: 

 

• OPTIONAL - “Client Clearing Book” = <Book name for the Clearing Member’s client trades> 

 See Defining Books for details – The book can be defined at the Clearing Member or Clearing Account 
level instead. 

• OPTIONAL - “House Clearing Book” = <Book name for the Clearing Member’s house trades> 

 See Defining Books for details – The book can be defined at the Clearing Member or Clearing Account 
level instead. 

• “LCH_CPTY” = LCH 

EUREX 
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ICE CLEAR EUROPE 

 

 

Books are optional. 

ICE CLEAR CREDIT 
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Books are optional. 

 

4.3 Defining the Agent Bank 

The agent bank for all clearing activity is HARRIS BANK. 

It should be defined with the following roles: “Agent” and CounterParty”. 

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities. 

 

Click Contact to define at least one contact. 

4.4 Defining the Clearing Member 

Clearing Member Setup Requirements 

A clearing member requires the following settings: 
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• A clearing member legal entity 

• OPTIONAL - A House book to represent CCP-facing house activity. 

• OPTIONAL - A Client Book to represent CCP-facing client activity. 

• A Nostro account for each currency that represents the cash position of the clearing member at the agent. 

• A Dummy Client account at the clearing member for payments between the clearing member and the 
client. 

4.4.1 Clearing Member Legal Entity 

The clearing member should be defined with at least the following roles: “ProcessingOrg”, “Agent”, “CounterParty”. 

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities. 

 

Click Contact to define at least one contact. 

Click Attributes to set the following legal entity attributes: 

 

• OPTIONAL - “House Clearing Book” = <Book name for house trades> 

 See Defining Books for details – The book can be defined at the Clearing House or Clearing Account 
level instead. 

• OPTIONAL - “Client Clearing Book” = <Book name for client trades> 

 See Defining Books for details – The book can be defined at the Clearing House or Clearing Account 
level instead. 

• “<CCP><Clearing Service>FirmId” = <ID given by CCP to identify the clearing member> 

For example: CMEIRDFirmId, CMENDFFirmId, LCHIRDFirmId - You need one FirmId for each CCP and each 
clearing service that you use. 

A clearing service is a combination of the CCPs defined in domain "mccAdditionalField.CCP" and the 
product types defined in domain "mccAdditionalField.PRODUCT_TYPE". 
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If you do not need to specify the FirmId by clearing service, you can use the attribute <CCP>FirmId 
instead. 

For example: CMEFirmId, LCHFirmId. 

• OPTIONAL – “<CCP>CVRSenderCode” = <ID given by the CCP to identify the Collateral Valuation Report 
(CVR) sender> 

If it is populated, it will be used to identify the CVR sender, otherwise the legal entity attribute 
“<CCP><Clearing Service>FirmId” or “<CCP>FirmId” will be used. 

•  “LCHRemoteFolderStructure” = <LCH folder option: Select “Static” or “Dynamic”> 

LCH offers two folder options for storing the EOD files: “Static” stores all reports under the SwapClear 
folder, and “Dynamic” stores the reports per date folder under the SwapClear folder. 

• “Minimum CFTC Requirement” - Used for regulatory reporting 

 Refer to the Calypso Clearimg Member User Guide for information on regulatory reporting. 

• “Minimum Other Requirement” - Used for regulatory reporting 

 Refer to the Calypso Clearimg Member User Guide for information on regulatory reporting. 

• OPTIONAL – “Clearing Business Calendar” = <Holiday calendar> 

Used to represent the calendar on which the clearing member will run EOD processes, and generate 

statements for the clients. If any CCP is open, the clearing member will be running EOD processes. 

If this attribute is not set, the calendar specified in the clearing member definition is used instead. 

 Refer to the Calypso Clearimg Member User Guide for details. 

4.4.2 Clearing Member Accounts 

Clearing Member - Nostro Account @ Agent 

Cash accounts of the clearing member at the settlement bank (agent) for cash settlement and margin call trades. 

You need one nostro account for the House account and another one for Client segregated accounts. 

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts. 

Define an automatic SETTLE account with: 

• Processing Org = <Clearing member name> 

• Legal Entity = <Agent name> 

• Role = Agent 

Example of House Nostro Account. 
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Example of Client Segregated Nostro Account. 
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Click Properties/Attributes (F4) to set account attributes as needed. 

• Attribute “SequesteredAccount” = Bank 

Clearing Member – Nostro Dummy Account @ Agent 

This account will be used for swap interest. 

 

 

4.5 On-Boarding an Individual Client/Affiliate 

Client Setup Requirements 

On-boarding a client requires the following settings: 

• A Client legal entity. 

• A book that contains client trades (defined at Client legal entity level or Client Account level) 

• A Position account at the clearing house for each CCP / service (e.g. CME/NDF). 

• A pair of Clearing accounts at the clearing member for each CCP/ service. One account configured with the 
client’s LE and a second one, also known as mirror account where the Legal Entity is the CCP. 

Both accounts are linked through the Description field that contains the account id of the other account. 

Both accounts must contain the CCP position account Id in the External Name field. 

• Internal Cash accounts for each currency. 

• Dummy accounts for each currency. 

 

It is recommended to use the Onboarding Manager as it creates all the required data at once, including the 
settlement and delivery instructions and the margin call contracts. 

 See Settlement and Delivery Instructions for details on SDI setup requirements. 
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 See Margin Calls Setup for details on Margin Call Contracts setup requirements. 

4.5.1 Onboarding Manager 

You need to add a menu item for the Onboarding Manager for menu action onboarding.OnboardingWindow. 

It brings up the Clearing Client Onboarding window. It allows defining a client based on a client template, 
previewing the data that will be created, and saving the required data: legal entity, book, accounts, interest 
bearing configurations, settlement and delivery instructions, and margin call contracts. 

Access Permissions 

The following access permission functions apply to the Onboarding Manager. 

• CreateModifyOnboardingTemplate – Permission to create and modify onboarding templates. You can 
modify onboarding templates provided you have read-write access to the onboarding templates. 

• CreateOnboardingObjects – Permission to save the actual objects created by the Onboarding Manager. 

• DeleteOnboardingTemplate – Permission to remove onboarding templates provided you have read-write 
access to the onboarding templates. 

• AuthorizeOnboardingCreation – Permission to authorize client onboarding data in Authorization mode. 

You can also assign read-write access or read-only access to onboarding templates under the “Onboarding 
Templates” category in the Groups panel of the Access Permissions window. Make sure that OnboardingTemplates 
is defined in the domain “classAccessMode”. 

Authorization Mode 

You can enable the Authorization mode for the Onboarding Manager. 

Add “ClientOnboardingData” to the domain “classAuthMode”. If the Authorization mode is enabled, new and 
modified client data will have to be authorized before being available. 

You can authorize the data in the Onboarding Manager using File > Load Pending Modifications. Accept or reject 

the data as applicable. This is an all-or-nothing authorization. 

Static Data Filters 

You need to create static data filters for the transfer types. 

Sample XferType_NOT_Int/Upfront_Fee 

 

Sample XferType_Interest/Upfront_Fee 
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Margin Call Contract Type 

In order to populate the contract type properly, you need to add the following values to the domain 
“legalAgreementType”: 

• Client – This value will be set as the Contract Type for client facing margin call contracts. 

• Client@<CCP>, such as Client@CME and Client@LCH – This value will be set as the Contract Type for CCP 
facing margin call contracts. 

Client Template 

A template is provided out-of-the-box “CLIENT_default”. It contains the basic required data. They are described 
below. 

You can choose Manage Templates > Configure to save the out-of-the-box template as a new template, in 
order to modify it. 

You can add values for the following types of information: 

• Legal Entity Roles 

• Legal Entity Attributes 

• Book Attributes 

• Account Properties 

• Account Attributes for Auto Accounts 

Choose File > Save or File > Save As New to save your changes if any. 

 

Default Client Template Values 

Fields  Default Value 

Processing Org  <not set> 

Legal Entity Roles 

Financial 

Status 

Country 

Holidays 

Client, CounterParty, Statement Recipient 

true 

Disabled 

<not set> 

<not set> 

Legal Entity 

Attributes 

ClearingReportingCurrency <not set> 

Clearing Book Book Name <ClientName>@<POName> 
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Fields  Default Value 

Activity 

Accounting Link 

Processing Org 

Location 

End of Day 

Base Ccy 

Holidays 

Comment 

Clearing 

<not set> 

<not set> 

<not set> 

<not set> 

<not set> 

<not set> 

<not set> 

Book Attributes Pricing Env 

BookType 

FROMDB 

Client 

Book Permissions Currency 

Currency Pair 

Product 

[__ALL__] 

[__ALL__] 

[__ALL__] 

Clearing Account Account Name 

Processing Org 

Call Account 

Type 

Security 

Currency 

Auto/Template Acc 

Interface Rule 

Role 

Create by Acc Only 

Balance 

Frequency 

Day 

Rule 

Roll 

Billing 

Interest Bearing 

<ClientName>@FCM_<POName>_<CCPName><ServiceName> 

<not set> 

false 

SETTLE 

false 

AUTO 

true 

Aggregate 

CounterParty 

true 

true 

DLY 

1 

<not set> 

END_MONTH 

true 

false 

Clearing Account 
Properties 

Clearing Book 

Description 

ClearingCashAccount 

CCPOriginCode 

AccountType 

<ClientName>@<POName> 

Clearing 

false 

CLIENT 

Client 

Clearing Account 
Attributes 

Auto account attributes <not set> 
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Fields  Default Value 

Clearing Mirror 
Account 

Account Name 

Processing Org 

Call Account 

Type 

Security 

Currency 

Auto/Template Acc 

Interface Rule 

Role 

Create by Acc Engine Only 

Balance 

Frequency 

Day 

Rule 

Roll 

Billing 

Interest Bearing 

<ClientName>@CCP_<POName>_<CCPName><ServiceName> 

<not set> 

false 

SETTLE 

false 

AUTO 

true 

Aggregate 

Agent 

true 

true 

DLY 

1 

<not set> 

END_MONTH 

true 

false 

Clearing Mirror 
Account Properties 

Clearing Book 

Description 

ClearingCashAccount 

CCPOriginCode 

AccountType 

<ClientName>@<POName> 

Clearing 

false 

CLIENT 

Client 

Clearing Mirror 
Account Attributes 

Auto account attributes <not set> 

Cash Account Account Name 

Processing Org 

Call Account 

Type 

Security 

Currency 

Auto/Template Acc 

Interface Rule 

Description 

Role 

Create by Acc Only 

Balance 

Frequency 

Day 

<ClientName>_<Currency>_CASH@<POName> 

<not set> 

false 

SETTLE 

false 

AUTO 

true 

Aggregate 

<not set> 

CounterParty 

false 

true 

DLY 

1 
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Fields  Default Value 

Rule 

Roll 

Billing 

Interest Bearing 

<not set> 

END_MONTH 

false 

true 

Cash Account 
Interest Bearing 

Interest Config 

Interests Valid From 

Interest Valid To 

Interests Type 

Interests Penalty 

<not set> 

<not set> 

<not set> 

<not set> 

false 

Cash Account 
Properites 

Description 

ClearingCashAccount 

CCPOriginCode 

AccountType 

Cash 

true 

CLIENT 

Client 

Cash Account 
Attributes 

Auto account attributes <not set> 

Direct SDI Role 

Currency 

Pay/Receive 

Cash/Security 

Contact 

Processing Org 

Products 

SD Filter 

Preferred 

Priority 

Method 

Trade Counterparty 

Is Direct 

DDA 

CounterParty 

ANY 

BOTH 

BOTH 

Default 

ALL 

ANY 

<not set> Recommended: XferType_NOT_Int/Upfront_Fee 

true 

0 

Direct 

ALL 

true 

<ClientName>_AUTO_CASH@<POName> 

Internal SDI Role 

Currency 

Pay/Receive 

Cash/Security 

Contact 

Processing Org 

Products 

SD Filter 

Preferred 

CounterParty 

ANY 

BOTH 

BOTH 

Default 

ALL 

G.Clearing Products 

<not set> Recommended: XferType_Interest/Upfront_Fee 

true 
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Fields  Default Value 

Priority 

Method 

Trade Counterparty 

Is Direct 

G/L Account 

DDA 

A/C 

Agent 

Agent Contact 

Agent Identifier 

Sub-Account 

Msg To Agent 

0 

Internal 

ALL 

false 

<not set> 

<not set> 

Dummy Account 

<not set> 

Default 

<not set> 

<not set> 

<not set> 

VM Margining Scenario 

Legal Entity Role 

Has Clearing Service 

Currencies 

Start Date 

EOD Pricing Environment 

ITD Pricing Environment 

Position Type 

Position Date 

Method 

Currency 

Cash 

Book 

Base Currency 

Currency 

Adjustment Currency 

Single_Ccy – See below for details. 

Client 

<not set> – See below for details. 

[ANY] 

<not set> 

<not set> 

<not set> 

THEORETICAL 

POSITION_DATE_VALUE 

Standard 

<not set> 

0 

<ClientName>@<POName> 

USD 

<not set> 

<not set> 

IM Margining Scenario 

Legal Entity Role 

Collateral Type 

Start Date 

EOD Pricing Environment 

ITD Pricing Environment 

Position Type 

Position Date 

Method 

Currency 

OSA – See below for details. 

Client 

BOTH 

<not set> 

<not set> 

<not set> 

THEORETICAL 

POSITION_DATE_VALUE 

Standard 

<not set> 
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Fields  Default Value 

Cash 

ANY 

Corporate 

Government 

Tbill 

Book 

Base Currency 

0 

0 

0 

0 

0 

<ClientName>@<POName> 

<not set> 

[NOTE: If the user does not select a contact in the SDI section of the template, the user will need to define a contact 
in the Client Information Panel. If there is a list of two or more contacts in the Client Information Panel, the first 
contact in the list is used as the default contact for all SDIs] 

 

VM Contract – Margining Scenario 

You can select the following scenarios: 

• Single_Ccy - There is one VM Margin Call Contract per Client. 

• Multi_Ccy - There is one VM Margin Call Contract per Client and per currency (regardless of CCP and 
product type). 

• Hybrid – You may have multiple VM Margin Call Contracts per Client and per currency on an ad-hoc basis. 
The currencies that are not selected all belong to the same VM Margin Call Contract. 

VM Contract – Has Clearing Service 

If “Has Clearing Service” is checked, and only one clearing service is selected for the client, the clearing service 
details are set in the CCP and Product Type additional info on the VM contract. 

These fields have to be manually populated on the VM contract otherwise. 

IM Contract - Margining Scenario 

You can select the following scenarios: 

• OSA - There is one Margin Call Contract per CCP and product type that handles initial margins for all 
clients for CCP facing contracts. If this contract already exists, it is not created again when a new client is 
added. 

• ISA - For SwapClear Members of LCH, it is also possible to have one Margin Call Contract per CCP, client, 
and product type that handles initial margins for CCP facing contracts. 

 See Margin Calls Setup for complete details on Margin Call Contracts setup requirements. 

Client Onboarding 

Select a client template, and fill in the client information described below. 

You can add more values for the following types of information, as needed: 

• Contacts 

• Clearing Houses 

• Legal Entity Attributes 

• Book Attributes 

• Account Properties 

• Account Attributes for Auto Accounts 

The Onboarding Preview displays all the data that will be created. 
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Then click Save Client if you are satisfied with the results. A summary of the results will be displayed. 

Fields Details 

Fields  Description 

Template  Select a client template. See “Client Template” for details. 

Processing Org  Select the clearing member. 

 See Defining the Clearing Member for details. 

Legal Entity Short Name 

Full Name 

Parent 

LE External Reference 

Country 

Holidays 

Location 

End of Day 

Reporting Currency 

Enter the client short name. 

Enter the client full name. 

Select a parent as needed (optional). 

Enter a client external reference as needed (optional). 

Select the country. 

Select the holiday calendars. 

Select the location timezone. 

Enter the EOD time. It must be an integer between 0 and 2359. 

Select the currency used to convert amounts for the Total 
column in the client statement. 
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Fields  Description 

Contact Details Contact Type 

Role 

Product Type 

Processing Org 

Last Name 

First Name 

Title 

Address Line 1 

Address Line 2 

Address Line 3 

City 

State 

Zip Code 

Country 

Phone 

Fax 

Email 

Swift 

Select the contact type, and define the contact details. 

Clearing Houses Time Zone 

Clearing Service 
 

 

Position Account 
 

 

Margin Account 
 

 

 

 

Segregated Account 
 

Trade Message Ref 
 

 
 

Eligible Securities 

Haircut Rule 

Eligible CCY 

Adjusted CCY 

Select the timezone. 

Click to select a service used by the client. A service is a 
combination of the CCPs defined in domain 
"mccAdditionalField.CCP" and the product types defined in 
domain "mccAdditionalField.PRODUCT_TYPE" 

Enter the account reference at the Clearing House (position 
account). 

NOTE: For LCH it is the account reference for trades only. 

Enter the margin account at the Clearing House for EOD files. It 
corresponds to the following columns of the EOD files: 

• CME IRSMR3 report – Column “A/C ID” 

• CME Margin Summary report – Column “PBA” 

• LCH Report86c report – Column “ClientAccountID” 

Segregated account for SOD pass-through function – Column 
Account of REP00030 report. 

Multiple positions accounts may share the same margin 
account. 

For LCH only, enter the account reference at the Clearing House 
for Cash Settlement trades. 

Select the static data filter that determines eligible securities. 

Select the haircut rule if any. 

Select the eligible currencies. 

Select the adjustment currency. 
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Fields  Description 

 Buffer Check to define a buffer to apply to the initial margin. You can 
enter a contractual multiplier and/or a contractual amount, and 
a discretionary multiplier and/or a discretionary amount. 

 Is ISA 
 

Book 

CCP Margin Account 

 
Ad-Hoc 

Valuation Date Frequency 

Check for ISA accounts (individual client activity), or clear for 
ISO (clearing activity for their own individual clients). 

For ISA accounts, select the client activity book. 

Enter the account reference of the CCP facing IM margin call 
contracts for ISA structures. 

Check for intraday margin calls. 

Select the valuation frequency and valuation date time. 

 Unallocated Excess The system allows maintaining additional collaterals held at the 
clearing member by a given client, but not posted at the CCP, in 
a specific margin call contract. 

Check to create an additional margin call contract, and enter 
the details of the contract. 

Variation Margin Currencies 

Underlying Currencies 
 
 

Included Flows 
 

Separate Payment 

For Multi_Ccy, select the currencies. 

For Hybrid, select the currencies that follow the multi-currency 
scenario. The non-selected currencies apply the single-currency 
scenario. 

Select the flow types associated with the contract, or leave 
blank for ALL. 

Check to add “Separate Settlements” sections to the Client 
Statement. 

Additional 
Attributes 

LE Attributes 

Book Attributes 

Account Properties 
Clearing 

Account Properties Cash 

Add attributes as needed. 

4.5.2 Client Legal Entity 

[NOTE: These are created by the Onboarding Manager] 

Each client should be defined with the following roles: 

• “CounterParty” for the trades 

• A role for the payment of margin call trades – We are using the role “Client” in this setup. It can also be 
“ExtCounterParty”. 

• “Statement Recipient” to generate client statements 

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities. 
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[NOTE: The client legal entity is created in status Disabled by default. You need to enable it in order to use it] 

Click Contact to define at least one contact. 

Click Attributes to set the following legal entity attributes: 

 

• OPTIONAL - “Clearing Book” = <Client book name> 

 See Defining Books for details – The book is defined by default at the Clearing Account level instead. 

• “ClearingReportingCurrency” = <Currency used to convert amounts for the Total column in the client 
statement> 

• Attribute for LSOC CVR Static Data report: CFTCID (Required - CFTC Reportable Number), LEID (Optional 
- US LEI of the client), OfficeCode (Optional) and CustAccountType (Optional - H for hedger, M for 
member, O for omnibus, or S for speculator). 

 Refer to the Calypso Clearing Member User Guide for information on the LSOC CVR Static Data report. 

4.5.3 Client Accounts 

[NOTE: These are created by the Onboarding Manager] 

Client Facing Clearing Account 

Mirror account of the CCP Facing Clearing Account. 

You need a client account at the clearing member for each clearing house: position of the client at the clearing 
member per clearing house. 

[NOTE: If the client has multiple accounts at the clearing house, you need to create an account for each client, for 
each clearing house, and for each account] 

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts. 

Define a SETTLE account with: 

• Processing Org = <Clearing member name> 

• LegalEntity = <Client/Affiliate name> 

• Role = CounterParty 

• Description = <ID of the CCP Facing Clearing Account> 



65 Clearing Member Setup Guide 

• External Name = <Account reference at Clearing House (position account)> 

NOTE: For LCH it is the account reference for trades only. 

• Create by Acc Engine only = Checked 

Example for “MAPPING CUS01 CME-SWAP” – Repeat for each CCP/service and for each client. 

 

 

 

It is likely that maintenance fees will be charged to the account. The “Billing” checkbox should be checked in order 
to compute maintenance fees on the account. 

 See Clearing Fees for details. 

Click Properties/Attributes (F4) to set the account attributes. 

 

• Attribute “CCPOriginCode” = CLIENT 

• Attribute “InitialMarginAccount” = <Margin account at Clearing House for EOD files> 

It corresponds to the following columns of the EOD files: 

- CME IRSMR3 report – Column “A/C ID” 
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- CME Margin Summary report – Column “PBA” 

- LCH Report86c report – Column “ClientAccountID” 

Multiple positions accounts may share the same margin account. 

• OPTIONAL – Attribute “Clearing Book” = <Clearing Account book name> - It is set by the Onboarding 
Manager by default. 

 See Defining Books for details – The book can be defined at the Client / Clearing Member level instead. 

• For LCH, attribute “LCHAccountName” = <Account reference at Clearing House for Cash Settlement 
trades> 

CCP Facing Clearing Account 

Mirror account of the Client Facing Clearing Account 

Position of the client at the clearing house. You need one account for each client and for each clearing house. 

[NOTE: If the client has multiple accounts at the clearing house, you need to create an account for each client, for 
each clearing house, and for each account] 

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts. 

Define a SETTLE account with: 

• Processing Org = <Clearing member name> 

• LegalEntity = <Clearing house name> 

• Role = Agent 

• Description = <ID of the Client Facing Clearing Account> 

• External Name = <Account reference at Clearing House (position account)> 

NOTE: For LCH it is the account reference for trades only. 

• Create by Acc Engine only = Checked 

Example for “MIRROR MAPPING CUS01 LCH-SWAP” – Repeat for each CCP/service and for each client. 
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It is likely that maintenance fees will be charged to the account. The “Billing” checkbox should be checked in order 
to compute maintenance fees on the account. 

 See Clearing Fees for details. 

Click Properties/Attributes (F4) to set the account attributes. 

 

• OPTIONAL – Attribute “Clearing Book” = <Clearing Account book name> - It is set by the Onboarding 
Manager by default. 

 See Defining Books for details – The book can be defined at the Client / Clearing Member level instead. 

• Attribute “CCPOriginCode” = CLIENT 

• Attribute “InitialMarginAccount” – <Margin account at Clearing House for EOD files> 

It corresponds to the following columns of the EOD files: 

- CME IRSMR3 report – Column “A/C ID” 

- CME Margin Summary report – Column “PBA” 

- LCH Report86c report – Column “ClientAccountID” 

Multiple positions accounts may share the same margin account. 

• For LCH, attribute “LCHAccountName” = <Account reference at Clearing House for Cash Settlement 
trades> 

Client Cash Accounts 

You need a cash account for each client. 

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts. 

Define an automatic SETTLE accounts with: 

• Processing Org = <Clearing member name> 

• LegalEntity = <Client/Affiliate name> 

• Role = CounterParty 

Example for “Clearing Cash Flows CUS01” - Repeat for each client. 
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It is likely that interest will be paid on the account. The “Interest Bearing” checkbox should be checked in order to 
compute interest on the account balance. 

 Please refer to Calypso Cash Management documentation for details on setting up interest bearing. 

Click Properties/Attributes (F4) to set the account attributes. 

 

• Attribute “CCPOriginCode” = CLIENT 

• Attribute “ClearingCashAccount” = True 

• Propagate = true to propagate the attributes to the child accounts 

Client - Cash DUMMY Account @ the Clearing Member 

This account is used for interests that are not settled. 
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4.6 Defining an Internal Counterparty 

One or multiple internal counterparties are required for capturing house trades. 

Sample internal counterparty: 

 

You also need to add the role “Statement Recipient” if you want to generate client statements. 

 

The setup is the same as an individual client with the following differences: 
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• Clearing Book = <Internal Counterparty book name> 

 See Defining Books for details – The book can be defined at the Clearing Account level instead. 

• OPTIONAL - Book attribute BookType = House (optional attribute to identify House activity in filters) 

 

Internal Counterparty clearing accounts: CCP Facing Clearing Account and Client Facing Clearing Account 

• Account attribute CCPOriginCode = HOUSE 

• OPTIONAL – Account attribute Clearing Book = <Clearing Account book name> 

 See Defining Books for details – The book can be defined at the Internal Counterparty / Clearing 
Member level instead. 

Sample CCP Facing Clearing Account: 

 

 

Sample Client Facing Clearing Account @ Clearing Member: 
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Internal Counterparty cash account @ Clearing Member: same as Client cash account @ Clearing Member with: 

• LegalEntity = <Internal Counterparty name> 

• Attribute CCPOriginCode = HOUSE 

4.7 On-Boarding an Omnibus Client 

Omnibus Client Setup Requirements 

On-boarding an omnibus client requires the following settings: 

• An Omnibus Client legal entity 

• Child Client legal entities 

• OPTIONAL - A book that contains client trades (dedicated book, or shared book across multiple clients) 

• A Client Clearing account at the clearing house for each clearing house. This account is linked to the Client 
Clearing account at the clearing member through the account description. 

• A Client Clearing account at the clearing member for each clearing house. This account is linked to the 
Client Clearing account at the clearing house through the account description. 

• A Client Cash account for each currency. 

4.7.1 Omnibus Client Legal Entity 

Each omnibus client should be defined with the role “CounterParty” for the trades, and the role “Client” for the 
payment of margin call trades. 

You also need to add the role “Statement Recipient” if you want to generate client statements. 

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities. 

 

Click Contact to define at least one contact. 

4.7.2 Child Client Legal Entities 

Each child client should be defined with the role “CounterParty” for the trades, and have the omnibus client as a 
parent. 

You also need to add the role “Statement Recipient” if you want to generate client statements. 
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From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities. 

 

 

Click Contact to define at least one contact. 

Click Attributes to set the following legal entity attributes: 

 

• OPTIONAL - “Clearing Book” = <Client book name> 

 See Defining Books for details – The book can be defined at the Clearing Account level instead. 

• “ClearingReportingCurrency” = <Currency used to convert amounts for the Total column in the Client 
Statement> 

4.7.3 Omnibus Accounts 

Child CCP Facing Clearing Account 

The clearing account is at the Child Client level. Position of the client at the clearing house. You need one account 
for each client and for each clearing house. 

Mirror account of the Child Client Facing Clearing Account. 
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It is the same as an individual client clearing account with: 

• LegalEntity = <Child client name> 

 See CCP Facing Clearing Account for setup details. 

Child Client Facing Clearing Account 

Mirror account of the Child Client Facing Clearing Account. 

You need a child client account at the clearing member for each clearing house: position of the client at the 
clearing member per clearing house. 

It is the same as an individual client clearing account with: 

• LegalEntity = <Child client name> 

 See Client Facing Clearing Account for setup details. 

Child Client Cash Accounts 

You need a cash account for each child client and for each currency. 

It is the same as an individual client cash account with LegalEntity = Child Client name 

 See Client Cash Accounts for setup details. 
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Section 5. Settlement and Delivery Instructions 

The settlement and delivery instructions (SDIs) drive the trade transfers to the Calypso accounts. 

Sample SDIs flow for house activity and individual client activity (this diagram only shows the SDIs that impact 
Calypso accounts). 

 

 

From the Calypso Navigator, navigate to Configuration > Settlements > Delivery Instructions to define SDIs. 

5.1 CCP Settlement Instructions 

Beneficiary = CME 

Role = CounterParty 

List of settlement instructions – Sample setup is provided below. 

 

 

SDI Name - Description Method Agent CCY Product Calypso Account 

Internal/CME/Internal SDI for 
trading activity 

Internal CME ANY G.ClearingProducts N/A 

SWIFT/HARRIS BANK/ HARRIS 
BANK 

Cash payments between clearing 
member and CCP. 

SWIFT HARRIS BANK ANY ANY N/A 

 

Beneficiary = LCH 

Role = CounterParty 

List of settlement instructions – Same as CME settlement instructions. 

Client Dummy Account @ CCP 
Swap Trade 

between Client / Clearing Member 

CASH_SETTLEMENT Trade 

Margin Call Trade 

between Client / Clearing Member 

PO SDI - Internal 

Clearing Member Dummy Client Account PO SDI - Direct 

Client Cash Account Client SDI - Direct 

CASH_SETTLEMENT Trade 

Margin Call Trade 

between Clearing Member / CCP 

PO SDI - SWIFT Clearing Member House Nostro Account @ Agent 

Clearing Member Client Nostro Account @ Agent 

 

Swap Trade 

between Clearing Member / CCP 
Clearing Member Dummy Account @ CCP 

PO SDI - Internal 
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SDI Name - Description Method Agent CCY Product Calypso 
Account 

Internal/LCH/Internal SDI for trading 
activity 

Internal LCH ANY G.ClearingProducts N/A 

SWIFT/HARRIS BANK/HARRIS BANK 

Cash payments between clearing 
member and CCP. 

SWIFT HARRIS 
BANK 

ANY N/A N/A 

 

CCP - Sample “Internal/CME/Internal SDI for trading” Settlement Instructions 

 

This SDI does not impact any account in Calypso. 

Static data filter XferType_Interest/Upfront_Fee 
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CCP - Sample “SWIFT/HARRIS BANK/HARRIS BANK” Settlement Instructions 

Cash payments between the clearing member and the CCP. 

 

This SDI does not impact any account in Calypso. 

5.2 EMIR Segregated Accounts 

For SwapClear Members of LCH, clients can choose to hold deposits of collateral that cover Initial Margin 
requirements into separate accounts. 

Margin Call Contracts 

In order to allow this, the individual CCP-facing IM contracts must be created for each client who wants a separate 
account (each unique EMIR Account). On this IM contact, the CCP_REFERENCE must be set to the LCH client’s sub-
account number instead of “C”. The LCH client’s sub-account number can be found in the “Account” column of LCH 
Report86c report, or Report 33a for intraday margins. The CCP_REFERENCE must match the Account value in this 
report in order to import the Initial Margin from that row of the report. 

 See Clearing Member Contracts – CCP Facing Contracts for details. 

CCP Settlement Instructions 

CCP settlement instructions must be added to populate the separate account. One for each client. 



77 Clearing Member Setup Guide 

 

 

The attribute “Margin Call Contract Id” in the Static Data Filter is the CCP-facing IM contract created for the client 
where the CCP_REFERENCE is set to the LCH client’s sub account (“Account” column of LCH Report86c). 
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5.3 Clearing Member Settlement Instructions 

Beneficiary = <Clearing Member name> 

Role = ProcessingOrg 

List of settlement instructions – Sample setup is provided below. 

 

 

SDI Name - Description Method Agent CCY Product Calypso Account 

Direct/Clearing Member/Dummy Client 
Account 

CASH_SETTLEMENT trades between 
clearing member and client. 

Direct Clearing 
Member 

ANY ANY Dummy Client 
Account 

Internal/CME/Dummy Account for 
Swaps/FRAs/FXNDFs 

Internal/LCH/Dummy Account for 
Swaps/FRAs 

Trades between clearing member and 
CCP. 

[NOTE: Repeat for each CCP] 

Internal CME 

LCH 

ANY Swap, FRA, 
FXNDF 

Dummy Account 
@CME 

Dummy Account 
@LCH 

SWIFT/HARRIS BANK/Clearing Member 
HOUSE NOSTRO USD 

Cash payments between clearing member 
and CCP for house trades. 

[NOTE: Repeat for each currency] 

SWIFT HARRIS 
BANK 

USD ANY Clearing Member 
HOUSE NOSTRO USD 
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SDI Name - Description Method Agent CCY Product Calypso Account 

SWIFT/HARRIS BANK/Clearing Member 
CLIENT NOSTRO USD 

Cash payments between clearing member 
and CCP for client trades. 

[NOTE: Repeat for each currency] 

SWIFT HARRIS 
BANK 

USD ANY Clearing Member 
CLIENT NOSTRO USD 

Clearing Member - Sample “Direct/Clearing Member/Dummy Client Account” 
Settlement Instructions 

CASH_SETTLEMENT trades and margin call trades between the clearing member and the client. 

 

Clearing Member - Sample “SWIFT/HARRIS BANK/Clearing Member HOUSE 
NOSTRO USD” Settlement Instructions 

House CASH_SETTLEMENT trades and margin call trades between the clearing member and the CCP. 

Sample for USD - Repeat for each currency. 
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Static data filter to filter house trades: 

 

Clearing Member - Sample “SWIFT/HARRIS BANK/Clearing Member CLIENT 
NOSTRO USD” Settlement Instructions 

Client CASH_SETTLEMENT trades and margin call trades between the clearing member and the client. 

Sample for USD - Repeat for each currency. 
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Static data filter to filter client trades: 

 

Clearing Member – Sample “Internal/CME/Dummy Account for Swap SDI” 
Settlement Instructions 

It can also be used for FRAs and FXNDFs as needed. 

Trades between the clearing member and the CCP. 

Example for CME - Repeat for each CCP. 
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Same static data filter as for CCP Settlement Instructions. 

5.4 Individual Client Settlement Instructions 

Beneficiary = <Client name> 

Currencies = ANY 

List of settlement instructions – Sample setup is provided below. 

 

 

Role = CounterParty 

[NOTE: These are created by the Onboarding Manager] 

SDI Name - Description Method Agent Currencies Products Calypso Account 

Direct/Client Cash Account 

CASH_SETTLEMENT trades between 

clearing member and client. 

Margin call trades between clearing 
member and client. 

[NOTE: Repeat for each client] 

Direct N/A ANY ANY Client Cash Account 
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SDI Name - Description Method Agent Currencies Products Calypso Account 

Internal/CME/Dummy Account 

Internal/LCH/Dummy Account 

Trades between clearing member 
and client. 

[NOTE: Repeat for each CCP] 

[NOTE: Repeat for each client] 

Internal CME 

LCH 

ANY G.Clearing 
Products 

N/A 

 

Role = Client 

SDI Name - Description Method Agent Currencies Products Calypso Account 

SWIFT/HARRIS BANK/Client 

Margin call trades (external nostro 
instructions). 

[NOTE: Repeat for each client] 

SWIFT HARRIS 
BANK 

ANY ANY N/A 

Individual Client - Sample “Direct/Client CASH USD” Settlement Instructions 

CASH_SETTLEMENT trades and margin call trades between the clearing member and the client - Direct SDI, with 
DDA = Client Cash Account @ Clearing Member. 

Example for USD – Repeat for each client – Repeat for each currency. 
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Individual Client - Sample “Internal/CME/Dummy Account” Settlement 
Instructions 

Trades between the clearing member and the client. 

Example for CME – Repeat for each CCP – Repeat for each client. 

 

This SDI does not impact any account in Calypso. 

Individual Client - Sample “SWIFT/HARRIS BANK/Client” Settlement Instructions 

Client external Nostro instructions for margin call trades. 

The Nostro instructions are defined for the client with role “Client”. 

Example for Client A – Repeat for each client. 
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This SDI does not impact any Calypso account. 

5.5 Omnibus Client Settlement Instructions 

Beneficiary = <Child Client name> 

Role = CounterParty 

SDI Name - Description Method Agent Currencies Products Calypso Account 

Internal/CME/CME 

Internal/LCH/LCH 

Trades between clearing member 
and child client. 

[NOTE: Repeat for each CCP] 

[NOTE: Repeat for each client] 

Internal CME 

LCH 

ANY Swap, 

FRA, 
FXNDF 

N/A 

 

Beneficiary = <Omnibus Client name> 

Role = CounterParty 

SDI Name - Description Method Agent Currencies Products Calypso Account 

Direct/Omnibus Client CASH USD 

CASH_SETTLEMENT trades between 
clearing member and child client. 

Margin call trades between clearing 
member and omnibus client. 

Direct N/A USD ANY Omnibus Client Cash 
USD 
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SDI Name - Description Method Agent Currencies Products Calypso Account 

[NOTE: Repeat for each currency] 

[NOTE: Repeat for each client] 

[NOTE: In order for the above SDIs to be selected for CASH_SETTLEMENT trades with the child client, and margin 
call trades with the omnibus client, the environment property LOOK_PARENT_SDI must be set to True] 

 

Beneficiary = <Omnibus Client name> 

Role = Client 

SDI Name - Description Method Agent Currencies Products Calypso Account 

SWIFT/HARRIS BANK/Omnibus 
Client 

Margin call trades (external nostro 
instructions). 

[NOTE: Repeat for each client] 

SWIFT HARRIS 
BANK 

ANY ANY N/A 
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Section 6. Margin Calls Setup 

Margin calls are handled through the Collateral Management module, which allows allocating margin calls on initial 
margins and variation margins. 

Initial margins (IM) are imported into the system as Collateral Exposure trades, based on Margin Call Contracts 
configurations. For clearing member contracts (CCP-facing contracts), there is one Collateral Exposure trade per 
Margin Call Contract and per client. For client contracts, there is one Collateral Exposure trade per Margin Call 
Contract. 

Variation margins (VM) are represented by the cash positions of the client cash accounts. 

Margin calls on initial margins and variation margins are computed in cash by the COLLATERAL_MANAGEMENT 
scheduled task, and are reported on the client statements. The clients can choose how to meet the margin calls: in 

cash, securities, or both. 

Haircut Rules 

You can define haircut rules for foreign currencies and securities as specified by the CCP rules prior to defining 
margin call contracts. 

From the Calypso Navigator, navigate to Fees, Haircuts, & Margin Calls > Haircut Rule to define haircut rules – 
Help is available from that window. 

6.1 CCP Facing Contracts 

 

Initial Margin 

The clearing member contracts are used to store the initial margin on the positions of the clearing member at the 
CCP. 

Initial margin requirements being segregated for house and client activity, it is required to define margin call 
contracts for each Clearing Member/CCP/activity combination. 

• For house activity, there is one Margin Call Contract per CCP and product type that handles initial margins. 

• For client activity we model as many ccp-facing margin contracts as segregation levels (e.g. omnibus 
accounts, individual segregated accounts, etc.). 

For SwapClear Members of LCH, it is also possible to have one Margin Call Contract per CCP, client, and 
product type that handles initial margins. The client can decide whether to have segregated accounts or 
not. 

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin 
calls are computed in the corresponding currency, and can be substituted to collateral securities. 

The actual margin calls are represented by margin call trades. 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Margin Call to 
define margin call contracts. 

 

Variation Margin 

By default, there is no need to define variation margin contract as the variation margin is automatically settled in 
cash with the CCP. However, you can also setup variation margin contracts with the CCP in order to use the 
Collateral Manager to generate margin call trades, and allocate the margin calls in cash or security. These variation 
margin contracts should be defined in the same manner as the client variation margin contracts with or without 
breakdown of Variation Margin Components. 

A sample setup is provided below. 
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6.1.1 CCP Facing - Initial Margin Contracts 

On these contracts, the legal entity configured in the contract is the CCP. These contracts are meant to represent 
the margin requirements between the clearing member and the CCP. There are two types of ccp-facing contracts: 

• House CCP-Facing 

• Client CCP-Facing 

The House CCP-Facing contract will represent the margin requirements for the house activity. 

The number of Client CCP-Facing contracts is driven by the different types of segregation of the customers: e.g. 
Omnibus accounts, ISA accounts. 

 

Example 

A Clearing Member (represented by the PO in Calypso) has the following clients: 

Undisclosed Customers: 

Client1 and Client2 

Disclosed Clients 

CUS01 and CUS02 (both clients benefit from the full segregation e.g. ISA accounts) 

We would model the IM margin call Client CCP-Facing in Calypso as follows: 

• One contract representing the Omnibus Account (including Client1 and Client2) 

• One contract representing customer CU01 

• One contract representing CUS02 

 

Sample of House/Client CCP-Facing Contract: 

Tab: Fields Client Activity House Activity 

Parties: Processing Org <Clearing Member> <Clearing Member> 

Parties: Legal Entity <CCP> <CCP> 

Parties: Legal Entity Role Counterparty Counterparty 

Details: Products CollateralExposure CollateralExposure 

Details: Currency <Cleared Currencies> <Cleared Currencies> 

Details: End of Day Pricing Environment <Your pricing environment> <Your pricing environment> 

Details: Intraday Pricing Environment <Your pricing environment> <Your pricing environment> 

Details: Contract Type Client@[CCP] House@[CCP] 

Details: Haircut <haircut rule> <haircut rule> 

Dates & Time: Valuation Time Zone Same as pricing environment 
time zone 

Same as pricing environment 
time zone 

Dates & Time: Valuation Date Frequency <rule for valuation date 
frequency> 

<rule for valuation date 
frequency> 
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Tab: Fields Client Activity House Activity 

Dates & Time: Valuation Time Offset <rule for valuation time offset> <rule for valuation time offset> 

Initial Margin: Initial Margin option Checked Checked 

Additional Info: CCP <CCP> <CCP> 

Additional Info: CCP_REFERENCE CLIENT (Omnibus Accounts) or 
ISA Account 

HOUSE 

Additional Info: PRODUCT_TYPE Values are configured in the 
domain 
<mccAdditionalField.PRODUCT_
TYPE  

Values are configured in the 
domain 
<mccAdditionalField.PRODUCT_
TYPE 

Additional Info: MARGIN_TYPE IM IM 

ELIGIBILITY 

Eligible Book -> Set Default Book 

Checked Checked 

ELIGIBILITY 

Eligible Book -> Books 

<Clearing member Client Book> <Clearing member House Book> 

ELIGIBILITY 

Eligible Securities 

Add one or more bond filters Add one or more bond filters 

ELIGIBILITY 

Eligible Currencies 

<base currency> 

<list of eligible collateral 
currencies> 

<base currency> 

<list of eligible collateral 
currencies> 

 

Parties: Legal Entity 

This is the Clearing House. 

 

Details: Contract Type 

This is useful in the case the user needs to filter the margin contracts per CCP AND [client or house]. 

The recommended format is: Client/House>@<CCP> 

Examples: 

• Client@CME 

• House@LCH, etc. 

 
Dates & Time: Valuation Date Frequency 

Recommended rule: 
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Dates & Time: Valuation Time Offset 

Recommended rule: 

 

 

Example: 

 

 

Additional Info: CCP_REFERENCE 

By default we configure CLIENT or HOUSE as needed but for European CCPs, clients that benefit from full 

segregation (ISA accounts) must be represented individually in a ccp-facing margin call contracts or through their 
position accounts. 

Examples for Pre-CDML: LCH 

Configure this filed with values from the column “Account” in the report RPT86c/Report 33a) 

Examples for Post CDML (any CCP) 

Configure this field from the value in the element <segregationAccount> of the initialMargin CDML report. 
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Summary of supported Clearing Houses 

CCP CCP EOD File Field/Element 

CME IRSMR3 report. Pre-CDML 

Column “A/C ID” 

Post-CDML 

<segregationAccount> 

EUREX RPTCC204 //RC/rptSubHdr/membId 

CDML 

<segregationAccount> 

ICE Client Gross Margin Report Client Legal Entity Account 

CDML 

<segregationAccount> 

LCH Report86c (Client 

Report 86 (house) 

Report 33a 

Pre-CDML 

Column “Account” 

Post-CDML 

<segregationAccount> 

 

Additional Info: PRODUCT_TYPE 

The values of this field must be configured in the domain mccAdditionalField.PRODUCT_TYPE 

Examples: IRD, NDF, etc. 

 

Additional Info: MARGIN_TYPE 

The values (IM or VM) are configured in the domain mccAdditionalField.MARGIN_TYPE 

Choose IM. 

 

Eligibility: Eligible Securities 

We must create a static data filter with the choice of securities collateral. 

Example: 

 

Once created, the filter appears in the bond selector: 
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6.1.2 CPP Facing - VM Margin Call Contracts (Optional) 

Tab: Fields Client Activity VM 
– USD 

[NOTE: Repeat for 
each currency for 
the multi-currency 
scenario] 

House Activity VM 
– USD 

[NOTE: Repeat for 
each currency for 
the multi-currency 
scenario] 

Parties: Processing Org <clearing member> <clearing member> 

Parties: Legal Entity Role Client Client 

Parties: Legal Entity <CCP> <CCP> 

Details: Products CollateralExposure CollateralExposure 

Details: Currencies USD USD 

Details: End of Day Pricing Environment <pricing env> <pricing env> 

Details: Intraday Pricing Environment <pricing env> <pricing env> 

Details: Haircut <haircut rule> <haircut rule> 

Dates & Times: Valuation Time Zone Same as <pricing 
env> timezone 

Same as <pricing 
env> timezone 

Dates & Times: Send Statement Checked Checked 

Initial Margin: Initial Margin Checked Checked 

Initial Margin: Credit Multiplier   

Additional Info: CCP <CCP> <CCP> 

Additional Info: CCP_ORIGIN_CODE CLIENT HOUSE 

Additional Info: CCP_REFERENCE C H 

Additional Info: PRODUCT_TYPE   
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Tab: Fields Client Activity VM 
– USD 

[NOTE: Repeat for 
each currency for 
the multi-currency 
scenario] 

House Activity VM 
– USD 

[NOTE: Repeat for 
each currency for 
the multi-currency 
scenario] 

Additional Info: MARGIN_TYPE VM VM 

Additional Info: INCLUDED_VM_FLOWS   

Additional Info: 

SEPARATE_VM_SETTLEMENT 
False False 

Additional Info: VM_CLASSIFICATION CTM or STM CTM or STM 

Eligible Books: Set Default Book Checked Checked 

Eligible Books: Book <PO Client book> <PO House book> 

Eligible Securities   

Eligible Currencies <base currency> 

USD 

<base currency> 

USD 

Eligible Currencies: Cash Margin Call 

Account 
True True 

Eligible Currencies: Security Margin Call 

Account 
True True 

Eligible Currencies: Orderer Role CounterParty CounterParty 

6.2 Client Facing Contracts 

The client contracts are used to store the initial margin / variation margin on the positions of the client at the 
clearing member. 

On these contracts, the Legal Entity configured in the contract is the client or a clearing member affiliate. This 
category of contract represents margin flows between the customer or affiliates and the Clearing Member. 

 

Initial Margin 

There is one IM margin call contract per CCP, position account and Product type. 

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin 

calls are computed in the corresponding currency, and can be substituted to collateral securities. 

 

Variation Margin 

Variation margins can be stored in multiple currencies, or in a single currency, based on the client’s choice. 

• Multi-currency scenario – There is one VM Margin Call Contract per Client and per currency (regardless of 
CCP and product type). 

In this case, there is one variation margin per currency, and the margin calls are computed per currency. 

• Single-currency scenario – There is one VM Margin Call Contract per Client. 

In this case, all variation margins are converted to the base currency of the Margin Call Contract. There is 
one variation margin in base currency, and the margin calls are computed in base currency. 
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The actual margin calls are represented by margin call trades. 

 

Collateral Held at Clearing Member, not posted at CCP 

The system allows maintaining additional collaterals held at the clearing member by a given client, but not posted 
at the CCP, in a specific margin call contract. 

These margin call contracts must be defined as the Initial Margin contracts with CCP = Unallocated. 

The collaterals attached to these contracts will be included in the regulatory reporting. 

 

Margin Call Contracts Definition 

For the client contracts, it is required that the margin calls update two different accounts in Calypso: 

• The clearing member external nostro account (where cash and/or securities are actually paid or received) 

• The client cash account @ the clearing member 

For this, the margin call contracts are defined for the external role of the client (we are using the role “Client” in 
this setup - It can also be “ExtCounterParty” – See On-Boarding an Individual Client for details), and you need to 
define the following attributes in the panel Eligibility > Eligible Currencies: 

• Cash Margin Call Account = True 

• Security Margin Call Account = True 

• Order Role = “CounterParty”, the role of the Client cash account at the clearing member. 

 

Breakdown of Variation Margin Components 

This functionality allows generating client VM Margin Calls based on user-defined combinations of the CMF 
generated fees and the individual cashflows that are passed from the CCP, through the CMF to the client. It allows 
the users to associate transfers that hit a single cash account to multiple VM Margin Call contracts using 
configuration controlled by the user. 

You need to define the following attributes in the Additional Info of the VM contracts: 

• INCLUDED_VM_FLOWS (Optional) – Comma-separated list of flow types associated with the margin call 
contract. If it is not set, all flow types will be associated with the margin call contract (default). 

• SEPARATE_VM_SETTLEMENT - If True, the flows associated with the margin call contract, including the 
Margin Call trades, will be included in a “Separate Settlements” section in the Client Statement. 
Otherwise, the flows will contribute to the Financial Summary table of the Client Statement. 

 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Margin Call to 
define margin call contracts. 

6.2.1 Client Facing - Initial Margin Contracts 

Tab: Fields Client Activity 

Parties: Processing Org <Clearing Member> 

Parties: Legal Entity Customer or Clearing member’s 
affiliate Legal Entity 

Parties: Legal Entity Role Client 

Details: Products CollateralExposure 

Details: Currency <Cleared Currencies> 
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Tab: Fields Client Activity 

Details: End of Day Pricing Environment <Your pricing environment> 

Details: Intraday Pricing Environment <Your pricing environment> 

Details: Contract Type Client@[CCP] 

Details: Haircut <haircut rule> 

Dates & Time: Valuation Time Zone Same as pricing environment time 
zone 

Dates & Time: Valuation Date Frequency <rule for valuation date frequency> 

Dates & Time: Valuation Time Offset <rule for valuation time offset> 

Dates&Times: Send Statements Checked 

Initial Margin: Initial Margin option Checked 

Initial Margin: Credit Multiplier <Credit Multiplier> 

Additional Info: CCP <CCP> 

Additional Info: CCP_REFERENCE Position account at the CCP 

(see comments below) 

Additional Info: PRODUCT_TYPE Values are configured in the domain 
<mccAdditionalField.PRODUCT_TYPE  

Additional Info: MARGIN_TYPE IM 

ELIGIBILITY 

Eligible Book -> Set Default Book 

Checked 

ELIGIBILITY 

Eligible Book -> Books 

<customer/affiliate Book> 

ELIGIBILITY 

Eligible Securities 

Add one or more bond filters 

ELIGIBILITY 

Eligible Currencies 

<base currency> 

<list of eligible collateral 
currencies> 

Eligible Currencies: Cash Margin Call 
Account 

True 

Eligible Currencies: Security Margin Call 
Account 

True 

Eligible Currencies: Orderer Role CounterParty 

 

 

 



Clearing Member Setup Guide 96 

©  2 0 1 1 – 2 0 1 8  |  Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved 

Additional Info: CCP_REFERENCE 

We must report the client’s (or affiliate) position account id at the CCP. 

Post CDML, the value can come from either the value in the element <initialMarginAccountId> or from the value in 
the element <positionAccountID>, depending on the level of granularity. 

This happens when the CCP provides margin calculations at portfolio level for a given customer. 

 

Example of EUREX 

Client: CAXXV 

Portfolios: 

a) CAXXV_P 

b) CAXXV_A1 

c) CAXXV_2 

We report in the CDML, in the element <initialMarginAccountId> the aggregated margin amounts for the three 
portfolios and three elements <segregationAccount>, each containing the margin requirements for a), b) and c). 

The user in Calypso has the choice of creating one margin call that represents the aggregation of the three 
portfolios. In that case it will create one margin call and will reference in the attribute CCP_REFERENCE the value of 

the element <initialMarginAccountId>. 

If the user needs more granularity, it can decide to create three margin calls where the CCP_REFERENCE attribute 
will contain the value of the <segregationAccount> element. 

6.2.2 Variation Margin Contracts 

Tab: Fields Client VM – USD 

[NOTE: Repeat for 
each currency for 
the multi-currency 
scenario] 

Parties: Processing Org <clearing 
member> 

Parties: Legal Entity Role Client 

Parties: Legal Entity <client> 

Details: Products CollateralExposure 

Details: Currencies USD 

Details: End of Day Pricing Environment <pricing env> 

Details: Intraday Pricing Environment <pricing env> 

Details: Contract Type Client 

Details: Haircut <haircut rule> 

Dates & Times: Valuation Time Zone Same as <pricing 
env> timezone 
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Tab: Fields Client VM – USD 

[NOTE: Repeat for 
each currency for 
the multi-currency 
scenario] 

Dates & Times: Send Statement Checked 

Initial Margin: Initial Margin Checked 

Initial Margin: Credit Multiplier  

Additional Info: CCP  

Additional Info: CCP_REFERENCE  

Additional Info: PRODUCT_TYPE  

Additional Info: MARGIN_TYPE VM 

Additional Info: INCLUDED_VM_FLOWS  

Additional Info: 
SEPARATE_VM_SETTLEMENT 

False 

Additional Info: VM_CLASSIFICATION CTM or STM 

Eligible Books: Set Default Book Checked 

Eligible Books: Book < client book> 

Eligible Securities  

Eligible Currencies <base currency> 

USD 

Eligible Currencies: Cash Margin Call 

Account 
True 

Eligible Currencies: Security Margin Call 

Account 
True 

Eligible Currencies: Orderer Role CounterParty 

 

Sample USD VM Client Contract 

For the multi-currency scenario, repeat for each client and for each currency. 

For the single-currency scenario, repeat for each client. 

The differences with the house contracts are listed below. 

Parties 

• Legal Entity Role = Client 

• Legal Entity = <Client name> 
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Dates & Times 

• Valuation Time Zone = Same as <pricing env> timezone 

• “Send Statement” = Checked 

 

Initial Margin 

• “Initial Margin” = Checked 

 

Additional Info 

• CCP = Not set 

• CCP_REFERENCE= Not set 

• PRODUCT_TYPE = Not set 

• MARGIN_TYPE = VM 

• INCLUDED_VM_FLOWS (Optional) = Not set. 

Comma-separated list of flow types associated with the margin call contract. If it is not set, all flow types 
will be associated with the margin call contract (default). 

• SEPARATE_VM_SETTLEMENT = False. 

If True, the flows associated with the margin call contract, including the Margin Call trades, will be 
included in a “Separate Settlements” section of the Client Statement. Otherwise, the flows will contribute 
to the Financial Summary table of the Client Statement. 

 

Eligible Books 

• Set Default Book = Checked 

• Book = <Client’s book name> - For example “Client A @ CGM” 

[NOTE: The timezone of the book must be the same as the margin call contract’s valuation timezone] 

 

Eligible Securities 

None. 

 

Eligible Currencies 

• Set the base currency – Example, “USD” 

• Only add the base currency as an eligible security, and check “Adjustment Currency”. 

You must also make sure that you have the workflow rule AutoAdjust on the following transitions in the 
Collateral workflow: PRICED_PAY - AGREE_EXPOSURE - EXPOSURE_AGREED and PRICED_RECEIVE - 
AGREE_EXPOSURE - EXPOSURE_AGREED. 

Example: 

 

• Cash Margin Call Account = True 

• Security Margi Call Account  = True 

• Orderer Role = CounterParty 
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6.3 Omnibus Client Contracts 

The omnibus client contracts are setup in the same way as individual client contracts for Omnibus client name. 

 See Client Facing Contracts for details. 

6.4 Collateral Investment Program 

The Collateral Investment Program allows FCMs to reinvest margin calls into the mutual funds participating in the 
program. 

The mutual funds are defined as Funds, and the investment is represented using Collateral Substitution of the 
margin calls into the Unitized Funds. 

6.4.1 Funds Definition 

From the Calypso Navigator, navigate to Configuration > Asset Management > Fund, and define the mutual 
funds as in the example below. 

 

» Select the “External” source, check “Unitized”, and check “Daily” dividend. 

 

Along with creating this “UnitizedFund” product, you need to create the product codes “Collateral Investment”, 
“SFR-8A”, and “SFR-8B” in the domain “FundAttributes”: 
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Then define the product codes using Main Entry > Configuration > Product > Code. 

In the Fund Configuration window, click  to open the Fund Attribute window, and set “Collateral Investment” 

to TRUE. 

Set SFR-8A to True if the fund should be added to column 8A of the SFR report (IEF5 funds), or set SFR-8B to True 
if the fund should be added to column 8B of the SFR report (other IEF funds). 

 

Then create a static data filter to identify the fund. This will be used during the Collateral Substitution process. 

 

This static data filter must be added to the tab called “Eligible Securities” in respective CCP Facing Margin Call 
Contracts. This will allow you to see all the Money Market Funds you have set up so you can later perform a 
Collateral Substitution. 

6.4.2 Margin Call Position Valuation Report 

If you are an FCM and you want to invest a client’s collateral on deposit with you, you need to choose which of the 
four CME Collateral Management Programs you as the FCM would like to invest in, how much, and finally how to 
allocate within each fund. Using the example of CME’s IEF2 and IEF5 investment funds, the FCM can only send USD 
cash and then enter the allocation of that cash in a separate CME system called “Clearing 21”. Using the existing 
CCP facing Margin Call contract(s) already created Calypso can generate a margin call trade where the FCM will 
wire funds to the CME. The cash can then be converted to a security that represents the investment in Calypso via 
a collateral substitution within Collateral Manager. Now you have created a security that represents the FCM’s 
investments in various CCP Collateral Management Programs. 

In Calypso, we can report on the pre/post haircut amounts invested using the Margin Call Position Valuation Report 
as seen below, where the pre haircut value is shown under the “Value” column and the post haircut value is seen 
under the “All-In Value” column. 

 

Note: In the above scenario, we have to mark the security at par on a daily basis. This can be done by using the 
PROP_RATE_1BUSDAY scheduled task. Should the value of the invested money market fund increase or decrease 
the user can manually change the price and manage the fluctuation accordingly. 

Now imagine your client wants to invest in CME’s IEF3 and 4 programs where the only acceptable forms of 
collateral are corporate bonds. The client must have sent in corporate bonds to the FCM to cover their collateral 
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requirements in which case the FCM would invest in IEF3 or IEF4. The FCM will then send the bonds to the CCP. 
Unlike IEF2, which is an investment of cash into a money market, IEF3 and 4 are programs where the FCM can 
post ineligible securities into a special account where they are rebranded as eligible collateral and can be used to 
meet IM requirements. The FCM must commit to a certain "lockup amount" which is essentially a guaranteed 
minimum amount that they will invest, as well as a term for that investment which dictates the minimum amount 
of time that the bonds will be pledged. 

6.4.3 Accounts Definition 

The purpose of creating a Collateral Investment Account Definition and corresponding SDIs and static data filter is 
to prevent the transfers that are tagged as a collateral investment from hitting the inventory engine and updating 
the Nostro. 

 

Next create a static data filter that will enable you to achieve separation of trades and transfers which is further 
explained in the next section. 

 

Note: You need to add the trade keyword “IEF2” to the domain “tradeKeyword”, and add the domain 

“keyword.IEF2” to give it a list of available values. 
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Then create the SDIs that will route both the cash and security transfers to this Collateral Investment Account. 

Counterparty SDI 

 

Processing Org SDI 
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You can view in the Transfer Viewer that the USD cash settlement did not hit the Nostro. 

 

Proceed to the next section that explains how to tag both trades and transfers. 
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6.4.4 Collateral Investment 

Using the Collateral Manager, you can increase or decrease the amounts in a certain investment program by 
choosing the security that represents the investment in Calypso and performing a Collateral Substitution. 

Our recommendation to accomplish this would be the use of the “Collateral Context” feature which is located within 
Collateral Manager as follows: 

 

Here you can configure the system to tag the ‘investment’ allocations (both trade and transfer). 

You can name the new attribute with a name that corresponds to the various investment vehicles you are investing 
in which from the “Allocation Attributes” tab as seen below. 

 

When performing a collateral substitution, you will need to configure the Allocation Attribute by choosing Data > 
Configure Columns, and add the name of the attribute you have configured. 
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When ready to perform the substitution tick off the checkbox as seen below. 

 

After applying the allocation and pricing the contract all the way to EXECUTED status. This will put a keyword on 
the margin call trades. 

 

This will get both the trade and transfer tagged. 

6.4.5 Haircut 

Haircuts rules are setup on the Margin Call Contract under the details tab. You will need to create the haircuts 
specific to each fund as per the CME website. Using CME’s IEF2 program as an example where there is a 
mandatory 3% haircut you would perform the following steps in order to record the haircut values. 

To create a haircut you load the relevant CCP facing Margin Call Contract but you must first define an SD filter that 
will locate the security position you want to add a haircut to. 
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Then navigate to the details tab, and click Show Haircut: 

 

It brings up the Haircut Rule Configuration GUI where you enter the PE, SD filter and finally add a haircut value. 
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You then choose the haircut rule you just saved in the details tab of the Margin Call Contract. 
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6.4.6 Inclusion in the Sequestered Fund Report 

The money invested in the funds should appear in line 8A or 8B at market value, based on the fund attribute “SFR-
8A” or “SFR-8B”. 

This information gets pulled from the Margin Call Position Valuation Report: any securities with product code 
“Collateral Investment = True” as of previous day’s close of business (T-1) converted to USD based on FX Rate 
from quote set. 

6.4.7 Configuration for Investing in Treasury Bonds 

Imagine an FCM has excess client cash posted as collateral for which they are paying the client a fixed interest 
rate. In addition to investing client funds, the FCM can also borrow internally from another funding desk and then 
invest it into a non CCP Investment Vehicle (e.g. Government Securities).  

Calypso recommends the FCM enter into a BOND transaction where the Counterparty can be Harris Bank or any 

other CFTC approved investment vehicle.  

Unlike what is described above when creating a UnitizedFund where a new Product_Code: Collateral Investment = 
TRUE, the FCM would need to create a new “Bond Collateral Investment” bond product. 

This will ensure the bond used to invest into a Harris type investment vehicle will allow the following code changes 
to the SFR to work. Essentially, line 7b works off of account attributes instead of a Product Code. Here is a sample 
of the Account definition setup along with the respective attributes. 

 

 

The LE was set to Harris Bank as this is where the Bond cash was settled. Note: You will need to create a Bond 
Collateral Investments account for each LE that will be holding the "Real Money Amount" for each Bond purchase 
and subsequent SDIs. 

Line 7B - From the Inventory Position Report as of previous days close of business (T-1) take all accounts that 
have the "SequesteredAccount" attribute set to "BANK" as well as the attribute "Collateral Investment" set to True 

and calculate the values of any securities that fall into the aforementioned account criteria converted to USD based 
on FX Rate from quote set. The values will be determined by using the CleanVal(MTM) balance type which is the 
position quantity multiplied into the security clean price. 
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Configuration Requirements 

The premise behind the following configuration is to allow Calypso to generate the value of any bond using the 
CleanPrice on the Settlement so that your SFR amounts are not overstated. 

Within the Inventory Position report, choose Process > Create Balance Type, and create the balance type 
“CleanVal(MTM)”. 

 

Then choose Process > Define Balance Type where you can create the formula to produce the CleanVal(MTM) 
balance type which is the position quantity multiplied into the security clean price. 

 

Once you are done with the formula click Apply. 

Then load up the Inventory Position report with the following parameters so that you can see the value of any 
settled Bond trade. 
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The 7,500,000.00 represents the actual clean value of a settled bond where the calculation takes the Quantity * 
CleanPrice. Bond details: Bond purchased with quantity of 5,000,000.00 at a price of 100.00. The closing quote for 
the bond is 150.00. So if you multiply 5,000,000.00 * 1.50 you get 7,500,000.00. 

You should also setup a formula for dirty price calculations on the Inventory Position report in the same way. 

Add and save new balance type 

 

 

You also need create the domain “SFR7BMovementType” to control what value of the bond trade you would like to 
be displayed on the SFR (i.e. Clean or Dirty) on line 7B. Example: 
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6.4.1 Pledge the Bond at the CCP and Populate 8-B 

The FCM will buy the bond from the street (reflected in SFR columns 7-a and 7-b) before pledging it to the CME 
(reflected in column 8-b). 

It is expected that IM Standardization is in place, meaning that we maintain internal and external client position for 
IM. 

Create new Allocation Attribute ‘InvestmentBonds’ in the Collateral Context windown that will be passed down to 
the MarginCall Trade when the bond is allocated. This attribute will be used to drive the SDIs. 

 

Allocate Bond and tick attribute to true. 
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System will pick the CCPs DDA SDI based on the filter to which the security will be paid to. 

  

 

On PO Side, this SWIFT PAY SDI should be used to debit Nostro Security account 
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The Direct account set up with CME should have account attribute ‘Collateral Investment’ set to true 
(SequesteredAccount should be null) 

  

 

Similarly to SFR 7b, it is possible to configure the position type to be displayed by Clean or Dirty price. The system 
will re-use the same configurable balance type set up for 7b and look up a new domain SFR8BMovementType set to 
CleanVal(MTM) or DirtyVal(MTM) depending on the position type to be displayed.  



Clearing Member Setup Guide 114 

©  2 0 1 1 – 2 0 1 8  |  Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved 

 

 

The Position is sourced from the Inventory position based on following criteria: 

 

Position Date: Settle 

Position Class: Internal 

Position Type: Actual 

Position Value: Nominal 

Cash/Sec: Security 

MovementType: CleanVal(MTM) or DirtyVal(MTM) if specified in above domain value, else defaulted to Balance 

 

Sum of values will be converted to USD 
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Section 7. ERS Limits 

In order for the trades to go through limits checking, you need to perform the following configurations. 

7.1 Trade Filters 

You need to create trade filters for the trades for which you want to check limits using Configuration > Filters > 
Trade Filter from the Calypso Navigator. 

For example: 

 

7.2 Market Risk Hierarchy 

You need to define a market risk hierarchy. Market risk hierarchies are created using ERS Risk. 

Bring up ERS Risk and click Admin in the upper right-hand corner. 

Then select the Hierarchy Editor. 
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Create a hierarchy as needed, and add nodes. The nodes correspond to Trade Filters. 

If the trade filter contains a book, then the trade filter is used to select the trades. Otherwise, the system selects 
the trades for which the trade keyword LIMIT_WHATIF_PORTFOLIO is the node name. 

[NOTE: Each node name must be the same as a Trade Filter] 

 Please refer to the Calypso ERS Risk User Guide for details on using this window. 

7.3 Pre-Deal Limit Configuration 

Make sure that the product types for which you want to check limits are defined in domain “limit.products”. 

7.4 Limits Configuration 

Bring up ERS Limits, and define limits for the hierarchy you have created under Limits > View / Edit. 

Select the hierarchy you have created, and click Load. 
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Then click New in the upper right-hand corner, and select a measure you want to check limits against. 

You can then define the limit amounts. 

 

Once you have defined limits, you need to authorize them before they become effective. 

 Please refer to the Calypso ERS Limits User Guide for details on using these windows. 

7.5 Limits Checking 

The EOD limits usage is computed using the scheduled task ERS_ANALYSIS for the ERS batch process that runs the 
Sim analysis on the market risk hierarchy. 

You can create an ERS batch process under in ERS Risk under Admin > Batch Editor as in the example below. 
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The scheduled task ERS_ANALYSIS should be run at the end of the day on this batch process, after all other 
clearing activity is completed. 

Sample setup: 

 

The batch process is set in the Batch Name attribute. 

When trades are received from the CCP, they go through the limits checking using the workflow rule 
CheckWhatIfLimits. 

The following trade keywords are populated: 

Trade Keywords Description 

LIMIT_WHATIF_CHECK_PASS Displays Y if the What-If analysis returns a usage value that does not 
violate the defined Market Risk Limit. It displays N otherwise. 

LIMIT_WHATIF_LIMIT_MAX Displays the maximum limit defined for the Market Risk Limit. 

LIMIT_WHATIF_RISK_USAGE Displays the usage value of the What-If analysis results. 

LIMIT_WHATIF_CHECK_ERROR Displays Y if there is an error while checking the limits, or N (or empty) 
otherwise. 
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Trade Keywords Description 

LIMIT_WHATIF_CHECK_ERROR_MSG Displays an error message when LIMIT_WHATIF_CHECK_ERROR=Y. 

LIMIT_WHATIF_PORTFOLIO ERS Limits portfolio. 
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Section 8. Clearing Fees 

The following types of clearing fees can be setup in the system. 

 

The CCP charges commissions on the trades to the clearing member on a periodic basis, and the clearing member 
charges those commissions to the clients immediately. 

The clearing member may also charge execution fees on the trades to the clients immediately. 

The CCP also charges maintenance fees on the accounts to the clearing member on a periodic basis, and the 
clearing member charges those maintenance fees to the clients on a periodic basis as well. 

Immediate trade fees, periodic trade fees, and account fees require a different setup. 

Note on Swap Residual Maturity for Transaction Fees and Maintenance Fees 

[NOTE: This only applies to version 14.4 of Core Calypso, and above] 

By default, the swap residual maturity is computed as: 

Swap residual maturity = MAX(CCPClearedDate,StartDate) - End Date 

You can change the behavior by adding the CCP name to the following domains: 

• “TransactionAdjustedEndDate” for Transactions fees - The end date is adjusted based on the Date Roll 
convention if it falls on a holiday (applies to LCH). 

• “TransactionStartDate” for Transaction fees – The start date is CCPClearedDate (applies to LCH). 

• “MaintenanceAdjustedEndDate” for Maintenance fees - The end date is adjusted based on the Date Roll 
convention if it falls on a holiday (applies to LCH). 

• “MaintenanceOriginalClearDate” for Maintenance fees – The start date is CCPOriginalClearedDate for 
netted trades (applies to LCH). 

• “MaintenanceStartDate” for Maintenance fees – The start date is CCPClearedDate (applies to LCH and 
CME). 

8.1 Clearing Member Commissions and Execution Fees 

The clearing member charges commissions and execution fees on the trades to the clients immediately. 

They are computed on the trades using the AutomaticFees workflow rule, which should be set on the workflow 
transitions once the trade is cleared: CLEARED – ENRICH – VERIFIED, VERIFIED – UPDATE – VERIFIED, etc. 

 See Trade Workflows for complete details on the trade workflow. 

CCP 

Clearing Member 

Clients 

Periodic Trade 
Commissions 

Periodic Account 
Maintenance Fees 

Immediate Trade 
Commissions 

Execution Fees 

Periodic Account 
Maintenance Fees 
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8.1.1 Fee Definition 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Definition to 
define the fee types, for example COMMISSION_FEE and EXECUTION_FEE. 

 

8.1.2 Fee Grids 

The Fee Grid is just a link to the Fee Config window where you can define the actual fee amounts. You need to 
define one fee grid for each fee type. 

You can use a static data filter to restrict the application of the fees. 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Grid. 
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The Calculator must be set to “FeeConfig”. 

You also need to set the following attributes: 

• TRADE_DATE_TYPE should be set to “CLEARED DATE” so that the fee will settle on the cleared date set in 
the trade keyword CCPClearedDate. 

• ZeroAmount should be set to “false” so that the system will not generate any fees with 0 amount. 

 

8.1.3 Fee Configs 

You need to define one fee config for each fee type. 

Note that for trade fees, the config type must always be set to “Trade Fee”. 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Config. 

Commission fees as specified below will be computed based on the trade notional. Depending on the trade’s 
maturity we will apply x USD per million notional. E.g. for a 10 million trade maturing in 6 month: commission = 
10*2 = 20 USD. 
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Sample formula definition. 

 

8.2 CCP Commissions and Maintenance Fees 

The following periodic fees can be setup: 

• The CCP charges commissions on the trades to the clearing member on a periodic basis – Example 
CME_COMMISSION_FEE. 

• The CCP charges maintenance fees on the accounts to the clearing member on a periodic basis – Example 
CME_MAINTENANCE_FEE. 

• The clearing member charges maintenance fees on the accounts to the clients on a periodic basis – 
Example MAINTENANCE_FEE. 

They are computed by the Billing engine based on billing grids and billing rules. 

The fee types that you want to compute on a periodic bases must be defined in the domain BillingFeeType. 
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8.2.1 Billing Grids 

The Billing Grid is a onetime configuration that should be as generic as possible. At least one billing grid is needed 
by billing event (trade, transfer, message, MaintenanceTrade, Account). The idea here is to link the fee calculation 
to the Fee Config window (via the calculator), and determine what date type should be used to generate the fee 
billing entry. 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Grid to define 
billing grids. 

Billing Grid for Trade Events 

 

• Role = CounterParty 

• Fee Value Date = TradeClearedDate 

• Calculator = FeeConfig 

Billing Grid for Trade Rebate Events 

This billing grid only applies if a rebate is defined in the Fee Config. 
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• Role = CounterParty 

• Fee Value Date = TradeClearedDate 

• Calculator = TradeFeeRebate 

Billing Grid for Maintenance Trade Events 

This billing grid will apply for ALL counterparties on MaintenanceTrade billing events, in our case 
MAINTENANCE_FEE and CME_ MAINTENANCE_FEE. Note that “date” should be set to “CustomDate” since the 
billing frequency is determined on the Fee Config. 

 

• Role = CounterParty 
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• Fee Value Date = CustomDate 

• Calculator = FeeConfig 

8.2.2 Billing Rules 

The Billing Rule determines the billing period, settle date, billing currency of the billing trade on which the billing 
fee entry will be generated. It is also possible to default certain billing trade entries such as the book and transfer 
type. 

You need to define one billing rule per fee type. 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Billing Rule to 
define billing rules. 

CONTRACT REBATE 

This config will apply for ALL counterparties in case a rebate applies. 

Note that the attributes BillingOnly and EntryType are mandatory. BillingOnly should always be set to true and 
EntryType to the corresponding fee type. 
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MAINTENANCE_FEE 

You can select a given client (counterparty) as needed. 

 

 

CME_MAINTENANCE_FEE 

This rule will only apply for maintenance fees that will be charged from the CCP (CME in this example). 
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CME_COMMISSION_FEE 

This rule is for CME only since the commissions charged by the clearing member are charged directly on the trades. 
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8.2.3 Fee Configs 

You need to define one fee config for each type of fee. The billing rule is linked to the fee config via the attribute 
EntryType. 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Config to 
define fee configs. 

MAINTENANCE_FEE 

Maintenance fees are generated on account balances. 

On the account for which you want to generate the fees, you need to check the Billing checkbox. 

Maintenance fees are triggered by the event MaintenanceTrade which is generated by the scheduled task 
ACCOUNT_BILLING. 

NOTE: You can set the legal entity attribute WAIVE FIRST to true to waive the first billing fee. 

Scheduled task ACCOUNT_BILLING: 
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Fee Config: 

 

• Config Type = Billing Fee 

• Rule Type = Maintenance 

• Event Type = MaintranceTrade 
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• Billing Fee Type = EntryType set on Billing Rule = Billing fee type 

• Fee Date = Fee frequency 

Sample formula 

 

CME_MAINTENANCE_FEE 

Similar setup to MAINTENANCE_FEE. 
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CME_COMMISSION_FEE 

This fee is generated by the Billing engine based on trade events. 

 

8.2.4 Billing Trades 

The Billing engine is used to create the billing fees. 

It must subscribe to the following events: 

• PSEventTrade 

• PSEventAccountBilling 

• PSEventMaintenanceTrade 

 

Version 14.0+ 

Make sure that the Billing engine is set in the parameter “engines.startup” of “<calypso 

home>/deploy/EngineStartupConfig.properties”: 

engines.startup=TransferEngine,MessageEngine,InventoryEngine,AccountingEngine,Liquidat

ionEngine,PositionEngine,TaskEngine,LifeCycleEngine,BillingEngine 

 

You can start the Billing engine as part of the Engine server using "<calypso 

home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on 

*nix platforms. 

 

Version 14.1+ 

The Billing engine is configured in the Engine Manager of Web Admin: event subscription and engine parameters. 
You may need to add this engine if it is not available for configuration: Create a new engine called BillingEngine, 
with class name com.calypso.engine.billing.BillingEngine. 

 
The Billing engine can be started from the Engine Manager in Web Admin. 

 Please refer to Calypso Web Admin documentation for complete details. 
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Sample CME_COMMISSION_FEE 

 

 

As more trades are entered into the system, more billing fees are added to the same billing trades. 

 

Sample MAINTENANCE_FEE 
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Rebate Process 

In case a rebate is configured on the Fee Config, rebate entries are generated using the EOD_REBATE_FEE 
scheduled task. 

The rebate process adjusts the fee rate based on all the events of the billing period (Default rebate type), or 
applies a discount based on the total fee amount and the discount schedule (Discount rebate type). 

The EOD_REBATE_FEE scheduled task must be run daily. It retrieves the billing trades for which the end date falls 
on the scheduled task valuation date. 

The system creates new billing entries of type REBATE to book the difference between the billing fee amount 
originally computed, and the billing fee amount computed at the end of the period, once the actual fee rate is 
known / discount is applied. There is one REBATE billing entry per trading book. 
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 Refer to Calypso Fees documentation for details on using these windows. 

8.3 Initial Margin Fees 

The CCPs charge fees on the initial margin requirements. 

Billing events are generated by the scheduled task CLEARING_BILLING based on account positions. The Billing 
engine subscribes to the billing events to generate the fees (billing trades) based on billing grids and fee billing 
rules. 

The Billing Grid calculator “InitialMarginFee” computes fees of type IM_BASED_FEE, on a periodic basis, using the 

scheduled task CLEARING_BILLING and the Billing engine. 

The scheduled task CLEARING_BILLING will only process accounts for which the Billing checkbox is checked. 

Make sure that you add IM_BASED_FEE to the domain “BillingFeeType”. 

You also need to add BillingInitialMarginFeeCalculator to the domain “billingCalculator”. 

The billing role of CCP-Facing trades is set to the role defined in the domain “Clearing.BillingFeeCCPReceiverRole”. 
If not set, the fee is generated using the role from the billing grid. 
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Setup details are described in the following sections. 

8.3.1 Billing Grid 

Choose Main Entry > Configuration > Fees, Haircuts, & Margin Calls > Fee Grid, and select the Billing Grid 
panel to define billing grids. 

 

Enter the criteria as needed. 

Select the calculator BillingInitialMarginFeeCalculator and click Add. 

 

The Daily fee type uses the previous day's IM Requirement to calculate each day's Fee, and carries the calculation 
forward to include the non-business days that immediately follow a given date. For example, the Fee calculated for 
a Friday will be generated for 3 days to cover Friday, Saturday and Sunday. 

The Daily fee type inserts a unique Fee into the Billing Trade for each day that the scheduled task is run. The sum 
of these Daily Fees will be the Monthly Total. The Fee currency for the Daily Fee is expected to be in the currency 
of the Requirement, so there is no FX Conversion logic. 

You can also select the currency as needed to define different IM requirements by currency. 
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If you check “Post-Buffer” the base amount to compute the fee is the Net Balance of the margin call contract 
(which takes the buffers into account). Otherwise, it is the pricer measure MARGIN_CALL. 

The ProductType attributes needs to match the “Product” field specified for the BillingInitialMarginFeeCalculator. 

 

8.3.2 Fee Billing Rule 

The billing rule allows defining the billing frequency, and a billing threshold if needed. 

Define the billing rule using Main Entry > Configuration > Fees, Haircuts & Margin Calls > Fee Billing Rule 

(menu action refdata.FeeBillingRuleWindow). 

 

» Click Add Attributes to add the EntryType attribute. 

 

Set EntryType = User-defined fee, “IM_BASED_FEE” in this example. 
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8.3.3 Fee Generation 

Configure the CLEARING_BILLING scheduled task. 

 

» Select the CCP for which you want to generate the fees. 

» Select the product type as needed. 

[NOTE: For the CME IM fee, the scheduled task should be run only at the end of the month] 

 

If the business holidays are set, and the valuation date is a holiday, the scheduled task fails. You can monitor the 
exception in the Task Station: 

• Add EX_CLEARING_BILLING to the domain “eventType”. 

• Add CLEARING_BILLING to the domain “exceptionType”. 

 

The scheduled task looks up the clearing account and generates PSEventAccountBilling events based on the billing 
grid. 

The Billing engine subscribes to PSEventAccountBilling events and generates billing trades based on the billing rule. 

 

Version 14.0+ 

Make sure that the Billing engine is set in the parameter “engines.startup” of “<calypso 

home>/deploy/EngineStartupConfig.properties”: 

engines.startup=TransferEngine,MessageEngine,InventoryEngine,AccountingEngine,Liquidat

ionEngine,PositionEngine,TaskEngine,LifeCycleEngine,BillingEngine 

 

You can start the Billing engine as part of the Engine server using "<calypso 

home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on 

*nix platforms. 
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Version 14.1+ 

The Billing engine is configured in the Engine Manager of Web Admin: event subscription and engine parameters. 
You may need to add this engine if it is not available for configuration: Create a new engine called BillingEngine, 
with class name com.calypso.engine.billing.BillingEngine. 

 
The Billing engine can be started from the Engine Manager in Web Admin. 

 Please refer to Calypso Web Admin documentation for complete details. 

 

The book is set on the billing trades according to the following logic: 

• The book specified on the billing rule is selected by default. 

• If not set, the “Funding Book” legal entity attribute on the PO is selected. 

• If not set, the standard clearing book lookup method is used. 

 See Defining Books for details. 

 

Sample billing trade: 

 

 

8.4 Security Collateral Fees 

Billing events are generated by the scheduled task CLEARING_BILLING based on margin call positions. The Billing 

engine subscribes to the billing events to generate the fees (billing trades) based on billing grids and fee billing 
rules. 
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The Billing Grid calculator “BondInvestmentFeeCalculator” computes fees of user-defined type, on a periodic basis, 
using the scheduled task CLEARING_BILLING and the Billing engine. 

The scheduled task CLEARING_BILLING will only process accounts for which the Billing checkbox is checked. 

Add the fee type that you want to generate to the domain “BillingFeeType”. For example, “IEF4_Fees”. 

You also need to add BondInvestmentFeeCalculator to the domain “billingCalculator”. 

The billing role of CCP-Facing trades is set to the role defined in the domain “Clearing.BillingFeeCCPReceiverRole”. 
If not set, the fee is generated using the role from the billing grid. 

Setup details are described in the following sections. 

8.4.1 Billing Grid 

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Grid, and 
select the Billing Grid panel to define billing grids. 

 

Enter the criteria as needed. 

Select the calculator BondInvestmentFeeCalculator and click Add. 
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» Enter the details of the calculator. 

» Set the billing type to the user-defined fee, IEF4_Fees in this example. 

» Then click Apply. 

Save the billing grid when you are done. 

8.4.2 Fee Billing rule 

The billing rule allows defining the billing frequency, and a billing threshold if needed. 

Define the billing rule using Main Entry > Configuration > Fees, Haircuts & Margin Calls > Fee Billing Rule 

(menu action refdata.FeeBillingRuleWindow). 

 

» Click Add Attributes to add the EntryType attribute. 
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Set EntryType = User-defined fee, “IEF4_Fees” in this example. 

8.4.3 Fee Generation 

Configure the CLEARING_BILLING scheduled task. 

 

» Select the CCP for which you want to generate the fees. 

» Select the product type as needed. 

 

If the business holidays are set, and the valuation date is a holiday, the scheduled task fails. You can monitor the 
exception in the Task Station: 

• Add EX_CLEARING_BILLING to the domain “eventType”. 

• Add CLEARING_BILLING to the domain “exceptionType”. 

 

The scheduled task PSEventAccountBilling events based on the billing grid. 

The Billing engine subscribes to PSEventAccountBilling events and generates billing trades based on the billing rule. 

 

Version 14.0+ 
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Make sure that the Billing engine is set in the parameter “engines.startup” of “<calypso 

home>/deploy/EngineStartupConfig.properties”: 

engines.startup=TransferEngine,MessageEngine,InventoryEngine,AccountingEngine,Liquidat

ionEngine,PositionEngine,TaskEngine,LifeCycleEngine,BillingEngine 

 

You can start the Billing engine as part of the Engine server using "<calypso 

home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on 

*nix platforms. 

 

Version 14.1+ 

The Billing engine is configured in the Engine Manager of Web Admin: event subscription and engine parameters. 
You may need to add this engine if it is not available for configuration: Create a new engine called BillingEngine, 
with class name com.calypso.engine.billing.BillingEngine. 

 
The Billing engine can be started from the Engine Manager in Web Admin. 

 Please refer to Calypso Web Admin documentation for complete details. 
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Section 9. Message Configurations 

From the Calypso Navigator, navigate to Configuration > Messages & Matching > Message Set-up for 
defining messages. 

9.1 CONSENT Messages 

The CONSENT message is sent to the CCP once a trade has been approved / rejected in Calypso. Upon receipt of 
the CONSENT message, the CCP will clear / cancel the trade. 

9.1.1 Message Setup 
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9.1.2 Message Sender Config 
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9.2 CLEARING_STATEMENT Messages 

The CLEARING_STATEMENT message is the client statement – It is generated by the Message engine once the 
scheduled task CLEARING_STATEMENT sends the STATEMENT events. 

 

[NOTE: Receiver Role = Client] 

We are using the role “Client” in this setup. It can also be “ExtCounterParty”. 

 See On-Boarding an Individual Client for details. 

You can select any HTML template – It will be overridden by the CLEARING_STATEMENT message formatter to use 
an XSL template. 

If you also want to generate a PDF statement, add the following message configuration: 

 

» Format Type = PDF 

» Template = “CMFMCClearingStatementPDF.html” 
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9.2.1 Default Templates 

The default templates are located in “resources/com/calypso/templates”: ClearingStatement.xsl, and 

CondensedClearingStatement.xsl. 

The XSL templates can be customized as needed. 

For example, you can easily replace the “logo” image, and any disclaimer in the “footer”. 

<img src="https://www.calypso.com/images/logo.gif" alt="Logo"/> 

<p class="FOOTER"> 

 Statement generated by Calypso Technology, 2013. 

</p> 

The actual content of the client statements is defined in the files 
“resources/config/ClearingStatementFactory.xml” and 

“resources/config/CondensedClearingStatementFactory.xml”. 

[NOTE: If the “Excess/Deficit Including Pending Collateral” row name is customized in 
“ClearingStatementFactory.xml”, all occurrences of such name must also be replaced in “ClearingStatement.xsl”] 

9.2.2 Defining a Template by Legal Entity 

It is possible to override the default location of the template, and set it by legal entity, using the configuration file 
“resources/com/calypso/tk/clearing/factory/ResourceClearingFactory.Statement.xml”. 

A sample configuration file is provided in 
“resources/com/calypso/tk/clearing/factory/ResourceClearingFactory.Statement.xml.sampl

e”. You need to rename it to 

“resources/com/calypso/tk/clearing/factory/ResourceClearingFactory.Statement.xml” in 

order to use it. 

If this file does not exist, the default template will be used instead. 

<?xml version="1.0" encoding="UTF-8"?> 

<beans xmlns="http://www.springframework.org/schema/beans" 

 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:util="http://www.springframework.org/schema/util" 

 xsi:schemaLocation=" 

  http://www.springframework.org/schema/util 

  http://www.springframework.org/schema/util/spring-util-3.0.xsd 

http://www.springframework.org/schema/beans 

http://www.springframework.org/schema/beans/spring-beans-3.0.xsd" 

 default-init-method="init" default-destroy-method="destroy"> 

 

 <!-- statementConfigurationPaths has to be a list of valid Spring resource 

paths. See http://docs.spring.io/spring/docs/3.0.x/spring-framework-

reference/html/resources.html#resources-app-ctx for more info --> 

 <!-- statementTemplatePath has to be either an absolute file path, or a 

classpath, with no classpath: or file: prefix --> 

 

 <!-- SAMPLES 

  

 <bean id="calypsoUKresourceLocations"  

  

 class="com.calypso.tk.bo.clearing.statement.ClearingStatementResourcesLocator" > 

  <meta key="LegalEntity" value="CALYPSO_UK"/> 

  <property name="statementTemplatePath"  

value="com/calypso/templates/custom_statement.xsl" /> 

  <property name="statementConfigurationPaths">    

   <list> 

 <value>classpath:config/CustomUKClearingStatementFactory.xml</value> 

 <value>config/OtherCustomUKClearingStatementFactory.xml</value> 

   </list> 

http://docs.spring.io/spring/docs/3.0.x/spring-framework-reference/html/resources.html#resources-app-ctx
http://docs.spring.io/spring/docs/3.0.x/spring-framework-reference/html/resources.html#resources-app-ctx
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  </property> 

 </bean> 

 

 <bean id="customerAresourceLocations" 

class="com.calypso.tk.bo.clearing.statement.ClearingStatementResourcesLocator" /> 

  <meta key="LegalEntity" value="CUSTOMER_A" /> 

  <property name="statementTemplatePath"  

value="/path/to/calypso/resources/com/calypso/templates/custom_statement.xsl" /> 

  <property name="statementConfigurationPaths"> 

   <list> 

<value>file:///path/to/calypso/resources/config/CustomerAClearingStatementFactory.xml<

/value> 

</list> 

  </property> 

 </bean> 

  

 END SAMPLES --> 

  

</beans> 

9.3 CVR_WORKSHEET Messages 

This message type is used to generate the Collateral Valuation report. 

It is not necessary to setup a message configuration, but it is necessary to define a message workflow for this type 
of message. 

The CVR_WORKSHEET message workflow can be imported using “<calypso 

home>/client/resources/CVR_WORKSHEET.wf”. 

If you are clearing with LCH, you need to use the file “<calypso 

home>/client/resources/CVR_WORKSHEET_LCH.wf” instead. It adds the transition highlighted below for 

managing incoming collateralAllocation messages. 

Orig Status Action Resulting 
Status  

Subtype  Product 
Type 

Processing 
Org 

ACCEPTED ACCEPT ACCEPTED    

ACCEPTED ACK ACCEPTED    

ACKED ACCEPT REJECTED    

ACKED REJECT REJECTED    

EDITABLE CANCEL CANCELED CVR_WORKSHEET ALL ALL 

EDITABLE EXPORT EXPORTED CVR_WORKSHEET ALL ALL 

EDITABLE UPDATE EDITABLE CVR_WORKSHEET ALL ALL 

EXPORTED AUTHORIZE TO_BE_SENT CVR_WORKSHEET 
Rule: PrepareCVRForSend 
Filter: 
isLCHCVRValidToSend 

ALL ALL 

NONE NEW EDITABLE CVR_WORKSHEET ALL ALL 

REJECTED ACK REJECTED CVR_WORKSHEET ALL ALL 

REJECTED REJECT REJECTED CVR_WORKSHEET ALL ALL 

SENT ACCEPT ACCEPTED CVR_WORKSHEET ALL ALL 

SENT ACK ACKED CVR_WORKSHEET ALL ALL 

SENT REJECT REJECTED CVR_WORKSHEET ALL ALL 

TO_BE_SENT SEND SENT CVR_WORKSHEET ALL ALL 

Static data filter “isLCHCVRValidToSend” 
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It is also necessary to define a message sender configuration in order to send the report to LCH through MQ Series. 

 

Once a CVR report is exported, from the CVR report or using the scheduled task 
CLEARING_EXPORT_CVR_WORSHEET, it is sent to LCH using the MQ connector LCHCVR. 

MQ Series is configured using the following files: 

• “<calypso home>/client/resources/LCHCVRbridge_config.properties.sample” (mandatory to send 

the outgoing CVR messages to LCH) 

• “<calypso home>/client/resources/LCHCVRbridgeservice.properties.sample” (optional, used to 

receive response messages) 

 

[NOTE: Resource files need to be copied to <calypso home>/custom-extensions/custom-

projects/custom-shared-lib/src/calypso/resources. You may need to create this folder if it does not 

already exist. You will then need to deploy the files to your applications servers] 
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 Please refer to the Calypso Installation Guide for details on deploying resource files. 

 

LCHCVRbridge_config.properties 

Rename “LCHCVRbridge_config.properties.sample” to “LCHCVRbridge_config.properties”, and 

modify as needed. 

# 

#  JMS properties file 

# 

#  REFER TO EXCHANGE FEED DOCUMENTATION FOR MORE INFO  

# 

#  JMSQueueIEAdaptor properties 

# 

#    Note: if queue.ackType is not set to auto then  

#          failed messages are not acknowledged to JMS and 

#          will be reconsumed when the engine restarts 

#  

# Queue-specific properties are prefixed by the queue name 

# 

input.queue.name=JQUEUE.LCH.CALYPSO 

JQUEUE.LCH.CALYPSO.queue.ackType=auto 

JQUEUE.LCH.CALYPSO.queue.persist=false 

JQUEUE.LCH.CALYPSO.queue.transacted=false 

 

output.queue.name=JQUEUE.CALYPSO.LCH 

JQUEUE.CALYPSO.LCH.queue.ackType=auto 

JQUEUE.CALYPSO.LCH.queue.persist=false 

JQUEUE.CALYPSO.LCH.queue.transacted=false 

 

jms.queue.hostname=localhost 

jms.queue.port=1414 

jms.queue.connectionUserName= 

jms.queue.connectionPassword= 

jms.queue.transportType=MQJMS_TP_CLIENT_MQ_TCPIP 

jms.queue.queueManager=QM.LCH.CALYPSO 

jms.queue.channel=SYSTEM.ADMIN.SVRCONN 

 

LCHCVRbridgeservice.properties 

Rename “LCHCVRbridgeservice.properties.sample” to “LCHCVRbridgeservice.properties”, and 

modify as needed. 

bridge.counterparty.attribute.identifier=LCH_CPTY 

 

########################################### 

# Bridge original, work in progress and  # 

# final transformation directory of the   # 

# incoming message.      # 

# If this option is not set,     # 

# <CALYPSO_HOME>/<Connection>    # 

# will be used by default     # 

########################################### 

#file.bridge.log.directory=C:\\LCH 

 

 

REQUESTCONSENT_SWAP_BRIDGE_XSLT=LCH_REQUESTCONSENT_SWAP.xslt 

CLEARINGCONFIRMED_SWAP_BRIDGE_XSLT=LCH_CLEARINGCONFIRMED_SWAP.xslt 

SWAP_TRANSFORMER_CLASS=com.calypso.tk.bo.bridge.transformer.LCHSWAPMappingTransformer 

KEYWORDS_REQUESTCONSENT_SWAP_XSLT=KEYWORDS_LCH_REQUESTCONSENT_SWAP.xslt 

KEYWORDS_CLEARINGCONFIRMED_SWAP_XSLT=KEYWORDS_LCH_CLEARINGCONFIRMED_SWAP.xslt 

 

REQUESTCONSENT_FRA_BRIDGE_XSLT=LCH_REQUESTCONSENT_FRA.xslt 
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CLEARINGCONFIRMED_FRA_BRIDGE_XSLT=LCH_CLEARINGCONFIRMED_FRA.xslt 

FRA_TRANSFORMER_CLASS=com.calypso.tk.bo.bridge.transformer.LCHFRAMappingTransformer 

KEYWORDS_REQUESTCONSENT_FRA_XSLT=KEYWORDS_LCH_REQUESTCONSENT_FRA.xslt 

KEYWORDS_CLEARINGCONFIRMED_FRA_XSLT=KEYWORDS_LCH_CLEARINGCONFIRMED_FRA.xslt 

 

RULE_HANDLER=com.calypso.tk.bo.bridge.handler.LCHCVRRuleHandler 

 

 

# BRIDGE BO Messages default sender and receiver.  

BridgeMessageDefaultSender=LCH 

BridgeMessageDefaultReceiver=CALYPSO 

 

ThreadPoolSize=5 

# Look for file changes every xx-seconds. 

interval=10 

########################################### 

# Message validator list                  # 

# A list of xslt files located in         # 

# /resources/calypso/mapping/             # 

# for incoming message validation by      # 

#  message structure      # 

########################################### 

ValidatorFiles=exchange_feed_clearing_confirmed_check_fpml5.3.xslt,exchange_feed_clear

ing_status_check_fpml5.3.xslt,exchange_feed_request_consent_check_fpml5.3.xslt,exchang

e_feed_consent_acknowledgement_check_fpml5.3.xslt,exchange_feed_clearing_refused_check

_fpml5.3.xslt,exchange_feed_service_notification_check_fpml5.3.xslt,exchange_feed_posi

tion_report_check_fpml5.3.xslt,exchange_feed_lch_data_document_check_fpml5.3.xslt,exch

ange_feed_message_rejected_check_fpml5.3.xslt 

 

The clearing member is identified in the output file using the FCM BIC (external name of the house clearing 
account). 

9.4 BRIDGE_ACK Messages 

BRIDGE_ACK messages are sent to acknowledge that collateralAllocation BRIDGEMSG messages have been 
received. 

9.4.1 Message Setup 

You need to add “LCHCVRResponseAck.html” to the domain “XML.Templates” if it is not available for selection. 
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9.4.2 Message Sender Config 
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9.4.3 Message Workflow 

The BRIDGE_ACK message workflow can be created using the file “<calypso 

home>/client/resources/workflow/bridge_ack.wf”. 

Orig Status Action Resulting 
Status  

Subtype  Product 
Type 

Processing 
Org 

NONE NEW PENDING BRIDGE_ACK ALL ALL 

PENDING AUTHORIZE TO_BE_SENT BRIDGE_ACK ALL ALL 

SENT SEND SENT BRIDGE_ACK ALL ALL 

TO_BE_SENT SEND SENT BRIDGE_ACK ALL ALL 

9.5 CVR_LE_DATA Messages 

This message type is used to generate the report LSOC CVR Static Data. 

9.5.1 Message Setup 

 

9.5.2 Message Workflow 

Orig Status Action Resulting 
Status  

Subtype  Product 
Type 

Processing 
Org 

NONE NEW PENDING CVR_LE_DATA ALL ALL 

PENDING TO_SEND TO_BE_SENT CVR_LE_DATA ALL ALL 

TO_BE_SENT SEND SENT CVR_LE_DATA ALL ALL 

TO_BE_SENT CANCEL CANCELED CVR_LE_DATA ALL ALL 

SENT CANCEL CANCELED CVR_LE_DATA ALL ALL 

SENT RESEND SENT CVR_LE_DATA ALL ALL 
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9.6 CFTC_REPORTING Messages 

This message type is used to generate the reports Liquidating Deficit and Aged Margin Calls. 

It is not necessary to setup a message configuration, but it is necessary to define a message workflow for this type 
of message. 

Orig Status Action Resulting 
Status  

Subtype  Product 
Type 

Processing 
Org 

NONE NEW CREATED CFTC_REPORTING ALL ALL 

CREATED CANCEL CANCELED CFTC_REPORTING ALL ALL 
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Section 10. Scheduled Tasks Setup 

The following scheduled tasks need to be configured for each CCP. 

They download the CCP files using the following property file: 

• “<calypso home>/client/resources/config/clearingconnection.properties” 

 See Clearing Member Setup for details. 

Once the files are retrieved from the CCP, they are stored in the folder specified in the property file “<calypso 

home>/client/resources/config/clearing.properties” if it exists. 

Otherwise, they are stored by default under “<user home>\Calypso\clearing” on the server where the 

Scheduler engine is running, and for the user running the Scheduler engine. 

From the Calypso Navigator, navigate to Configuration > Scheduled Tasks (menu action 
scheduling.ScheduledTaskListWindow) to configure the scheduled tasks. Choose this menu item to bring up 

the Scheduled Task Definitions & Scheduling window. 

10.1 Flow Types and Fees 

The scheduled tasks create Clearing Transfer trades to reflect the clearing activity. Clearing Transfer trades are of 
type CASH_SETTLEMENT. 

CASH_SETTLEMENT Clearing Transfer trades represent the cashflow amounts that impact the cash accounts. They 
are used for payment purposes and these amounts have a direct impact on the Cash Account balances posted to 
the client statements. 

They are associated with the following fees: 

• CS_PAI - Price Alignment Interest. Interest paid on Mark-to-Market amounts. Taken from the CCP file. 

• CS_COUPON - Interest associated with the swap trades (CME). Taken from the CCP file. 

• CS_INTERESTS - Interest associated with the swap trades (LCH). Taken from the CCP file. 

• CS_FRA_PAYMENT - Settlement associated with the FRA trades. Taken from the CCP file. 

• CS_CASH_DELIVERY – Cash associated with the FX NDF trades. Taken from the CCP file. 

• CS_VARIATION – Variation margin taken from the CCP file (EOD or intraday for LCH GBP FRAs) 

• CS_FEES – CME only - Fees associated with the trades. Taken from the CCP file. 

• CS_CONSIDERATN – LCH only - Fees associated with the swap trades. Taken from the CCP file. 

• CS_NPV_ADJUSTED – Adjusted NPV. Taken from the CCP file. 

• CS_NPV_REV – Reversal of CS_NPV_ADJUSTED, the day after. 

We recommend that CASH_SETTLEMENT trades be settled automatically on their value date since the CCP 
takes/pays the money from/to the clearing member’s nostro account, and this must be reflected on the client’s 
cash accounts. To do so, you just need to add the rule CheckToBeSettled in the transfer workflow on the transition 
VERIFIED – AUTO_SETTLE – SETTLED. 

One Transfer for Each Fee 

In order to generate proper information for the client statement, the system must generate one transfer for each 
fee of the trade. 

Note that in this case, the fee definitions MUST have the Transfer option checked, except for fee 
CS_VARIATION. 

Example for CS_PAI: 
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All of these fees are created by the system upon installation. 

10.2 Settlement Lag 

For the generation of all Clearing Transfer trades, the Trade date is the Value Date of the Scheduled Task. 

 

Settlement Date 

(1) For all flow types, the Settle Date is set based on the Settle Date of the Flow tag if one is provided. If a Settle 
Date is not provided, this date is calculated by adding the number of business days defined in the Currency 
Settlement Lag of the flow's settlement currency according to that currency's holiday calendar. 

(2) If the CCP legal entity attribute “UseAlternateSettleDateMethod” is false or null the system follows the logic 
defined in (1). If set to true, the following logic applies: 

T+2 currencies 

• SETTLE DATE=Trade Date + 2 days (excluding weekends) 

• If SETTLE DATE falls under currency Holiday, then it is set to the next business day for that currency. 

T+1 currencies 

• SETTLE DATE=Trade Date + 1 day (excluding weekends) 

• If SETTLE DATE falls under currency Holiday, then it is set to the next business day for that currency. 

“UseAlternateSettleDateMethod” should be set to true for LCH and false for CME. 

Settlement Date = Trade Date + Settlement Lag 

The Settlement Lag of all Clearing Transfers is driven by the currency of the transfer in the following manner: 

• If a settlement lag is specified in the currency attribute “<CCP name>ClearingTransferSettleLag”, it is 
used in priority. 

• Otherwise, we use the settlement lag specified in the currency attribute “ClearingTransferSettleLag” if any. 

• Otherwise, the settlement lag is 1 business day. 

[NOTE: If you only set ClearingTransferSettleLag, it will apply to all CCPs] 

Sample setup (remember that attribute names are case-sensitive): 
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In this example, the settlement date for CME clearing transfer trades would be Trade Date + 2, and the settlement 
date for LCH Clearing Transfer trades would be Trade Date + 3. 

This sample setup is not realistic – It is only used to illustrate the configuration capability. 

10.3 Available Date 

The Inventory positions MUST be based on the Available Date. 

As a result, you need to define how the Available Date is set for the various trades involved in the clearing activity. 

By default, the Available Date is set to the Trade Date. This behavior can be customized using the domain 
“XferAvailableDate” to determine the Available Date based on the Settlement Date +/- a number of days for a 
given static data filter. You need to setup the following: 

• Value = “-1.AVDATEFORSIMPLEXFER” where “AVDATEFORSIMPLEXFER” is a static data filter that filters 
simple transfers in AUD and JPY – The available date will be set to the settlement date -1 day. 

• Value = “-1.EOD CT” where “EOD CT” is a static data filter that filters non GBP FRAs clearing transfers in 
currencies different from AUD and JPY – The available date will be set to the settlement date -1 day. 

• Value = “-2.TPLUS2CCY” where “TPLUS2CCY” is a static data filter that filters clearing transfer trades in 
AUD and JPY - The available date will be set to the settlement date -2 days. 

 

Static Data Filters 
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10.4 CLEARING_SOD_MARGINCALL 

This scheduled task can be executed at the start of day to manage the SOD pass-through function. It allows 
comparing the client Margin Call Positions with the CCP cash balances provided by report REP00030, and 
generating Margin Call Trades facing the CCP in the respective IM Margin Call Contract. 

The domain “Clearing.SOD.IgnoreAccount” can be used to filter out the accounts to be ignored by this process. 

The margin call attribute CCP_SEGREGATION_ACCOUNT must be set to the “Account” field of report REP00030. 

 

Attributes 

» CCP - Select LCH. 

» Product - Select IRD. 

» Skip download - Select Always, If already downloaded, or Never. 

You can skip the download of the CCP files if the files have already been downloaded, or if you download 
them using another process. 

» Position Type – Select ACTUAL or THEORETICAL. 

» Collateral Context - Select a collateral context as needed. 

 

The margin call trades are created with Keyword.CCPSettlementType=”SOD”. The counterparty role is set to the 
OrdererRole if set on the margin call contracts, or CounterParty otherwise. 

The domain “Clearing.SOD.IgnoreXferStatusOnRerun” can be used to store transfer status codes to prevent “SOD” 
trades modifications. The scheduled task will not modify existing “SOD” trades if their transfers are in these 
statuses codes. 
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10.5 CLEARING_INTRADAY_MARGIN 

This scheduled task can be executed at any time during the day to generate intraday margin calls for LCH. You 
may set it up to run every half hour for example. 

You need to configure the scheduled task for LCH, and for IRD products. 

 

Attributes 

» Ledger Type – Select COV, NON-COV, or ALL. 

» CCP - Select LCH. 

» Product – Select IRD. 

» Select the mode: Client, House, or Both. 

This only applies to LCH – Select Client to import client files only, House to import house files only, or Both 
to import both. 

 

This scheduled task downloads the “Report 33a” from LCH and generates margin call trades of type 
ITD_COLLATERAL for each PPS Call entry that is after the time specified in the domain 
“Clearing.LCH.ExcludeBankingCallTime” with the 24 hour format “hh:mm”. For example 09:30 is 09:30 am. Any 
entries before that time will be excluded. 

The margin call trades are associated with the IM contracts (client for “C” PPS Call entries, or house for “H” PPS 
Call entries) of the clearing member facing the CCP, and can be viewed in the Collateral Manager as “previous 
margin”, so that they will not be called again during the EOD process. 

The following keywords are populated on the ITD_COLLATERAL trades: 

• CCPAccountReference = CCP_REFERENCE from additional info of IM MCC which can be "C" or "H" or 
position account id for ISA 

• IS_CLIENT=False (since it is CCP facing trade)  

• RelatedProductType = IRD (PRODUCT_TYPE from additional info of IM MCC)  

• CCPSettlementType = ITD 

• CCPLedgerType = COV for cash cover IM, or NON-COV for non-cash cover (interest and fees) 
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10.6 Intraday Settlement 

GBP FRAs are supported with or without intraday processing (same day settlement). The following options are 
provided: 

• Option 1 - To import GBP FRAs intraday (gross settlements), you need to use the scheduled task 
CLEARING_INTRADAY_SETTLEMENT as described below (only to LCH). 

• Option 2 - To import GBP FRAs intraday (gross settlements or net settlements), you need to use the 
Intraday CDML process as described below (only applies to LCH). 

• Option 3 - Otherwise, if you want to import GBP FRAs with settlement at T+1 (like other FRA trades), use 
the standard CDML process. 

See CDML Files Processing for details on Option 3. 

10.6.1 Intraday Setup Requirements 

This applies to Option 1 and Option 2. 

Domain “ProcessGBPFRAIntraday” 

You need to add the value True to the domain “ProcessGBPFRAIntraday” to import GBP FRAs intraday. It is not set 
by default (no intraday processing). 

 

Domain “XferAvailableDate” 

The Available Date is populated differently for GBP FRA trades and the other trades in order to allow trades that 
settle on different days to be included in the Client Statement. 

You need to setup the following for GBP FRA trades: 

• Value = “0.GBP FRA Intraday CT” where “GBP FRA Intraday CT” is a static data filter that filters GBP FRAs 
– The available date will be set to the settlement date. 

 

Static Data Filter 

 

 



Clearing Member Setup Guide 162 

©  2 0 1 1 – 2 0 1 8  |  Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved 

10.6.2 Scheduled Task CLEARING_INTRADAY_SETTLEMENT 

This applies to Option 1. 

 

Clearing Member Setup 

You need to set the legal entity attribute SKIP_ITD_FLOW = true on the Clearing Member Processing Org. In this 
case, the system will not process NPVAdjustment in reports 91 and 16. It is false by default. 

 

Scheduled Task Setup 

To import GBP FRAs intraday, you need to configure a scheduled task CLEARING_INTRADAY_SETTLEMENT. 

This scheduled task creates CASH_SETTLEMENT clearing transfer trades with CS_FRA_PAYMENT and 
CS_VARIATON_MARGIN fees. 

 

Attributes 

» CCP - Select the CCP: LCH (only LCH is currently supported) 

» Product - Select the product: IRD. 

» Mode: Select Client, House, or Both. 

This only applies to LCH – Select Client to import client files only, House to import house files only, or Both 
to import both. 

» Skip download - Select Always, if already downloaded, or Never. 

You can skip the download of the CCP files if the files have already been downloaded, or if you download 
them using another process. 

 

This scheduled task processes the files 104 and 104c: 

• CS_FRA_PAYMENT fee = “FRASettlementAmount” column 

• CS_VARIATION fee = “PreviousTradeLevelNPV” column 

 

The trade keyword RelatedProductType is set to GBP_FRA. 

For intraday GBP FRAs, all the fees attached to the CASH_SETTLEMENT clearing transfer trades have Fee Date = 
Fee Start Date = Fee End Date = Fee Known Date = Trade Settle Date. 
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10.6.3 Intraday CDML Process 

This applies to Option 2. 

 

Margin Call Contract Setup 

To settle all the flows intraday, you have to define a dedicated Margin Call VM contract identified with attribute 
SETTLEMENT_TYPE = ITD. 

The logic is the following: 

• If set to ITD, the contract will only be applicable to process intra-day clearing transfers flows 

• If not set, the contract will be applicable for both, ITD and EOD clearing transfers flows 

 

CCP facing MCC 

LCH will always consider the NET settlement. The contract will be similar to a regular VM contract with 

following exceptions: 

Where Field Value 

MCC Additional Info tab SETTLEMENT_TYPE ITD 

MCC Additional Info tab INCLUDED_VM_FLOWS Not set. 

MCC Details tab Position Date POSITION_DATE_LAST_KNOWN 

MCC Dates & Times tab Valuation Time Offset Daily Valuation date rule 

 

Client facing MCC 

Net Settlement Setup 

Where Field Value 

MCC Additional Info tab SETTLEMENT_TYPE ITD 

MCC Additional Info tab INCLUDED_VM_FLOWS Not set. 

MCC Details tab Position Date POSITION_DATE_LAST_KNOWN 

MCC Dates & Times tab Valuation Time Offset Daily Valuation date rule 

 

Gross Settlement Setup 

Where Field Value 

MCC Additional Info tab SETTLEMENT_TYPE ITD 

MCC Additional Info tab INCLUDED_VM_FLOWS CS_COUPON, CS_FRA_PAYMENT 

MCC Details tab Position Date POSITION_DATE_LAST_KNOWN 

MCC Dates & Times tab Valuation Time Offset Daily Valuation date rule 
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Example of CCP / client MCC settling all the flows (NET) coming from report 305 intra-day: 

 

 

Example of client MCC settling only coupons and FRA payments intraday and NPV reversal at the end of day 
(GROSS): 

 

 

Scheduled Tasks Setup 

CLEARING_TRANSLATE_TO_CDML scheduled task needs to be set to import the new report 305/ 305c with 
Intraday = true. 

 

CLEARING_PROCESS_FROM_CDML should be chained to CLEARING_TRANSLATE_FROM_CDML and run intraday to 
generate intra-day Clearing Transfer Trades 

 

To avoid double accounting, the system will back out the previous day’s NPV of EOD trade valuation reports 91 and 
16 for the trades that have settled Intra-Day. 
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10.7 CLEARING_HOLIDAY_PROCESSING 

The scheduled task CLEARING_HOLIDAY_PROCESSING allows generating Clearing Transfer trades, Collateral 
Exposure trades and PL Marks, on an ad-hoc basis, when the CCP does not provide EOD files because of a CCP 
holiday. 

It should be run on CCP holidays when the CCP does not provide the EOD files. 

 

Attributes 

» CCP - Select the CCP. 

» Product - Select the product. 

» Mode: Select Client, House, or Both. 

» Processing For - Select the type of processing: CLEARING TRANSFER, COLLATERAL EXPOSURE, or PL 
MARKS. 

 

For CLEARING TRANSFER, the scheduled task creates Clearing Transfers trades for the given valuation date. It 
copies the NPV from the previous business day, and generates reversals accordingly. 

For COLLATERAL EXPOSURE, the scheduled task creates Collateral Exposure trades for the given valuation date. It 
copies the following measure from the previous business day: 

• MAINTENANCE_REQUIREMENT 

• MARGIN_CALL 

• INITIAL_MARGIN 

• LIQUIDITY_MARGIN 

• ADDITIONAL_MARGIN 

• BASIS_RISK_MARGIN 

• CREDIT_MULTIPLIER_MARGIN 

For PL MARKS, the scheduled task copies PL MARKS for the given valuation date from the previous business day. 
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10.8 CLEARING_IMPORT_MARKET_DATA 

You can import the following quotes using the scheduled task CLEARING_IMPORT_MARKET_DATA. 

10.8.1 LCH PAI Quotes 

PAI quotes are imported from report LCH REP000016c. 

For PAI Quotes, the Interface Value in the Calypso Mapping Window should simply be in the format “CCYPAI”, for 
instance USDPAI, CADPAI, etc. We will associate a single PAI rate per currency. 

 

CLEARING_IMPORT_MARKET_DATA import: 

 

Market Data Types = Quotes 

10.8.1 LCH LDR/CDR/HDR Rates 

The LDR/CDR/HDR rates are imported from report LCH REP00017. 

For LDR/CDR/HDR Rates, the Interface Value should be in the format CCY~INDEX~OIS0D~LDR/CDR/HDR, for 
instance DKK~DENTNIN~OIS0D~LDR. 

 

CLEARING_IMPORT_MARKET_DATA import: 

 

Market Data Types = Rate Index 

10.8.1 LCH LDR/CDR/HDR Spreads 

The LDR/CDR/HDR spreads are imported from report LCH REP00042. 

For LDR/CDR/HDR spreads, the Interface Value should be in the format 
CCY~INDEX~OIS0D~LDR/CDR/HDRSpread, for instance CAD~CORRA~OIS0D~HDRSpread. 
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CLEARING_IMPORT_MARKET_DATA import: 

 

Market Data Types = Rate Index 

10.8.2 LCH Bond Prices 

The bond prices are imported from report LCH REP00034 based on the bonds’ ISIN code. No data mapping is 
required. 

[NOTE: The prices are imported into the quote set of the pricing environment defined in the scheduled task] 

CLEARING_IMPORT_MARKET_DATA import: 

 

Market Data Types = Collateral Quotes 

10.8.3 CME FX NDF Rate Resets 

The FX NDF rate resets are imported from report CME FXNDF. 

The mapping between the FX Reset and the quote is done for CME/Quotes in the Calypso Mapping window as: 

• Interface Value = FX.<ccy1>.<ccy2>.<CME FX reset>.<source> 

• Calypso Value = FX.<ccy1>.<ccy2>.<Calypso FX Reset>.<source> 

Example: 

 

[NOTE: The quotes are imported into the quote set of the pricing environment defined in the scheduled task] 

CLEARING_IMPORT_MARKET_DATA import: 
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Market Data Types = FX Rate Resets 

Please consider QUOTE_ALLOW_IN_FUTURE=false and QUOTE_MAX_DAY_FUTURE environment property so that 
the system will not populate values in the future. Also, make sure that you add the appropriate default source in FX 
Rate Definition window (SAEC for example). 

10.8.4 LCH / Comder FX Spot Rates by Currency Pair 

FX Spot quotes are imported from reports FXMD0001 (LCH) and SpotQuote (Comder). 

Calypso Mapping window: 

 

CLEARING_IMPORT_MARKET_DATA import: 

 

Market Data Types = Quotes 

10.8.5 LCH / Comder NDF Fixing Rates 

NDF fixing rates are imported from reports FXMD0010 (LCH) and SpotQuote (Comder). 

You need to define the FX Resets using Configuration > Foreign Exchange > FX Rate Definitions. 

CLEARING_IMPORT_MARKET_DATA import: 

 

Market Data Types = Quotes NDF 
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10.9 CDML Files Processing 

The CDML files processing is a two-step process. 

You first need to store the files into the system using the scheduled task CLEARING_TRANSLATE_TO_CDML. Then 
you can process the files using the scheduled task CLEARING_PROCESS_FROM_CDML. 

The scheduled tasks CLEARING_TRANSLATE_TO_CDML and CLEARING_PROCESS_FROM_CDML use the timezone 
defined in the scheduled task. 

10.9.1 Supported Files 

CCP Trade Valuation Initial Margin 

CME IRSTR IRSMR3 

COMDER FXNDF_Trades_Cleared 

FXNDF_Maturing_Today 

IRD_Trades_Cleared 

Outstanding_cashflows 

EOD_IM_Report 

EUREX RPTCB202 

RPTCC203 

RPTCD200 

RPTCI280 

RPTCC204 

ICE MARK TO MARKET MARGIN DETAIL report 
(NPV). 

MARK TO MARKET MARGIN INTEREST DETAIL 
report (PAI). 

TRADE PAYMENT DETAIL report (Upfront 
fees, Coupons, Credit Events). 

Client gross Margin 

LCH 91xce(client) 

91xe(house) 

REP00002c (client) 

REP00002 (house) 

REP000105c (client) 

REP105 (house) 

REP00084c (client) 

305 / 305c 

REP00086c (client) 

REP00086 (house) 

REP00050g (client) 

LCH FX FREP0009 (CLIENT) 

FRP0009 (HOUSE) 

FREP0026c (client) 

FREP0014 (house) 

10.9.2 CLEARING_TRANSLATE_TO_CDML 

The scheduled task scans the subfolders (that represent the CCPs) and tries to find pre-defined sets of CCPs EOD 
reports needed to generate the CDML reports. 
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The scheduled task can be run multiple times. If it finds new information (e.g. EOD reports for another CCP), it will 
add this CCP data to the existing CDML report and will create a new version of the report. 

This process can run in two modes: 

• “Generation plus Import” - The system takes the raw CCP files and translates them into CDML files. The 
raw CCP files must be stored in subfolders (of the Base Folder) by CCP short name. The file producers 
must be defined in the domain “Clearing.CDML.producerNames”. 

 

Each producer requires its own set of EOD files to be able to generate CDML reports. 

• “Import Only” – To import CDML files already translated into the system. 

 

 

The timezone in the Common Attributes is mandatory. 

Attributes 

» Base Folder - Enter the location of the files. 

For the mode “Generation plus Import”, the raw CCP files need to be organized in subfolders by CCP short 
name. 

For the mode “Import” only, the folder contains the CDML files to be imported into the system. 

» CDML Processing - Select the type of CDML processing “Import Only” or “Generation plus Import”. 

» Intraday – False by default. Set to “true” to execute an intraday producer {CCP}ITD, for example LCHITD 
- Only applies to mode “Generation plus Import”. 

For information on using Intraday = true, see Intraday CDML Process. 

» Ignore Producers: List of producers to be ignored - Only applies to mode “Generation plus Import”. 
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The scheduled task produces two types of XML reports: 

• tradeValuationReport 

• initialMarginRreport 

10.9.3 CLEARING_PROCESS_FROM_CDML 

The scheduled task CLEARING_PROCESS_FROM_CDML consumes the imported tradeValuationReport and 
initialMarginRreport CDML reports. 

It creates CASH_SETTLEMENT Clearing Transfer trades, Collateral Exposure trades, and PL Marks. 

 

The timezone in the Common Attributes is mandatory. 

Attributes 

» CCP: Select one or more CCPs. 

» Clearing Service: Select one or more clearing services. 

» CDML Report Type: Select All, initialMarginReport, or tradeValuationReport. 

» Process Mode: 

- If you have selected the report type “tradeValuationReport”, you can select All, Clearing 
Transfers, or Cleared Trade Marks, to create Clearing Transfer trades only, PL Marks only, or both 
(All). 

- If you have selected the report type “initialMarginReport”, you can select Collateral Exposures to 
create Collateral Exposure trades. 

10.9.4 CLEARING_INTRADAY_MARGIN_REV 

This scheduled task creates “return” trades for the intraday margin call trades of type ITD_COLLATERAL created by 
the scheduled task CLEARING_INTRADAY_MARGIN when you use CDML to create the EOD Initial Margin trades. 

It creates “return” trades of type ITD_COLLATERAL, of opposite direction of the original trades, and with the trade 
keyword ITDMarginCallReturn=true. There is one return trade for each counterparty and currency. 

 

Attributes 

» Ledger Type – Select COV, NON-COV, or ALL. 

» CCP - Select LCH. 

» Product - Select the product IRD. 

» Mode - Client, House, or Both. 

This only applies to LCH – Select Client to import client files only, House to import house files only, or Both 
to import both. 
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10.10 COLLATERAL_MANAGEMENT 

It computes the exposure on the initial margin and variation margin, and generates cash margin calls. It requires 
that you save a Collateral Manager report template to retrieve selection criteria. 

From the Calypso Navigator, navigate to Processing > Collateral Management > Collateral Manager (menu 
action reporting.margincall.MarginCallDesktop) to define a Collateral Manager report template. 

For IM contracts, the scheduled task loads the corresponding Collateral Exposure trades. 

For VM contracts, the scheduled task loads the cash accounts associated with the margin call contracts. The 
exposure is the inventory THEORETICAL Margin_Call position that has been updated by the CASH_SETTLEMENT 
Clearing Transfer trades. 

 

Attributes 

» Template - Select a Collateral Manager template to define the selection criteria. 

You can create a Collateral Manager template in the Collateral Manager using File > Save Template. 

» Collateral Context - Select a collateral context as needed. 

The other attributes may remain empty. 

 

 Please refer to Calypso Collateral Management documentation for complete details on this scheduled task. 
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10.11 CLEARING_STATEMENT 

This scheduled task generates Statement events that are sent to the Message engine to generate the actual client 
statements based on the message configuration for the message type “CLEARING_STATEMENT”. It can be run for 
all the CCPs that the clients use for clearing. It generates one statement per client. 

 

Attributes 

» CCPs - Select the CCPs for which you want to consolidate the client statement. 

» Static Data Filter – You can select a static data filter that contains legal entity attributes to select the 
corresponding clients. This only applies if ALL is selected for the Client attribute. 

In order to allow the static data filter to contain legal entity attributes, you need to add the value 
ClearingLEAttribute to the domain “CustomStaticDataFilter”. 

» Client - Select the client for which you want to generate the client statement, or ALL for all clients (or all 
clients satisfying the static data filter if set). 

» Layout Style: Select “Default” or “Condensed”. 
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In the Condensed Client Statement, all pending settlements are aggregated in 1 row, and the following 
sections are included in the Clearing Cash Flows Summary: 

- Separate Settlements 

- Initial Margin Summary 

- Summary of Payments 

» Mode - Select the mode: Daily to get the daily activity, Monthly to get the month to date activity, or 

Parent Daily to get parent level daily activity. 

See Parent Clearing Statement for “Parent Daily” setup requirements. 

» New Trades for IRS - Select the Trade Browser template for new IRD trades. 

» New Trades for FXNDF - Select the Trade Browser template for new FX NDF trades. 

» New Trades for CDX - Select the Trade Browser template for new CDX trades. 

» Open Trades for IRS - Select the Trade Browser template for open IRD trades. 

» Open Trades for FXNDF - Select the Trade Browser template for open FX NDF trades. 

» Open Trades for CDX - Select the Trade Browser template for open CDX trades. 

» Terminated Trades for IRS - Select the Trade Browser template for terminated IRD trades. 

» Terminated Trades for FXNDF - Select the Trade Browser template for terminated FX NDF trades. 

» Terminated Trades for CDX - Select the Trade Browser template for terminated CDX trades. 

» Matured Trades for IRS - Select the Trade Browser template for matured IRD trades. 

» Matured Trades for FXNDF - Select the Trade Browser template for matured FX NDF trades. 

» Matured Trades for CDX - Select the Trade Browser template for matured CDX trades. 

» Account Activity Template - Select the Account Activity report template. 

» Collateral Position Template - Select the Collateral Position report template. 

» Collateral Allocation Template - Select the Collateral Allocation report template. 

» Collateral Context – Select “default”. 

The report templates are described below. 

 

Performance Enhancements 

To improve the performance, you can set the following JVM parameters: 

“-XX:UseConcMarkSweepGC -Xms1g -Xmx4g -XX:MaxPermSize=384m” 

You can also set the number of threads to use when generating client statements in the domain 
“Clearing.Statement.parallel.numThreads”. 

 

New Trades for IRS Template 

Trade Browser template. 

From the Calypso Navigator, navigate to Deal Management > Trade Browser. 

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration] 

Example = “001 - Calypso US New Trades IRD” 
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• Trade Attribute = IS_CLIENT Contains true 

• Processing org = <the clearing member> 

• Trade Filter = New Trades 

• Product Type = Swap, FRA 

• Status = CLEARED, VERIFIED 

The criteria of the “New Trades” trade filter are the following – It loads trades cleared today. 

 

New Trades for FX NDF Template 

Same as New Trades for IRS with Product Type = FXNDF. 

New Trades for CDX Template 

Same as New Trades for IRS with Product Type = CreditDefaultSwap, CDSIndex. 

Open Trades for IRS Template 

Trade Browser template. 

From the Calypso Navigator, navigate to Deal Management > Trade Browser. 

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration] 

Example = “001 - Calypso US Open Trades IRD” 
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• Trade Attribute = IS_CLIENT Contains true 

• Processing org = <the clearing member> 

• Trade Filter = Open Trades 

• Product Type = Swap, FRA 

• Status = CLEARED, VERIFIED 

The criteria of the “Open Trades” trade filter are the following – It loads trades cleared before today. 
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Open Trades for FX NDF Template 

Same as Open Trades for IRS with Product Type = FXNDF. 

Open Trades for CDX Template 

Same as Open Trades for IRS with Product Type = CreditDefaultSwap, CDSIndex. 

Terminated Trades for IRD Template 

Trade Browser template. 

From the Calypso Navigator, navigate to Deal Management > Trade Browser. 

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration] 

Example = “001 - Calypso US Terminated Trades IRD” 

 

• Trade Attribute = IS_CLIENT Contains true 

• Processing org = <the clearing member> 

• Trade Filter = TERM Trades 

• Product Type = Swap, FRA 

• Status = Not set 

The criteria of the “TERM Trades” trade filter are the following – It loads trades terminated today. 
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Terminated Trades for FX NDF Template 

Same as Terminated Trades for IRS with Product Type = FXNDF. 

Terminated Trades for CDX Template 

Same as Terminated Trades for IRS with Product Type = CreditDefaultSwap, CDSIndex. 
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Matured Trades for IRD Template 

Trade Browser template. 

From the Calypso Navigator, navigate to Deal Management > Trade Browser. 

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration] 

Example = “001 - Calypso US Matured Trades IRD” 

 

• Maturity Date = <today> 

• Trade Attribute = IS_CLIENT Contains true 

• Processing org = <the clearing member> 

• Trade Filter = ALL 

• Product Type = Swap, FRA 

• Status = PENDING, PRICING, VERIFIED, ALLOCATED, ROLLOVERED, MATURED, EXERCISED, TERMINATED 

Matured Trades for FX NDF Template 

Same as Matured Trades for IRS with Product Type = FXNDF. 

Matured Trades for CDX Template 

Same as Matured Trades for IRS with Product Type = CreditDefaultSwap, CDSIndex. 

Account Activity Template 

Account Activity report template. 

From the Calypso Navigator, navigate to Reports > Nostro/Custodian Positions > Account Activity. 

[NOTE: Make sure that the “Currency” column is selected] 

Example = “SWAP-ACTIVITY” 
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• Start and End = 0D 

• Position Date = Available 

• Position Class = Client 

• Position Type = Actual 

• Detail by Account = Checked 

• Currency = <list of currencies> 

Make sure to select the currencies that you want to monitor. 

This is a sample setup. You may choose the settings of the fields based on your business requirements. 

You can define the flows that you want to filter out from the Account Activity section of the Client Statement in the 
domain “NPVFlows” and “NPVReversalFlows”. 

The domain “NPVFlows” contains NPV non-reversal flows, by default: 

• CS_NPV_ADJUSTED 

• NPV_ADJUSTED 

 

The domain “NPVReversalFlows” contains NPV reversal flows, by default: 

• NPV_REV 

• CS_NPV_REV 

 

Collateral Position Template 

Margin Call Position Entry report. 

From the Calypso Navigator, navigate to Processing > Collateral Management > Collateral Manager - Report 
available under Window > Report > Position). 

Example = “SWAP-MCPOSITION” (today’s actual Margin_Call positions) 
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• Value Date Start and End = 0D 

• Position Type = ACTUAL 

Collateral Allocation Template 

Margin Call Allocation Entry report. 

From the Calypso Navigator, navigate to Processing > Collateral Management > Collateral Manager - Report 
available under Window > Report > Allocation). 

Example = “SWAP-MCALLOCATION” (today’s margin call trades) 

 

• Process Date Start and End = 0D 

 Please refer to the Calypso Clearing Member User Guide for sample client statements and complete details. 
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10.12 Parent Clearing Statement 

This mode pertains to multi branch account structure wherein buy side has various funds which are clearing trades 
under parent entity. Buy side generally have each fund acting as cost center hence some flows of VM need to be 
accounted for at fund level however IM needs to be calculated at parent entity level taking offsetting risk 
advantage across all funds. 

You can decide which flows need to be settled at parent level using the parent SDI functionality with environment 
property LOOK_PARENT_SDI = true and margin call contract attribute CLOUD_NET. The SDIs can be configured so 
that the system uses the parent SDIs to settle the flows defined in CLOUD_NET, and specific netting can be 
configured for those flows. The child SDIs are used otherwise. 

The clearing statement allows reporting these flows using the scheduled task attribute Mode = Parent Daily. This 
only applies with the Default layout style. 

10.12.1 Domain Values 

Add the following domain values. 

 

Domain “mccAdditionalField.CLOUD_NET” - Possible list of flows that can be netted. For example: ALL, COUPON, 
PAI, VM. This is user-defined. 

 

 

Domain “tradeKeyword”: 

Value = CLOUD_NET 

 

Domain “XferAttributes” 

Values=CLOUD_NET 

 

Make sure that CLOUD_NET is added to the domains “Clearing.MCC.propagateFields” and 
“PropagateTradeKeyword” so that it can be propagated to margin call trades and transfer attributes to be used in 
static data filters and netting configurations as needed. 

10.12.2 Workflow 

Make sure that the rule UpdateClearingMarginCallKeywords is set on the MarginCall workflow transition NONE – 
NEW – XXX. 

 

Make sure that the rule PropagateTradeKeyword is set on the Transfer workflow transition NONE – NEW – XXX. 

10.12.3 Legal Entities 

Define Parent/ Child relationships between Parent fund and child entities as shown below. 

Example: FUND_A child of parent LEADFUND 
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10.12.4 Margin Call Contracts 

Set the attribute CLOUD_NET as needed for contracts that should be settled and netted at parent level. 

In the example below, child FUND_A is settling VM and PAI through its parent entity LEADFUND. Coupons are 
directly settled by FUND_A. PAI has as separated netting bucket and VM is netted in a general bucket. 

 

Make sure that the attributes INCLUDED_VM_FLOWS and CLOUD_NET are compatible: 

• CLOUD_NET can be ALL or empty, if INCLUDED_VM_FLOWS is empty. 

• CLOUD_NET can be ALL or a subset of INCLUDED_VM_FLOWS, or empty, if INCLUDED_VM_FLOWS is not 
empty. 

10.12.5 Settlement Instructions 

Parent Level 

SWIFT SDIs should be set up at Parent level to instruct the payments of all children entities (including the parent 
itself when acting as a child entity) that are in scope, i.e. for transactions that are settled/ netted at the parent 
level. 

Example: 
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Child Level 

The only SWIFT SDIs required at Child level are the SDIs of the settlements that will be directly instructed by the 
Child fund, i.e. not applicable for Parent netting and settlement. 

It is necessary to specify in a filter the applicable flows for the SDI. Note that this SDI needs also to be set up for 
the parent entity when it acting as a child entity and no netting is required 

Example: FUND_A settles the coupons at Child level. 
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10.12.6 Netting Method 

This netting method will be used to create the netting buckets as defined on the underlying MCC. For instance, if a 

Fund has a separate PAI contract where CLOUD_NET is set to PAI and 2 further separate VM and Coupon contracts 
where CLOUD_NET is set to ALL, then the system will create 2 netting buckets: 1 for the netting by flow type for 
PAI only and the other for the contracts that are tagged as ALL. 

Create new netting type, for instance CloudNet. 
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You can use the same netting keys as CounterParty netting but add key CLOUD_NET: 

 

 

Create a new Netting Method as shown below 

 

 

Specify in the filter which flow types should be included in this netting method: 
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10.12.7 Parent Statement 

The CLEARING_STATEMENT scheduled task is used to trigger the parent statement using Mode = Parent Daily and 
the following attributes: 

• CCPs - List of CCPs in scope for the statement 

• Client - Should bet set to the Parent Entity(ies) only 

• Layout - Default. Condensed is currently not supported for Parent statement 

• Trade reports - Currently not supported, should be left empty 

• Other reports - Same as default daily statement 

 

The Parent Daily Statement is an aggregation of all the flows of the Child entities that are tagged with the MCC 
attribute CLOUD_NET. The statement is based on the default daily statement and follows the same logic. 

The Parent statement can be distinguished from the child statement by looking at BO Message Attribute 

“Statement Type”: Set to PARENT_DAILY for the parent statement and DAILY for the child statement. 
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10.13 Scheduled Tasks Execution 

The scheduled tasks are executed by the Calypso Scheduler once you have defined triggers as described in the 
Calypso Scheduled Tasks User Guide. 

Important Note – Timezones Considerations 

In order to successfully process scheduled tasks which combine the import and processing of EOD files, you need 
to run the relevant scheduled tasks for a given day before the EOD of the books where the trades are 
saved, based on the book’s timezone. 

For example, the book’s timezone is New York EOD 5pm. To process today’s files, you need to run the scheduled 
tasks before 5pm New York time, regardless of where you run the scheduled tasks from, so that the trades are 
timestamped as of today, and the settlement date is computed from today. 

 

Order of Execution 

They should be executed in the following order: 

• CLEARING_SOD_MARGINCALL (start of day) 

• CLEARING_INTRADAY_MARGIN (every half hour during the day) 

• CLEARING_TRANSLATE_TO_CDML 

• CLEARING_PROCESS_FROM_CDML 

• CLEARING_INTRADAY_SETTLEMENT (for intraday GBP FRAs only) 

• COLLATERAL_MANAGEMENT 

• CLEARING_STATEMENT 

• ERS_ANALYSIS 
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Section 11. Intraday Margin Calls to Clients 

This section describes the setup for making intraday margin calls to clients, and sending XML margin call 
notifications. 

Intraday margin calls to clients follow the diagram below. 

 

11.1 PL Mark Mapping 

In this process we translate yyyymmdd_REP00086c - Intraday Margin Split_ “n” into CDML format for intraday 
reporting. 86c Intraday contains CoveredLiability = (CoveredIM + CoveredLM + Covered AM + CoveredBR + 
CoveredCM + CoveredNPVChange) 



Clearing Member Setup Guide 190 

©  2 0 1 1 – 2 0 1 8  |  Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved 

This report gives information on intraday initial margin requirements at a portfolio level for client activity. 

• Frequency: Intraday, LCH generates the report every 15 mins 

• Report Structure: This report contains the following information 

- MbrMnemonic = “ShortName”  

- Account =”C” representing client activity 

- ReportingCCY = Currency in which CoveredLiability is reported 

• Sub Components of CoveredLiability: We are importing the following components for intraday client 
reporting purposes along with CoveredLiability in CollateralExposure trades: 

- CoveredIM = Initial Margin for all registered trades. 

- CoveredLM = Liquidity Margin: Liquidity Risk Multiplier multiplied by the Initial Margin amount. 
This is taken from the Previous Days Close of Business. 

- CoveredAM = Additional Margin for all registered trades. 

- CoveredBR = BR for all registered trades. 

- CoveredCM = CM within the total liability amount which has registered a call. This is only 
populated should a backload call or a TriReduce call be made. 

- CoveredNPVChange = NPV change for all registered trades -i.e. CoveredNPV – 
NPVPreviousDay. 

- ItdCallAmount = Non-cumulative Intraday call amount. 

11.2 Configuration Requirements 

11.2.1 Domain Values 

In the domain “Clearing.Statement.ITD.useBaseValue” add the value True or False. 

• If true, amounts are converted to the base currency of the collateral context. 

• If false, amounts are converted to the contract currency of the LCH IM contracts. 

11.2.2 Date Rule Setup 

The following date rules are needed for the margin call contract for ad-hoc or intraday valuation. 

Daily date rule for Valuation Date Frequency 
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VD=0D date rule for Valuation Time Offset 

 

11.2.3 IM Margin Call Contract Setup 

You need to set up Ad-Hoc details for the IM margin call contracts: Check “Ad-Hoc Calls” in the Ad-Hoc Details 
panel. 

This enables the Valuation details. 
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» Set the Valuation Date Frequency as Daily and the Valuation Time Offset as the relative date rule based on 
the Daily date rule previously defined. 

 

You also need to set an end-of-day pricing environment and an intraday pricing environment in the Details panel. 

 

11.2.4 Collateral Contexts 

You need to define a collateral context for end-of-day processing, and one for intraday processing. 

EOD Collateral Context 

It should have Pricing Env Type = EOD, and Valuation = Standard. 

It is used for EOD processing in the scheduled task COLLATERAL_MANAGEMENT, and in the Collateral Manager. 

 

 

ITD Collateral Context 

It should have Pricing Env Type=ITD, and Valuation= Adhoc. 

It is used for intraday processing in the scheduled task COLLATERAL_MANAGEMENT, and in the Collateral Manager. 
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You can also define a separate collateral workflow for the intraday collateral context using the Workflow panel. 

 

Workflow Setup 

You can create a separate Collateral workflow for each context, or add a NEW transition from EXECUTED to 
PRICING. 

It is also important to have a SUBSTITUTE intermediate transition to apply the workflow rule 
SetMarginCallTradeTypeAttribute. 
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The workflow rule SetMarginCallTradeTypeAttribute needs to be added on the VALIDATE and SUBSTITUTE 
transitions. This rule sets the keyword CCPSettlementType to ITD or EOD based on the Pricing Env Type of the 
collateral context. 

 

 

11.2.5 Processing Org Attributes 

You need to specify the following attributes on the processing organization: 

• EODCollateralContext – Enter the EOD collateral context. Used to apply on Margin Report filters to 
generate appropriate information on ITD notification XML. 

• ITDCollateralContext – Enter the ITD collateral context. Used to apply on Margin Report filters to generate 
appropriate information on ITD notification XML. 

• ImportZeroMarginAmountITD – Used when importing the COVEREDLIABILITY column. Default is true. 

- If false, COVEREDLIABILITY and the other PL marks are imported ONLY if ITDCALLAMOUNT 
column <> 0 

- If true, PL Marks are imported regardless of the value in the ITDCALLAMOUNT column. 

• ApplyBufferITD – Used to apply a buffer against intraday margin calls. Default is false. 

- If false, no buffer is applied. 

- If true, a buffer (multiplier) is applied. 
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11.2.6 Intraday Notification Message 

The system creates an XML file on creation of the Margin Call Trades for intraday. It is stored into the local folder. 
This message is used for client notification and downstream reporting. 

 

Message Setup 

Product Type = MarginCall 

Message Type = CLEARING_ITD_STATEMENT  

Receiver Role = Statement Recipient 

Event Type = STATEMENT 

Format Type= XML 

 

 

SD Filter Setup 

The static data filter checks the trade keyword MarginCallTradeType. 

 

 

Message Sender Configuration 
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11.3 Scheduled Tasks 

Configure the scheduled task CLEARING_TRANSLATE_TO_CDML with Intraday = true. 

 

On execution of this scheduled task, the system imports PL marks on existing Collateral Exposure trades. 

 

After executing this scheduled task, you need to execute the scheduled task COLLATERAL_MANAGEMENT with the 
intraday collateral context, to generate the margin calls and the intraday message notifications. 
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Section 12. Custodial Segregation 

The integration of MT569 messages allows supporting custodial segregation. 

MT569 messages (message type INCOMINGCUSTSEG) can be integrated using the MESSAGE_MATCHING 
scheduled task or the Import Message engine. Based on the incoming messages, it generates Security Margin Calls 
on a dummy bond (bond with security code CLEARING_DUMMY_CUST_SEG=True). 

The margin call contract is identified using the margin call attribute CCP_SEGREGATION_ACCOUNT. 

12.1 Setup Requirements 

12.1.1 Dummy Bond 

The dummy bond to be used for generating the security margin calls is identified with product code 
CLEARING_DUMMY_CUST_SEG = True. 

You need one dummy bond per currency. 

12.1.2 Processing Org 

The processing Org must have the legal entity attribute ClearingDummyCustSegBond = True to create the security 
margin calls using the dummy bond. 
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12.1.3 Incoming Message 

Add MT569 to the domain “incomingType”: 

• Value = MT569 

• Comment = INCOMINGCUSTSEG 

 

12.1.4 Position Selection 

Specify the position type you want to use to determine the margin call position in the domain 
“ClearingCustSeg.PositionType” – It can be THEORETICAL or ACTUAL. 

 

12.1.5 INCOMINGCUSTSEG Message Workflow 
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Orig Status Action Result Status STP WF Rule 

NONE NEW PENDING     

PENDING PROCESS RECEIVED Yes   

RECEIVED TRANSLATE TRANSLATED Yes TranslateSwiftToMarginCall 
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Orig Status Action Result Status STP WF Rule 

TRANSLATED REPROCESS TRANSLATED   TranslateSwiftToMarginCall 

RECEIVED CANCEL CANCELED     

RECEIVED REJECT REJECTED     

12.2 MT569 Message Integration 

You can use the scheduled task MESSAGE_MATCHING or the Import Message engine to import the MT569 
messages. 

 

MESSAGE_MATCHING Scheduled Task 

 

 

Import Message Engine 

You need to start the SwiftImportMessageEngine using the Engine Manager in Web Admin with the config Swift. 

You may need to add it if it is not available: 

Name = SwiftImportMessageEngine 

Class = com.calypso.engine.advice.ImportMessageEngine 

The "config" engine parameter is config = Swift 
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Section 13. Collateral Sweeping 

Collateral Sweeping supports the following scenarios: 

• Sweeping VM to IM for independent entity in base currency 

• Sweeping VM to IM for parent/child entity in base currency 

13.1 Margin Call Contracts Setup 

Margin Call Contract: You need to define MCC with LE role as Client and Orderer Role as CounterParty. 

 

Position Date: You need to define IM and VM contracts with position date as POSITION_DATE_VALUE. 

 

 

Linked Configurations: You need to link IM MCC to VM MCC and vice versa. 

If LEs are holding parent child relationship (through LE Parent setup) then user should be able to see child MCC in 

Parent Linked Configuration and Parent MCC in Child MCC Linked Configuration. 

See below CPTY_ISA parent IM linked to various child VM MCC in USD ccy. 
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Similarly individual Child and Parent VM MCC is linked to parent IM MCC, see below one example: 

 

 

Preference Template: The scheduled task COLATTERAL_DISTRIBUTION requires a Preference Report template. 
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13.1.1 Collateral Context 

Collateral Context: The scheduled task COLATTERAL_DISTRIBUTION requires a collateral context with 
ContextBased valuation method. 

 

The base currency should be same as that of MCC’s base currency. 
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13.1.2 Optimization Configuration 

Optimization Configuration: The scheduled task COLLATERAL_DISTRIBUTION requires an optimization 
configuration. 

 

• Optimization Type: Allocation to make sweeping/allocation from VM to IM 

• Solver: Allocation Rule 

• Allocation Type: Under Collateralized 

• Pricing Env: Matching to MCC of IM and VM 

• Currency: MCC base currency 

 

Target: 
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Create a Target Configuration of type “Category” using Util > Target Configuration to define the currency that 
needs to be swept. 

 

Then create a Target configuration of type “Allocation-rule” using Util > Target Configuration. 
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For the Contract Allocation Rules, add an allocation rule of type “Contract-Attribute” and select the attribute 
PRIORITY. 

 

It is set in the margin call contract attribute PRIORITY. 

For the Collateral Allocation rule, add an allocation rules of type “Collateral-Category” and select the target 
configuration of type “Category” previously created. 

 

Finally, select the target configuration of type “Allocation-rule” in the Target panel of the Optimization 
Configuration. 
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Substitution: Never as system should just sweep fungible cash collateral from VM to IM unlike any substitution 
process. 

 

 

Constraint: Add the following constraints. 

• Required-Margin - To make sure allocated amount is equal to GRM 

• Collateral-Distribution – To allocate cash (only) available on margin call entry 

• Eligibility - To sweep all currencies which are defined as eligible currencies in IM and VM MCC 

 

13.2 Scheduled Task COLLATERAL_DISTRIBUTION 

Run the scheduled task COLLATERAL_DISTRIBUTION with the configurations previously defined. 

 

 


